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Before You Begin

Installing PLECS Standalone

Installing PLECS on your system is easy. You do not need to have system ad-
ministrator permissions.

Installation on Microsoft Windows

1 If you already have a license file *.1ic, copy it to your harddisk.

2 Run the installer executable by double-clicking it. PLECS can be installed for
the current user or all users of a machine. To install PLECS for all users the
installer must be executed with administrator privileges.

3 Start PLECS.

Installation on macOS

1 If you already have a license file *.1ic, copy it to your harddisk.
2 Open the disk image by double-clicking it.

3 Copy PLECS to the Application folder.

4 Start PLECS.

Installation on Linux

1 If you already have a license file *.1lic, copy it to your harddisk.
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2 Open a terminal and extract the package
plecs-standalone-x-y-z_linux64.tar.gz by entering the command

tar xf plecs-standalone-x-y-z_linux64.tar.gz

in a directory of your choice. This will create a new sub-directory named
plecs containing the required files.

3 Start PLECS by executing PLECS in the folder plecs.

Licensing

If PLECS cannot locate any license file when you start it, it will show a mes-
sage that it is unlicensed.

Choose Start in demo mode to use PLECS in a restricted demo mode that lets
you build models and run simulations. Saving models or data is disabled in this
mode.

Choose Open license manager... to open the License Manager, which lets you
install a license file or request a time-limited trial or student license.

If PLECS does locate license files but they do not contain a valid license (e.g.
because it has expired), it will immediately open the License Manager without
the option to start the demo mode.
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Installing PLECS Blockset

Installing PLECS Blockset on your computer is easy. You do not need to have
system administrator permissions. Since PLECS Blockset requires MATLAB
and Simulink make sure these programs are installed on your computer.

Installation on Microsoft Windows

1 If you already have a license file *.1lic, copy it to your harddisk.

2 Run the installer executable by double-clicking it. PLECS can be installed for
the current user or all users of a machine. To install PLECS for all users the
installer must be executed with administrator privileges.

3 After the installer has finished, it will automatically start the PLECS
Blockset Installation Wizard.

4 On the License File page you can choose to keep an existing license file,
copy a new license file from your harddisk or request a trial or student li-
cense.

5 Review the MATLAB Search Path page and click Continue.

6 Start MATLAB and enter plecslib or choose the entry PLECS in the
Simulink Library Browser to open the PLECS Library.

Installation on macOS

1 If you already have a license file *.1ic, copy it to your harddisk.

2 Open the diskimage by double-clicking it and copy the folder
PLECS Blockset x.y to a location of your choice.

3 Run the application PLECS. app inside the folder PLECS Blockset x.y by
double-clicking it. This will start the PLECS Blockset Installation Wiz-
ard.

4 On the License File page you can choose to keep an existing license file,
copy a new license file from your harddisk or request a trial or student li-
cense.

5 Review the MATLAB Search Path page and click Continue.
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6 Start MATLAB and enter plecslib or choose the entry PLECS in the
Simulink Library Browser to open the PLECS Library.

Installation on Linux

1 If you already have a license file *.1lic, copy it to your harddisk.

2 Open a terminal and extract the package
plecs-blockset-x-y-z 1linux64.tar.gz by entering the command

tar xf plecs-blockset-x-y-z_linux64.tar.gz

in a directory of your choice.

3 Still within the terminal execute the program PLECS.setup inside the folder
plecs/bin/glnxa64. This will start the PLECS Blockset Installation Wiz-
ard.

4 On the License File page you can choose to keep an existing license file,
copy a new license file from your harddisk or request a trial or student li-
cense.

5 Review the MATLAB Search Path page and click Continue.

6 Start MATLAB and enter plecslib or choose the entry PLECS in the
Simulink Library Browser to open the PLECS Library.

Licensing

If PLECS cannot locate any license file when you start it, it will show a mes-
sage that it is unlicensed.

Choose Start in demo mode to use PLECS in a restricted demo mode that
lets you build models and run simulations. Saving Simulink models containing
PLECS blocks is disabled in this mode.

Choose Open license manager... to open the License Manager, which lets you
install a license file or request a time-limited trial or student license.

If PLECS does locate license files but they do not contain a valid license (e.g.
because it has expired), it will immediately open the License Manager without
the option to start the demo mode.
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Without a valid license you will still be able to open or save Simulink models
containing PLECS blocks. However, you cannot modify a circuit schematic or
run a simulation.

Note PLECS scans the license file only once when the module is loaded

by MATLAB. Therefore, if you reinstall the license file, you need to clear the
PLECS module before the changes can become effective. You can do this by en-
tering plecsclear at the MATLAB command prompt.

Configuring the MATLAB Search Path

The recommended method to register PLECS Blockset with MATLAB is to add
appropriate addpath commands to the startup file startup.min your MATLAB
startup folder. For information on the startup.m file, enter doc startupin
MATLAB. The PLECS Blockset Installation Wizard will assist you in cre-
ating or updating this file.

Using this method has the advantage that if you update MATLAB after hav-
ing installed PLECS, the new MATLAB version will automatically know about
PLECS. The disadvantage is that each user must setup their startup file indi-
vidually.

As an alternative method you can register PLECS with a specific MATLAB
installation using the MATLAB Path Browser or by directly editing the file
pathdef.m in the directory matlabroot/toolbox/local/. This method may be
appropriate if PLECS will be used by multiple users sharing the same com-
puter. You need to add the PLECS directory and its subdirectory demos to the
MATLAB search path.

Configuring PLECS

For information about setting global configuration options for PLECS see “Con-
figuring PLECS” (on page 124).
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Installing Different Versions of PLECS Blockset in Paral-
lel

If you want to keep different versions of PLECS installed in parallel on one
computer, you must ensure that only one version is on your MATLAB path at
any time during a MATLAB session. Otherwise, loss of data may occur. Be-
fore changing the MATLAB path, be sure to clear the currently loaded PLECS
module by entering plecsclear at the MATLAB command prompt. As an addi-
tional precaution you should restart MATLAB after the change.

Uninstalling PLECS Blockset

Uninstalling PLECS Blockset is as easy as installing it.
1 Locate the directory where PLECS is installed by entering

which plecs

in the MATLAB command line.

2 Remove the PLECS directory and its subdirectory demos from the search
path. Depending on how the directories were added to the path during instal-
lation, this is done using the Path Browser or by editing the file pathdef.m
in the directory matlabroot/toolbox/local/ or your MATLAB startup file
startup.m.

3 Quit MATLAB.

4 On Windows, deinstall PLECS Blockset by choosing the appropriate entry
in the Windows control panel. On macOS and Linux just delete the PLECS
directory.
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License File Location

Both PLECS Standalone and PLECS Blockset search for license files named
* . 1lic in the following directories:

License File Search Paths

Platform | Search Paths

Windows | C:\Users\<USER>\AppData\Local\Plexim\PLECS\licenses
C:\Programbata\Plexim\PLECS\1licenses

macOS ~/Library/Application Support/Plexim/PLECS/licenses
/Library/Application Support/Plexim/PLECS/licenses

Linux ~/.local/share/Plexim/PLECS/licenses
/usr/local/share/Plexim/PLECS/licenses

The License Manager will install license files in the first directory listed for
each platform because this location is usually writable by the user. However,
an administrator may choose to install license files to be used for all users in
the other directory.

If none of the search directories contains any license file *.1ic, PLECS uses the
environment variables PLEXIM_LICENSE_FILE and LM_LICENSE_FILE to locate
the license file.

Network Licensing

If you purchase one or more floating licenses for PLECS, the license server pro-
gram FlexNet Publisher is employed to control access to PLECS. FlexNet Pub-
lisher is a product of Flexera Software. The license file sent to you must be in-
stalled on the license server. This file contains information that identifies the
computer running the license manager and specifies the number of floating li-
censes you have purchased.

On the client computer(s), you need to use a text editor to create a license file
network.lic with the following content:

SERVER licenseserver ANY
USE_SERVER
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where licenseserver is the IP address or the hostname or fully qualified domain
name (FQDN) of the server computer running the license manager. If the host-
name or FQDN is used, verify that the client computer can resolve it to the
correct IP address. If the license manager uses a TCP port other than 27000-
27009, the port number must be specified on the SERVER line after the keyword
ANY, e.g.:

SERVER licenseserver ANY 3456
USE_SERVER

PLECS tries to obtain a license from the server the first time you load a model
or library containing a PLECS circuit. If the license is not granted — e.g. be-
cause the server is down or unreachable or because the licensed number of
concurrent users is already reached — PLECS will open the License Manager
to report the problem. In order to retry to obtain a license you need to restart
PLECS Standalone or clear PLECS Blockset from the MATLAB memory using
the MATLAB command plecsclear. Once granted, a license is returned to the
server when quit PLECS Standalone or clear PLECS Blockset from the MAT-
LAB memory.

If the connection to the license server is lost after you have obtained a license,
PLECS will temporarily switch to the unlicensed mode. Upon successful recon-
nection to the server, PLECS will switch back to normal operation.



What's New in Version 4.8

What’s New in Version 4.8

Major New Features

¢ The PLECS Coder now supports code generation for targets with multiple
processors. See “Generating Code” (on page 285).

¢ PLECS now supports fixed-point data types to facilitate code generation for
targets that do not support floating-point data types. See “Fixed-Point Data
Types” (on page 43).

¢ The Thermal Package Description now lets you characterize the thermal cou-
pling between individual semiconductors with an impedance matrix. See
“Thermal Package Description” (on page 150).

¢ PLECS now lets you choose between the classic light color scheme and a new
dark color scheme designed to work well in a low-lit environment. See “Con-
figuring PLECS” (on page 124).

Enhanced Library Components

Selected power modules have been enhanced to support thermal simulations
both in the “Switched” and “Sub-cycle average” configuration. This applies to
the following power modules:

¢ 3-Level Half Bridge (T-Type) (see page 340)

¢ Flying Capacitor Half Bridge (see page 449)

¢ IGBT 3-Level Half Bridge (NPC) (see page 486)

¢ IGBT Chopper (High-Side Switch) (see page 488)

¢ IGBT Chopper (High-Side Switch with Reverse Diode) (see page 489)

¢ IGBT Chopper (Low-Side Switch) (see page 491)

¢ IGBT Chopper (Low-Side Switch with Reverse Diode) (see page 492)

¢ IGBT Full Bridges (Series Connected) (see page 496)

¢ IGBT Half Bridge (see page 498)

¢ IGBT Half Bridges (Low-/High-Side Connected) (see page 500)

Further Enhancements

¢ The improved error reporting using spotlights makes it easier to identify the
erroneous components. In case of parameter evaluation errors, clickable links
take you directly to the corresponding dialog box to fix the problem.
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PLECS will now detect sample time conflicts between continuous and dis-
crete blocks to help users avoid typical modelling mistakes, see “Continuous
Sample Time Conflicts” (on page 40).

PLECS now supports model references into the same model file. See the doc-
umentation for the Model Reference block (on page 561).

PLECS now fully supports self-referencing libraries. In prior releases, self-
references were permitted only if the library reference appeared after the
original subsystem in the model file.

You can now limit the number of parallel computation threads that PLECS
will use for an individual analysis or for the execution of parallel simulations
or analyses. Prior to this, PLECS would limit this number to the number of
CPU cores. See “Analysis Tools — Usage in PLECS Standalone” (on page 186)
and “Configuring PLECS” (on page 124).

PLECS now removes state-space equations for unused physical meters in
order to avoid unnecessary calculations. This is controlled with a new solver
option Remove unused state-space outputs, see “Simulation Parameters”
(on page 111).

Changed Behavior

¢ When PLECS is operated with a fixed-step solver, all physical domains are

discretized with Radau ITA or Tustin’s method as specified in the solver resp.
coder options. Prior to PLECS 4.8, only the electro-magnetic domain was dis-
cretized in this way, and the state variables from other physical domains
were integrated with Euler’s method. See also “Physical Model Discretiza-
tion” (on page 35).
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Let us have a quick tour and see how PLECS is used. Our aim is to show the
essential elements of PLECS in real applications without regarding all the de-
tails, rules, and exceptions. At this stage, we are not trying to be complete. We
want to get you as soon as possible to the point where you can set up useful ap-
plications. Many of the details are not necessary at the beginning and can be
studied later.

The following section addresses users of PLECS Standalone. If you are using
PLECS Blockset for Simulink, please continue with section “Getting Started
with PLECS Blockset” (on page 19).

Getting Started with PLECS Standalone

The only way to become familiar with a new program is by using it. For this
reason we are presenting here two example circuits that you can reconstruct
on your computer. The examples are based on each other, since the features of
PLECS will be explained step by step.

After starting PLECS the PLECS Library browser is displayed. In the libraries
you find various components from which you can create your circuits. You can
browse through the available libraries and see which components are available.

A Simple Passive Network

The first electrical system we are going to model is a simple RLC network as
shown in Fig. 1.1. A capacitor is charged by a DC voltage source via an RL-
branch and its voltage is monitored with a voltmeter.
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Figure 1.1: Simple RLC network

In order to enter the circuit in PLECS we have to open a new PLECS model.
This is done by selecting “New Model” from the “File” Menu in the Library
Browser.

Components

The components required for our circuit must be copied into this window from
the Library Browser. This is done by dragging them with the mouse. If you
want to copy components already placed in the window, hold down the Ctrl key
(cmd key on macOS) while dragging them.

The electrical components that you need for the RLC network can be found in
in the library “Electrical” in the sub-libraries “Sources”, “Meters” and “Passive
Components”. The scope is located in the library “System”. Instead of browsing
for the components you can also search for them by entering the first letters of
the component you need in the search bar. For example, typing sc shows you
the scope, res all available resistors etc.

After you have copied all components the schematic window should look like
Fig. 1.2. If not, move the components with the left mouse button. To rotate
selected components press Ctrl-R, to flip them horizontally press Ctrl-F. All
these functions can also be accessed via the menu bar.

Connections

The unconnected electrical terminals of a component are marked with little hol-
low circles. If we bring the mouse pointer close to such a terminal, the pointer
shape changes from an arrow to a cross. We now can drag a connection to an-
other component by holding the left mouse button down. When we approach
another terminal or an existing connection the pointer shape changes into a
double cross. As soon as we release the mouse button an electrical connection
will be created.
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Figure 1.2: PLECS schematic

For drawing a branch connection place the mouse pointer on an existing connec-
tion where you want the branch to start. With the right mouse button or with
the left mouse button while holding down the Ctrl key you can create a connec-
tion from there to the desired destination.

Component Properties

Each component is identified by a unique name, which is chosen automatically.
You may change it as you wish by double-clicking on it in the schematic. The
name is intended only for documentation purposes and does not affect the sim-
ulation. Of greater importance are the parameters that determine, for example,
the inductance of an inductor, the capacity of an capacitor, or the voltage of a
DC voltage source. A double-click on the component icon opens a dialog box in
which you can set these parameters. Fig. 1.3 shows the dialog box for an induc-
tor.

If you want selected parameters to be displayed in the schematic, check the
check box on the right side of the edit field. For reasons of clarity we prefer to
display only the most important parameters of a component.

Units

PLECS does not know anything about units. It is your responsibility that vari-
ables are scaled correctly. For power electronics we recommend the use of SI
quantities. However, if you want to employ PLECS for the simulation of power
systems, it may be more appropriate to work with “per unit” quantities.

13



1 Cetting Started

14

4 Block Parameters: untitied/L1 |
Inductar
’7 Ideal inductar,

Parameters | Assertions

Inductance:

o.001] r

Initial current:

Jo I~

[o4 I Cancel | Apply | Help

Figure 1.3: Inductor dialog box

For every component enter the values according to the schematic in Fig. 1.1. In
the dialog boxes of the inductor and the capacitor you can additionally set the
initial current resp. the initial voltage. Please leave both values at zero.

Signals

In addition to the electrical connections (wires) that are used to connect elec-
trical components PLECS also makes use of unidirectional signals. The signals
are painted in green and have an arrowhead to indicate their direction. In the
RLC example a signal connects the output terminal of the voltmeter to the in-
put terminal of the scope.

PLECS uses signals to carry non-electrical information like measurement val-
ues or triggering pulses for switches. Signals can be used in calculations and
displayed in a scope. Electrical connections cannot be fed into a scope directly,
you always have to use a volt- or ammeter to convert the electrical quantities
into a signal first.

By this time your model should look similar to Fig. 1.4. To start the simulation,
press Ctrl-T or select “Start” from the “Simulation” menu. In order to see the
more interesting part of the simulation, you need to set the time span to 0.1. To
do this, open the Simulation Parameters dialog by clicking the corresponding
menu entry in the “Simulation” menu or press Ctrl-E.

You should now get the simulation results shown in below.
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Figure 1.4: Complete model and simulation result

Adding Control Blocks

To enhance our model we would like to add some dynamic behavior into our
static electrical model. Let us see how the capacitor in our example charges
and discharges if we apply a pulsed voltage. In the schematic we replace the
DC voltage source by a controlled one. The input of the voltage source can be
any signal generated from one of the control blocks in PLECS. In Fig. 1.5 we
used a pulse generator with a period of 0.04s and an amplitude of 10 to control
the voltage source.
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Figure 1.5: RLC network with a pulsed voltage source
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Buck Converter

In the next example we will introduce the concept of ideal switches, which
distinguishes PLECS from other simulation programs. It will be shown how
switches are controlled, i.e. either by voltages and currents in the system or by
external signals.

25 mH

Isrc

Vsre /N 220 uF —— wve 20

Figure 1.6: Schematic of buck converter

Switches

In the buck converter outlined in Fig. 1.6 we will model the transistor as an en-
tirely controllable switch and bear in mind that it may conduct current only

in one direction. We also need a free-wheeling diode. The diode is a switch

that closes as the voltage across it becomes positive, and opens as the current
through it becomes negative.

The diode can be found in the library “Electrical / Power Semiconductors” and
the switch in the library “Electrical / Switches”. All components in these li-
braries are based on ideal switches that have zero on-resistance and infinite
off-resistance. They open and close instantaneously. In some components like
the diode you may add a forward voltage or a non-zero on-resistance. If you are
unsure about these values, leave them at zero.

The switch is controlled by an external signal. It will close upon a non-zero in-
put and open when the signal goes back to zero.

We start with the electrical part of the buck converter first. By now you should
be able to model it as shown in Fig. 1.7.

Subsystems

We'd also like to separate the electrical part from the control part. This has no
effect on the simulation result but makes the whole system more structured.
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Figure 1.7: Electrical part of buck converter

Once you have completed the circuit from Fig. 1.7, select all components (ei-
ther by clicking on an empty space in the upper left corner of the schematic and
dragging a frame to the lower right corner, or by pressing Ctrl-A). Now create
a new subsystem by selecting “Create Subsystem” from the “Edit” menu or by
pressing Ctrl-G. The electrical components are now in a new subsystem “Sub”.
You can rename it to something more meaningful, e.g. “Circuit” and change the
icon size by dragging one of the selected corners. You can also move the name
label to another position by clicking and dragging it to the borders or the cor-
ners of the icon. Now your system should look similar to Fig. 1.8.

4 untitled * -0 x| 44 untitled /Circuit * =13 x|
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Figure 1.8: Electrical Subsystem

To connect the subsystem to the outer schematic we need to place ports into it.
Drag two Signal Inports and two Signal Outports into the subsystem schematic
and connect them to the voltage source, the switch, the volt- and the ammeter
respectively. Note that a new terminal appears in the subsystem icon for each
port that you drag into the subsystem schematic.

For the buck converter we will implement a hysteresis type control that keeps

17
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the capacitor voltage roughly in a +0.2'V band around 6 V. To make things a
bit more interesting we apply a step change from 12V down to 8 V to the input
voltage during the simulation.
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Figure 1.9: Simulation of buck converter with hysteresis control

Demo Models

Now that you’ve built your first own models in PLECS it may be worthwhile to
take a look at the demo models that come with PLECS. Open the demo model
browser by selecting “Demo Models” from the “View” Menu.
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Getting Started with PLECS Blockset

To access PLECS you simply need to enter plecslib in the MATLAB command
line. This will bring up a Simulink model that contains a generic PLECS block
named “Circuit” and various component libraries. In the libraries you find elec-
trical components, from which you can create your circuits. Alternatively, you
may access the PLECS toolbox by opening it in the Simulink library browser.

A Simple Passive Network

The only way to become familiar with a new program is by using it. For this
reason we are presenting here two example circuits that you can reconstruct
on your computer. The examples are based on each other, since the features of
PLECS will be explained step by step.

The first electrical system we are going to model is a simple RLC network as
shown in Fig. 1.10. A capacitor is charged by a DC voltage source via an RL-
branch and its voltage is monitored with a voltmeter.

10mH 100
Y Y M
m +
10V 100 uF == v¢

Figure 1.10: Simple RLC network

In order to enter the circuit in PLECS we have to open a new Simulink model.
Into the model window we copy the block “Circuit” from the PLECS library by
dragging it with the mouse. Our Simulink model should now look like Fig. 1.11.

Components

A double-click on the PLECS block will open an empty schematic window with
a menu bar quite similar to the one of a Simulink window. The components re-
quired for our circuit must be copied into this window from the components
libraries. Like in Simulink, this is done by dragging them with the mouse. If
you want to copy components already placed in the window, hold down the Ctrl
key (cmd key on macOS) while dragging the mouse. The components that you
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Figure 1.11: Simulink model

need for the RLC network can be found in in the library “Electrical” in the sub-
libraries “Sources”, “Meters” and “Passive Components”.

After you have copied all components the schematic window should look like
Fig. 1.12. If not, move the components with the left mouse button. To rotate
selected components press Ctrl-R, to flip them horizontally press Ctrl-F. All
these functions can also be accessed via the menu bar.

-loix]
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Figure 1.12: PLECS schematic

Note You cannot place Simulink objects in a PLECS schematic and vice versa
since both programs do not share the same Graphical User Interface.
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Connections

The unconnected electrical terminals of a component are marked with little hol-
low circles. If we bring the mouse pointer close to such a terminal, the pointer
shape changes from an arrow to a cross. We now can drag a connection to an-
other component by holding the left mouse button down. When we approach
another terminal or an existing connection the pointer shape changes into a
double cross. As soon as we release the mouse button an electrical connection
will be created.

For drawing a branch connection place the mouse pointer on an existing connec-
tion where you want the branch to start. With the right mouse button or with
the left mouse button while holding down the Ctrl key you can create a connec-
tion from there to the desired destination.

Component Properties

Each component is identified by a unique name, which is chosen automatically.
You may change it as you wish by double-clicking on it in the schematic. The
name is intended only for documentation purposes and does not affect the sim-
ulation. Of greater importance are the parameters that determine, for example,
the inductance of an inductor, the capacity of an capacitor, or the voltage of a
DC voltage source. A double-click on the component icon opens a dialog box in
which you can set these parameters. Fig. 1.13 shows the dialog box for an in-
ductor.

“4 Block Parameters: untitled/L1 x|
Inductar
’7 Ideal inductar,

Parameters | Assertions

Inductance:

Jo.001] r
Initial current:

Jo I~

[0]4 I Cancel | Apply | Help |

Figure 1.13: Inductor dialog box

If you want selected parameters to be displayed in the schematic, check the
check box on the right side of the edit field. For reasons of clarity we prefer to
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display only the most important parameters of a component.

Units

Like Simulink PLECS does not know anything about units. It is your responsi-
bility that variables are scaled correctly. For power electronics we recommend
the use of SI quantities. However, if you want to employ PLECS for the sim-
ulation of power systems, it may be more appropriate to work with “per unit”
quantities.

For every component enter the values according to the schematic in Fig. 1.10.
In the dialog boxes of the inductor and the capacitor you can additionally set
the initial current resp. the initial voltage. Please leave both values at zero.

Signals

Up to now our electrical circuit lacks a connection with the Simulink environ-
ment. You will notice this from the fact that the PLECS block in Simulink does
not have inputs or outputs. In order to add inputs and outputs we must copy
the respective port blocks from the library “System” into the schematic. In our
case we want to access in Simulink the voltage measured by the voltmeter.
Therefore, we need the “Signal Outport” block that exports a signal into the
parent system.

Signals in PLECS correspond to the connections between Simulink blocks. They
provide unidirectional information interchange between components and with
Simulink.

Connect the output of the voltmeter with the input of the port block. In
Simulink, connect a Scope to the output of the PLECS block and start the simu-
lation. In order to see the more interesting part of the simulation, you probably
need to set the stop time to 0. 1. By this time you should have something like
Fig. 1.14 and Fig. 1.15 on your screen.

Adding More Measurements

If you want to measure other quantities in the circuit, simply add the required
voltmeters and ammeters. The measured signals can be exported to Simulink
with additional port blocks. Alternatively you can bundle the measured signals
into a vector by using the multiplexer for signals “Signal Multiplexer” from the
library “System”.
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Figure 1.14: Complete model
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Figure 1.15: Simulation result

You can also add scopes in the PLECS schematic directly. The “Scope" block can
be found in the library “System".

Importing Signals

You have already learned how to export signals from the electrical circuit to
Simulink via the output block. In the same manner you can also import signals
from Simulink into your circuit, usually to control sources.

Let us see how the capacitor in our example charges and discharges if we apply
a pulsed voltage. In the schematic we replace the DC voltage source by a con-
trolled one. Copy the input block “Signal Inport” into the schematic and connect
it to the voltage source. The PLECS block in Simulink now also has an input
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terminal. Any Simulink signal that you connect to this terminal will be trans-
lated into a voltage in the electrical circuit. In Fig. 1.16 we used a pulse genera-
tor with a period of 0.04 s and an amplitude of 10.

-icix
IOixd| P e ve reb
File Edit ¥iew Simulation Format Tools Help JJ (e N> Q§ RD |.H.' |qa ||f|i |°

DSEH&| + =B e 4|9

h 4

Int PI_'EC. ut 1
Circui

Pulze
Generator

Scope

Circuit

1 1
0.04 0.06

Fl100%% | | |odeds 4

Figure 1.16: RLC network with a pulsed voltage source

The signal generated by the pulse generator is discrete, i.e. its value changes
abruptly. Normally, the PLECS Scope would determine the signal type auto-
matically and display vertical slopes. In this case, however, the discrete signal
coming from the pulse generator is multiplexed with a continuous signal before
reaching the Scope. In order to avoid trapezoidal curves, the signal type must
be set manually to “discrete” in the Data window of the Scope (see Fig. 1.17).

Figure 1.17: Data window of the PLECS Scope

Buck Converter

In the next example we will introduce the concept of ideal switches, which
distinguishes PLECS from other simulation programs. It will be shown how
switches are controlled, i.e. either by voltages and currents in the system or by
external signals.
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Figure 1.18: Schematic of buck converter

Switches

In the buck converter outlined in Fig. 1.18 we will model the transistor as an
entirely controllable switch and bear in mind that it may conduct current only
in one direction. We also need a free-wheeling diode. The diode is a switch
that closes as the voltage across it becomes positive, and opens as the current
through it becomes negative.

The diode can be found in the library “Electrical / Power Semiconductors” and
the switch in the library “Electrical / Switches”. All components in these li-
braries are based on ideal switches that have zero on-resistance and infinite
off-resistance. They open and close instantaneously. In some components like
the diode you may add a forward voltage or a non-zero on-resistance. If you are
unsure about these values, leave them at zero.

In order to control the switch in our buck converter we import another signal
from Simulink and connect it to the switch. The switch will close upon a non-
zero signal and open when the signal goes back to zero.
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Figure 1.19: Electrical part of buck converter

By now you should be able to model the electrical part of the buck converter as
shown in Fig. 1.19. For the buck converter we will implement a hysteresis type
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control that keeps the capacitor voltage roughly in a 0.2V band around 6 V. To
make things a bit more interesting we apply a step change from 12V down to
8V to the input voltage during the simulation.
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Figure 1.20: Simulation of buck converter with hysteresis control

Demo Models

Now that you’ve built your first own models in PLECS it may be worthwhile to
take a look at the demo models that come with PLECS. Open the demo model
browser by selecting “Demo Models” from the “View” Menu.



How PLECS Works

PLECS is a software package for modeling and simulating dynamic systems. As
with any other software package, in order to make the best use of it you should
have a basic understanding of its working principles. Before delving into the
question how PLECS works, however, it is worthwhile to distinguish between
the terms modeling and simulation.

The term modeling refers to the process of extracting knowledge from the sys-
tem to be simulated and representing this knowledge in some formal way.

The second part — i.e. the representation of knowledge — can be more or less
straightforward depending on the formalism used. PLECS offers three differ-
ent formalisms — equations (implemented as C-code), block diagrams and phys-
ical models — that can be used in the same modeling environment. They are de-
scribed in the following section.

The term simulation refers to the process of performing experiments on a model
in order to predict how the real system would behave under the same condi-
tions. More specifically, in the context of PLECS, it refers to the computation of
the trajectories of the model’s states and outputs over time by means of an ordi-
nary differential equation (ODE) solver. This is described in the second section.

Modeling Dynamic Systems

A system can be thought of as a black box as depicted below. The system does
not exchange energy with its environment but only information: It accepts in-
put signals u, and its reactions can be observed by the output signals .

A system can have internal state variables that store information about the
system’s past and influence its current behavior. Such state variables can be
continuous, i.e. they are governed by differential equations, or discrete, i.e. they
change only at certain instants. An example of a continuous state variable is
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the flux or current of an inductor; an example of a discrete state variable is the
state of a flip flop.

System Equations

One way to describe a system is by mathematical equations. Typical system
equations are listed below:

* An output function describes the system’s outputs in terms of the current
time, the system’s inputs and its internal states.

¢ Ifthe system has discrete states, an update function determines if and how
they change at a given time for the current inputs and internal states.

¢ If the system has continuous states, a derivative function describes their
derivatives with respect to time.

Symbolically, these functions can be expressed as follows:

Yy = foutput(tauaxc,xd)
xgeXt = fupdate(tvuaxcazd)

jjc fderivative(ta u, Z’C,Id)

Such a description is most convenient for implementation in a procedural pro-
gramming language like C.

Block Diagrams

A more graphic modeling method that is commonly used in control engineering
is a block diagram such as the one below which shows a low pass filter.

Each of the three blocks is again a dynamic system in itself, that can be de-
scribed with its own set of system equations. The blocks are interconnected
with directed lines to form a larger system. The direction of the connections
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determines the order in which the equations of the individual blocks must be
evaluated.

Physical Models

Block diagrams are very convenient to model control structures where it is clear
what the input and output of a block should be. This distinction is less clear or
impossible for physical systems.

For instance, an electrical resistor relates the quantities voltage and current
according to Ohm’s law. But does it conduct a current because a voltage is ap-
plied to it, or does it produce a voltage because a current is flowing through it?
Whether the first or the second formulation is more appropriate depends on the
context, e.g. whether the resistor is connected in series with an inductor or in
parallel with a capacitor. This means that it is not possible to create a single
block that represents an electrical resistor.

Therefore, block diagrams with their directed connections are usually not very
useful for modeling physical systems. Physical systems are more conveniently
modeled using schematics in which the connections between individual compo-
nents do not imply a computational order.

PLECS currently supports physical models in the electrical, magnetic, mechani-
cal and thermal domains (in the form of lumped parameter models).

Simulating Dynamic Systems

A simulation is performed in two phases — initialization and execution — that
are described in this section.

Model Initialization
Physical Model Equations

PLECS first sets up the system equations for the physical model according to
e.g. Kirchhoff’s current and voltage laws. If the physical model contains only
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ideal linear and/or switching elements, it can be described by a set of piece-wise
linear state-space equations:

x=A,x+B,u
y=C,x+D,u

The subscript o is due to the fact that each state-change of a switching element
leads to a new set of state-space matrices.

The complete physical model is thus represented by a single, atomic subsystem.
The following figure shows the interaction between the physical subsystem, the
surrounding block diagram and the ODE solver.

- D
1 Event
Solver s detection
\ /
g N
M . measure-
continuous _ ol S | H o " ments
inputs 'E_» E i g
o]
5
> | €
gid <
gate o 2
inputs = . o ug)
Physical model W
\

Switched state-space implementation

The physical subsystem accepts external input signals for controllable sources
and for switching elements and it provides an output signal containing the val-
ues of physical measurements. During the simulation, the derivatives of the
physical state variables are calculated and handed over to the solver which in
turn calculates the momentary values of these state variables.

The Switch Manager monitors the gate signals and the internal measurements
and decides whether a switching action is necessary. The Switch Manager also
provides auxiliary signals — so-called zero-crossing signals — to the solver for
proper location of the exact instants when a switching should occur.

A flowchart of the Switch Manager is shown in the figure below. In every simu-
lation step, after the physical measurements have been calculated, the Switch
Manager evaluates the switching conditions of all switches in the physical
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model. If a switching action is necessary, it initiates the calculation of a new

set of state-space matrices or fetches a previously calculated set from a cache.
Afterwards, it recalculates the physical measurements with the new state-space
matrices to check whether further switching actions of naturally commutated
devices are required. It will iterate through this process until all switches have
reached a stable position. If a set of switch states o is encountered repeatedly
in this process, PLECS is unable to determine stable conditions and aborts the
simulation.

Start with
given u, x,

D —

Calculate Toggle switches
state-space and get new
outputs topology &

no
Switching Switch loop
required? detected?
no

Continue with
next step

Switch Manager flowchart

Block Sorting

After the setup of the physical model, PLECS determines the execution order
of the block diagram. As noted above, the physical model is treated as a single
atomic subsystem of the block diagram. The execution order is governed by the
following computational causality:

If the output function of a block depends on the current value of one or
more input signals,the output functions of the blocks that provide these
input signals must be evaluated first.
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Direct feedthrough The property of an input port whether or not its cur-
rent signal values are required to compute the output function is called direct
feedthrough. For example, the output function of a linear gain is

y=k-u

and so the input signal of the gain has direct feedthrough. In contrast, the out-
put function of an integrator is

Y=2Tc

i.e. the integrator just outputs its current state regardless of the current input.
The integrator input therefore does not have direct feedthrough.

Algebraic loops An algebraic loop is a group of one or more blocks that are
connected in a circular manner, so that the output of one block is connected to a
direct feedthrough input of the next one.

For such a group it is impossible to find a sequence in which to compute their
output functions because each computation involves an unknown variable (the
output of the previous block). Instead, the output functions of these blocks must
be solved simultaneously. PLECS uses a Newton-type equation solver for this
purpose. Since the solver performs iterations in order to find a solution con-
sistent with all blocks, models with algebraic loops may run more slowly than
models without algebraic loops. Failure to find a solution brings the simulation
to a halt with an error message.

See “Simulation Parameters” (on page 111) for a list of parameters that influ-
ence the solution of algebraic loops.

The Initial Condition block (see page 531) can be used to provide a guess to the
equation solver at the start of a simulation.



Simulating Dynamic Systems

Model Execution

The figure below illustrates the workflow of the actual simulation.
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Simulation loop

Main Loop

The main simulation loop — also called a major time step — consists of two ac-

tions:

1 The output functions of all blocks are evaluated in the execution order that
was determined during block sorting. If a model contains scopes, they will be

updated at this point.

2 The update functions of blocks with discrete state variables are executed to
compute the discrete state values for the next simulation step.

Depending on the model and the solver settings, the solver may enter one or
both of the following minor loops.
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Integration Loop

If a model has continuous state variables, it is the task of the solver to numer-
ically integrate the time derivatives of the state variables (provided by the
model) in order to calculate the momentary values of the states variables.

Depending on the solver algorithm, an integration step is performed in multi-
ple stages — also called minor time steps — in order to increase the accuracy of
the numerical integration. In each stage the solver calculates the derivatives at
a different intermediate time. Since the derivative function of a block can de-
pend on the block’s inputs — i.e. on other blocks’ outputs — the solver must first
execute all output functions for that particular time.

Having completed an integration step for the current step size, a variable-step
solver checks whether the local integration error remains within the specified
tolerance. If not, the current integration step is discarded and a new integra-
tion is initiated with a reduced step size.

Event Detection Loop

If a model contains discontinuities, i.e. instants at which the model behavior
changes abruptly, it may register auxiliary event functions to aid a variable-
step solver in locating these instants. Event functions are block functions and
are specified implicitly as zero-crossing functions depending on the current time
and the block’s inputs and internal states.

For instance, if a physical model contains a diode, it will register two event
functions, fium on = vp and fium of = ip, depending on the diode voltage
and current, so that the solver can locate the exact instants at which the diode
should turn on and off.

If one or more event functions change sign during the current simulation

step, the solver performs a bisection search to locate the time of the first zero-
crossing. This search involves the evaluation of the event functions at differ-
ent intermediate times. Since the event function of a block — like the derivative
function — can depend on the block’s inputs, the solver must first execute all
output functions for a particular time. Also these intermediate time steps are
called minor time steps.

Having located the first event, the solver will reduce the current step size so
that the next major time step is taken just after the event.
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Fixed-Step Simulation

As indicated in the previous paragraphs, certain important aspects of the mi-
nor simulation loops require a variable-step solver that can change its step size
during a simulation. Using a solver with a fixed step size has two serious impli-
cations.

Integration Error A fixed-step solver does not have any control over the in-
tegration error. The integration error is a function of the model time constants,
the step size and the integration method. The first parameter is obviously given
by the model, but the second and possibly the third parameter must be provided
by the user. One strategy for determining an appropriate step size is to iter-
atively run simulations and reduce the step size until the simulation results
stabilize.

Event Handling Discontinuities in a physical model — such as the turn-on or
turn-off of a diode or the transition from static to dynamic friction — typically do
not coincide with a fixed simulation step. Postponing such non-sampled events
until the following fixed simulation step will produce jitter and may lead to sub-
sequent runtime errors, e.g. because a physical state variable becomes discon-
tinuous.

For these reasons it is generally recommended to use a variable-step solver.

Physical Model Discretization

In order to mitigate the problems due to non-sampled events, PLECS trans-
forms the physical model into a discrete state-space model when it is simulated
with a fixed-step solver. The continuous state-space equations of the electrical
and magnetic domains are discretized and replaced with the following update
rule:

Xp = A4 Xp—1+Ba1 - up—1 +Ba2 - u,

By default, a first-order hold is applied to the input signals, i.e. it is assumed
that the inputs change linearly from u,,_; in the previous step to u,, in the cur-
rent step. As a consequence, the inputs of the electro-magnetic model now have
direct feedthrough because their current values must be known before the cur-
rent model states and the model output can be calculated. This will result in an
algebraic loop if the value of a controlled voltage or current source depends on a
measurement in the electro-magnetic model.

To avoid this problem, the Controlled Current Source (see page 402) and the
Controlled Voltage Source (see page 822) can be configured to apply a zero-order
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hold on the input signal when the model is discretized. In this case only the in-

put value from the previous simulation step ufﬁl is required to calculate the
current state values.

By default, the discrete state-space matrices A4, Bq: and By, are calculated
from the continuous matrices A and B using a fifth-order accurate fully-implicit
three-stage Runge-Kutta formula (Radau IIA). Alternatively, the bilinear trans-
formation known as Tustin’s method can be chosen. It is only 2nd order accu-
rate and has poor damping characteristics for time constants that are smaller
than the discretization step size, but it is cheaper to compute because Bg;
equals By,. Therefore, it can be useful for real-time simulations where the cal-
culation time is essential. The discretization method can be chosen in the Simu-
lation Parameters dialog (see page 111).

Note that this applies only to the discretization of physical domains. The state
variables from the control block diagram are integrated with Euler’s method.

Interpolation of Non-Sampled Switching Events

With the physical model discretized like this, non-sampled switching events can
be handled efficiently using the following algorithm:

1 Check whether the solver has stepped over a non-sampled switching event in
the last simulation step.

2 If so, determine the time of the event and calculate the model state just after
the event using linear interpolation and handle the event, i.e. toggle one or
more switches.

3 Perform one full forward step.

4 Linearly interpolate the model states back to the actual simulation time.

This algorithm is illustrated using the example of a half-wave rectifier shown
below. The two graphs show the commutation of the dc current from diode D3
(shown in gray) to diode D1 (shown in black). The solid lines show the results
from a simulation with a variable-step solver, large dots mark the steps of the
fixed-step simulation, and small dots mark the internal interpolation steps.

Commutation starts when the voltage across D1 becomes positive. The fixed-
step solver first steps well beyond the zero-crossing of the voltage (1). PLECS
then internally steps back to the zero-crossing (2) and turns on D1. With the
new set of state-space equations, it performs an internal full step forward (3)
and then interpolates back to the actual simulation time (4). Next, the solver
steps beyond the zero-crossing of the current through D3 (1). Again, PLECS
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internally steps back to the zero-crossing (2) and turns off D3. With the new set
of state-space equations, it performs an internal full step forward (3) and then
interpolates back to the actual simulation time (4).
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Diode currents

Diode voltage

Interpolation of non-sampled switching events

Note that without this interpolation scheme, D3 would have been turned off at
point (1). This would have caused the current through the inductor in phase 3
to become discontinuous. Such a non-physical behavior can lead to gross simu-
lation errors and should therefore be avoided.

Sampled Data Systems

PLECS allows you to model sampled data systems, i.e. discrete systems that
change only at distinct times. You can model systems that are sampled periodi-
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cally or at variable intervals, systems that contain blocks with different sample
rates, and systems that mix continuous and discrete blocks.

Sample Times

Sample times are assigned on a per-block basis. Some blocks may have more
than one sample time, and they may associate assign different sample times to
different input or output terminals. PLECS distinguishes between the following
sample time types:

Continuous A continuous sample time is used for blocks that must be up-
dated in every major and minor time step. This includes all blocks that have
continuous state variables, such as the Integrator or Transfer Function.

Semi-Continuous A semi-continuous sample time is used for blocks that
must be updated in every major time step but whose output does not change
during minor time steps. This applies for instance to the Memory block, which
always outputs the input value of the previous major time step.

Discrete-Periodic A periodic sample time is used for blocks that are updated
during major time steps at regular intervals.

Discrete-Variable A variable sample time is used for blocks that must be up-
dated during major time steps at variable intervals which are specified by the
blocks themselves.

Inherited An inherited sample time is used for blocks that do not have a sam-
ple time of their own but may adopt the sample time from other blocks con-
nected to them. This includes blocks such as Gain, Sum and Product.

Constant A constant sample time is used for blocks that are updated only
once at the beginning of a simulation. The only block that explicitly uses a con-
stant sample time is the Constant block. However, other blocks may inherit a
constant sample time.

For most block types the sample time is automatically assigned. Discrete blocks
and the C-Script block (see page 381) have a parameter Sample Time allowing
you to specify the sample time explicitly. A sample time is specified as a two-
element vector consisting of the sample period and an offset time. The offset
time can be omitted if it is zero.

The table below lists the different sample time types and their corresponding
parameter values.
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Sample Time Parameter Values

Type Value
Continuous [0, O]
0
Semi-Continuous | [0, -1]
Discrete-Periodic | [T,, To]1 T},: Sample period, T}, > 0
Ty T,: Sample offset, 0 < T, < T,
Discrete-Variable | [-2, 0]
-2
Inherited [-1, 0]
-1
Constant [inf, O]
inf

Sample Time Inheritance

For blocks with an inherited sample time, PLECS employs the following propa-
gation scheme to determine an appropriate sample time:

1 Propagate the sample times forward along the block execution order (see
“Block Sorting” on page 31). A block with an inherited sample time will be
assigned a sample time based on the sample times of the blocks that are con-
nected to the block’s inputs.

2 Propagate the sample times backward along the block execution order. A
block with an inherited sample time will be assigned a sample time based
on the sample times of the blocks that are connected to the block’s outputs.

3 Loop until there are no inherited sample times left or until no inherited sam-
ple time can be resolved.

Sample times are assigned according to the following rules:

¢ If any sample time is inherited, the block sample time also remains inher-

ited.
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¢ Else, if all sample times are constant, the block sample time is set to con-
stant.

¢ Else, if any sample time is continuous, the block sample time is set to contin-
uous.

¢ Else, if all sample times are fixed-step discrete or constant and the fastest
sample time is a valid base sample time of the other non-constant sample
times, the block sample time is set to the fastest sample time.

¢ Else, the block sample time is set to semi-continuous.

Any block sample time that cannot be resolved using this propagation scheme
is set to continuous.

Continuous Sample Time Conflicts

A continuous sample time conflict arises when a continuous signal is fed into a
block that expects a discrete input or when a discrete signal is fed into a block
that expects a continuous input. Such a situation typically indicates a mod-
elling error that produces undesirable results.

Example 1 A user attempts to break an algebraic loop by inserting a Mem-
ory block (see page 555). This is problematic if the loop involves a continuous-
time signal because the Memory is a discrete block and converts the continu-
ous signal into a piece-wise constant signal. It also introduces a variable-step
delay when used with a variable-step solver. In order to mitigate the negative
effects of this, the user may be tempted to limit the maximum step size of the
variable-step solver or switch to the fixed-step solver with a small time step,
which leads to very long simulation times.

The proper way to break a continuous algebraic loop is by inserting a continu-
ous low pass filter.

Example 2 A user attempts to produce phase-shifted gate signals for an
interleaved converter with a Transport Delay block (see page 790). This is
problematic because the Transport Delay is a continuous block and produces
the delayed output signal by interpolating between past samples of the input
signal. A rectangular input signal is thus converted into a trapezoidal sig-

nal where the slope depends on the solver step size. Again, they user may be
tempted to limit the maximum step size of the variable-step solver or switch to
the fixed-step solver with a small time step.

The proper block to delay a rectangular or any other discrete signal is the
Pulse Delay (see page 619).
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PLECS will detect such continuous sample time conflicts and flag an appropri-
ate diagnostic warning or error. This is controlled with the solver option Con-
tinuous sample time conflict on the Diagnostics tab of the simulation pa-
rameters dialog, see “Simulation Parameters” (on page 111).

Multirate Systems

Systems that contain blocks with multiple different discrete-periodic sample
times are called multirate systems. For such systems, PLECS calculates a base
sample time as the greatest common divisor of the periods and offsets of the
individual sample times. The individual periods and offsets are then expressed
as integer multiples of the base sample time.

This is necessary in order to avoid synchronization problems between blocks
with different sample times that would occur when the sample hits are calcu-
lated using floating-point arithmetic. For instance, in double precision floating-
point arithmetic 3*1e-4 is not equal to 3e-4 (even though the difference is only
about 5.4 x 10720),

In order to find the greatest common divisor, PLECS may slightly adjust indi-
vidual sample periods or offsets within a relative tolerance of approximately
+10~8. PLECS does not allow the base sample time to become smaller than
10~% times the largest sample period in order to avoid overflows in the integer
arithmetic.

Troubleshooting

If PLECS fails to find an appropriate base sample time, it will show a corre-
sponding error message. There are three possibilities to resolve the problem:

Adjusting the sample times Adjust the sample times of the individual
blocks in the system so that PLECS can find a base sample time within the
above constraints. Whenever possible, specify sample times as rational num-
bers instead of decimal fractions. For instance, for a block that is sampled with
a frequency of 30 kHz enter 1/30e3 instead of 3.3333e-5.

Allow multiple base sample times You can allow PLECS to use different
base sample rates for different groups of block sample times. To do so, uncheck
the option Use single base sample rate in the simulation parameters dialog.
Only block sample times within the same group are then guaranteed to be syn-
chronized with each other.
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Disable sample time synchronization You can disable the sample time
synchronization altogether by unchecking the option Synchronize fixed-step
sample times in the simulation parameters dialog. This is generally not rec-
ommended.

The last two options are only available when using a continuous state-space
model with a variable-step solver.
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Data Types

PLECS can use different data types to store the value of a signal. Boolean, in-
teger and floating-point data types are listed in the table below. Additionally
fixed-point data types are supported (see next section).

Data Types
Name Description
bool Boolean
uint8_t Unsigned 8-bit integer
int8 t Signed 8-bit integer
uint16_t | Unsigned 16-bit integer
int16_t Signed 16-bit integer
uint32_t | Unsigned 32-bit integer
int32_t Signed 32-bit integer
float Single-precision floating point
double Double-precision floating point
target A pseudo data type that resolves to single-precision or

double-precision floating point depending on the simulation
target. For normal simulations and when using the PLECS
Blockset Coder, this type resolves to double. When using
the PLECS Standalone Coder, the type is determined by the
parameter Floating point format in the Coder Options
dialog (see “Generating Code” on page 285).

Fixed-Point Data Types

PLECS supports signed and unsigned fixed-point numbers with a word length
of 8, 16 or 32 bits. The scaling and interpretation of the fixed-point value is de-
fined by the number of fractional bits. The results of arithmetic operations are
rounded to the closest representable number in direction of negative infinity
(two’s complement truncation).
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When you select a Fixed-point number data type, additional control elements
appear. The signedness and word length are set by selecting the base data

type from the combo box. The number of fractional bits can be specified with
the spin box. The resulting range and precision of the current settings are dis-
played underneath.

A fixed-point data type can also be passed with a reference variable by specify-
ing its properties as a structure. E.g. struct(’Signed’, 1, ’WordLength’,
32, ’FractionLength’, 16) specifies a signed 32-bit fixed-point data type
with 16 fractional bits.

Setting the global model parameter Use floating-point data type for fixed-
point signals (see “Simulation Parameters” on page 111) overwrites all fixed-
point data types with the target floating-point data type. This can be used to
easily compare the accuracy of fixed-point operations with floating-point opera-
tions.

Blocks with an Implicit Output Data Type

Certain blocks have an implicit output data type. For instance, all physical
meters use the target output type, and a logical operator always outputs a
Boolean signal. Other blocks with implicit output data types are listed be-
low:

¢ Comparator (see page 388), bool

¢ Compare to Constant (see page 389), bool

¢ Edge Detection (see page 439), bool

¢ FMU (see page 460), according to the FMU description

¢ Hit Crossing (see page 475), bool

* Logical Operator (see page 542), bool

* Monoflop (see page 562), bool

¢ Relational Operator (see page 628), bool

* Sign (see page 678), int32_t

¢ Trigger (see page 797), bool

Specifying an Output Data Type

The following blocks let you specify the data type of their output signals:
* Constant (see page 391)
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Data Type (see page 406)
Enable (see page 447)

Gain (see page 464)

Offset (see page 584)
Product (see page 618)
Pulse Generator (see page 620)
Relay (see page 629)
Rounding (see page 649)
Signal Input (see page 671)
Step (see page 694)

Sum (see page 698)

Some of these blocks also let you choose to inherit the output data type from the
input signal(s).

Data Type Inheritance

The following blocks implicitly inherit the output data type from the input sig-
nals:

Abs (see page 358), the unsigned input data type is set as output data type
Delay (see page 410)

Dynamic Signal Selector (see page 438)
Function (see page 459)

Initial Condition (see page 531)
Manual Signal Switch (see page 550)
Memory (see page 555)

Minimum / Maximum (see page 557)
Multiport Signal Switch (see page 572)
Saturation (see page 659)

Signal Switch (see page 677)

Zero Order Hold (see page 837)

If the input signals have heterogeneous data types, an error message is gen-
erated, unless there is at least one floating-point data type and no fixed-point
data type. In this case the floating-point data type is inherited. To explicitly set
the data type of one of the above blocks, insert a Data Type block (see page 406)
in front of the block.
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Earlier versions of PLECS implemented more relaxed data type inheritance
rules by choosing the data type with the greatest order (as defined in the ta-
ble above). These rules can be applied to legacy models by changing the global
model parameter Datatype inheritance conflict (see “Simulation Parame-
ters” on page 111).

Data Type Overflows

Data type overflows are handled individually per block according to the Data
type overflow handling parameter. This option applies to simulations and
generated code. The options are:

¢ Unchecked Overflows are ignored, the resulting value is dependent on the
platform and the compiler used. The most efficient code is generated with
this option.

¢ Saturate Overflows/underflows are clamped to the maximum/minimum rep-
resentable value of the data type.

¢ Assert with error The simulation or program execution is aborted with an
error if an overflow is detected.

With the global model parameter Datatype overflow (see “Simulation Pa-
rameters” on page 111) warning/error messages on data type overflow can be
enabled independent from the individual block settings. This parameter only
affects simulations and not code generation.
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The main user interface of PLECS is the graphical schematic editor in which
you create block diagrams and physical models. This chapter describes the
aspects of the schematic editor that are common to PLECS Standalone and
PLECS Blockset but also the differences between the two that are highlighted
in the first two sections.

Using PLECS Standalone

Creating a New Model

To create a new model, choose New Model from the File menu. It is good prac-
tice to save the new model before you make any changes in order to enable the
auto-save functionality.

Importing a Schematic From PLECS Blockset

To facilitate data exchange between PLECS Standalone and PLECS Block-
set, you can import the schematics of PLECS Circuit blocks inside a Simulink
model. To do so, choose Import form Blockset... from the File menu.

Note PLECS cannot import the Simulink blocks within a Simulink model
because there is no exact match between Simulink blocks and PLECS compo-
nents.
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Using PLECS Blockset

The main element of PLECS Blockset is the PLECS Circuit block in the
PLECS Library. This block constitutes the interface between the PLECS sim-
ulation engine and the Simulink solver.

To open the PLECS library, type plecslib at the MATLAB command prompt or
click on the Library Browser icon in a Simulink window and click on PLECS
in the Simulink Library Browser window.
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Creating a New Circuit

To create a new circuit, copy the PLECS Circuit block from the PLECS library
into your Simulink model, then double-click the block to open the schematic edi-
tor.
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Note You cannot place Simulink blocks in a PLECS schematic or PLECS com-

ponents in a Simulink model because the two programs do not share the same
Graphical User Interface.

Importing a Schematic From PLECS Standalone

To facilitate data exchange between PLECS Blockset and PLECS Standalone,
you can import the schematics of a PLECS Standalone model into a PLECS

Blockset schematic. To do so, choose Import from Standalone... from the File

menu.

Opening a PLECS Standalone Model

You can also directly open.a PLECS Standalone model in the PLECS Blockset
schematic editor. This is useful if you want to work with the Model Reference
(see page 561) block.

To open a PLECS Standalone model, choose Open from the File menu of a
schematic editor or the PLECS Library Browser and change the file type fil-
ter in the file dialog to PLECS Standalone model files (*.plecs). Note that
the schematic editor of a PLECS Standalone model does not have a Simu-
late menu in PLECS Blockset because you cannot run a simulation without a
Simulink model.

Customizing the Circuit Block

You can customize the mask of the Circuit block to a certain extent, e.g. in or-
der to change the block icon or to define mask parameters. For information on
Simulink block masks please refer to the Simulink documentation.

Note You may not change the mask type or remove the callback from the ini-
tialization commands. Doing so will break the interface and may lead to loss of
data.
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If you define mask parameters for the Circuit block, PLECS evaluates com-
ponent parameters in the mask workspace rather than the MATLAB base
workspace. The mask workspace contains both the mask parameters and any
additional variables defined by the mask initialization commands. For details
on parameter evaluation see “Specifying Component Parameters” (on page 52).

By default, a double-click on the Circuit block opens the schematic editor. This
can be changed by editing the OpenFcn parameter of the block. To change the
behavior so that a double-click opens both the schematic editor and the mask
dialog,

1 Select the block, then choose Block Properties from the Edit menu or from
the block’s context menu.

2 On the Callbacks pane of the block properties dialog, select OpenFen from
the function list and change the content of the callback function to

plecs('sl',202); open_system(gcb, 'mask');

Alternatively, you can change the behavior so that a double-click opens only the
mask dialog. Then, add a checkbox to the dialog that will open the schematic
editor when you click on it:

1 Select the block, then choose Block Properties from the Edit menu or from
the block’s context menu.

2 On the Callbacks pane of the block properties dialog select OpenFen from
the function list and clear the content of the callback function.

3 Select the block, then choose Edit Mask from the Edit menu or from the
block’s context menu.

4 On the Parameters pane of the mask editor add a checkbox parameter with
the prompt Open schematic and the variable name openschematic. As a dia-
log callback for the new parameter enter

if (strcmp(get_param(gcb, 'openschematic'),'on'))
set_param(gcb, 'openschematic', 'off');
plecs('sl',202);

end
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Using the Library Browser

In PLECS Standalone it is opened automatically when the program is started.
In PLECS Blockset the library browser is opened by a double-click on the Com-
ponents block in the PLECS library. It can always be re-opened by choosing Li-
brary Browser in the Window menu or using the shortcut Ctrl-L.

You can navigate through the component library by clicking on the tree entries.
Alternatively, you can search for a specific component by typing part of its name
into the search bar.
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Drag the components you need from the library browser into the schematic edi-
tor.
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Copying a Component into a Schematic

You can copy a new component into a schematic in different ways:

* Drag a component from the Library Browser into the schematic.

¢ Click into the schematic and start typing the type name of the desired com-
ponent. This will open a mini browser in a popup window. To insert a com-
ponent, use the up/down cursor keys and press Enter, or click and drag the
component to the desired location. To close the mini browser without insert-
ing a component, press the Esc key.

¢ Press and hold the Ctrl key (Cmd key on macOS), then drag an existing
component from the same or a different schematic.

Moving a Component

To move a component, click it with the left mouse button and drag it to the de-
sired location. If the component has connected terminals, the connections are
automatically rerouted to the new location so that the terminals remain con-
nected. To cut any existing connections when moving a component, hold the
Shift key while dragging the component.

Specifying Component Parameters

Every component has a dialog box to view and modify the component param-
eters. To open the parameter dialog, double-click on a component or select the
component and choose Parameters... from the Edit menu or the component’s
context menu.

Most component parameters accept MATLAB expressions as values, provided
that they evaluate to an acceptable result. Parameter expressions are evalu-
ated when you start a simulation or update the Simulink model. In case an er-
ror occurs during evaluation of the parameters, an error dialog appears and the
corresponding component is highlighted.

An exception to this behavior are parameters that affect the appearance of the
component such as the parameter Number of windings of the Mutual Induc-
tor (see page 573) or the parameter Width of the Wire Multiplexer (see page
832). Such parameters must be literal values and are evaluated immediately.
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Diode
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Integer values may be specified as decimal, binary or hexadecimal values. Hex-
adecimal integers are prefixed by 0x, binary integers are prefixed by Ob. The
expressions Oxfa and 0b11111010, for example, both evaluate to 250.

Using Workspace Variables in Parameter Expressions

Parameter expressions that are not evaluated immediately can include
workspace variables. Expressions are evaluated as a whole in one workspace.
By default, the evaluation workspace is the base Octave or MATLAB
workspace. Notice that in PLECS Standalone every model has its own base Oc-
tave workspace that is populated by the model initialization commands that
can be configured in the Simulation Parameters dialog, see “Model Initializa-
tion Commands” (on page 118).

However, you can define local mask workspaces for subsystems that will then
be used for the parameter evaluation in the underlying schematics. For infor-
mation on subsystem mask workspaces see “Mask Parameters” (on page 76).

In PLECS Blockset you can also mask the Circuit block as a whole. This is nec-
essary e.g. if you want parameter expressions to be evaluated in the Simulink
model workspace instead of the MATLAB base workspace, or when you use the
sim command from within a MATLAB function and want to access the function
workspace. For more information see “Customizing the Circuit Block” (on page
49).
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Displaying Parameters in the Schematic

You can cause PLECS to display any component parameter beneath the com-
ponent name in the schematic. To specify which parameter should be displayed
in the schematic, open the dialog box and check the check box next to the pa-
rameter edit field. Parameter values can be edited in the schematic directly by
double-clicking them.

Changing Parameters of Multiple Components

You can simultaneously change the parameters of multiple components of the
same type. To do so, select the components, then double-click any of them or
choose Parameters... from the Edit menu or the components’ context menu.

Parameters that have different values for the selected components show a
placeholder text multiple values. If you leave this placeholder as is, the com-
ponents retain their individual values for this parameter when you apply any
other changes that you have made.

Changing Parameters During a Simulation

Parameters are evaluated once a new simulation is started. Their values re-
main constant throughout the simulation. Certain parameters can be changed
during the simulation, their value is used as soon as the change is applied. De-
pending on the parameter type it may be necessary to reevaluate other parts of
the model, which may take some extra computation time.

Parameters are changeable during the simulation if they do not change the
structure of the model. If, for example, a parameter value is a vector, the ele-
ments of the vector may be changed, whereas the size of the vector must remain
the same. Parameters that influence the number of terminals of a component or
the width of a signal cannot be changed during simulation.

Changing Component Names

To edit a component name, double-click it in the schematic. Press Enter or click
anywhere outside the label to finish editing. Press Shift+Enter to enter a line
break for component names that span multiple lines. To show or hide a compo-
nent name, toggle Show name in the Format menu.

All component names in the same schematic must be unique and must contain
at least one non-space character. Trailing spaces are removed from the names.
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Placing the Component Label

The label of a component can be placed at any of the following 16 positions
along the component frame: at the four corners, at the center of the four edges
and at two off-center positions of each of the four edges. The label of a Subsys-
tem block can additionally be placed at the center of the component frame.

To change the placement of a label, press the left mouse button and drag it to a
new location. While you hold down the mouse button, small dots mark the pos-
sible positions, and a dashed rectangle indicates the new label position. When
you release the mouse button, the label is moved. The horizontal and vertical
alignment of the label text is automatically adjusted to the label position.

Label | x

Changing the Orientation of Components

You can change the orientation of a component by choosing one of these com-
mands from the Format menu:

* The Rotate command rotates a component clockwise 90 degrees (Ctrl-R).
¢ The Flip left/right command flips a component horizontally (Ctrl-F).

¢ The Flip up/down command flips a component vertically (Ctrl-I).

Disabling Components

If you would like to disable one or more components temporarily so that they do
not affect the behavior of a model, you can do so by commenting them. The term
“commenting” is inspired by the programming pattern of disabling lines of code

by commenting them. There are two possibilities to comment a component:

Comment Out Commenting out a component has the same effect on the
model as deleting the component, leaving the connections that lead to and from
the component unconnected.
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Comment Through For certain types of components it is useful to “close the
gap” when they are commented. For instance, you may want to replace a com-
mented resistor with a short circuit rather than an open circuit.

A commented component is drawn with dimmed colors, and the connections
leading to and from it are also dimmed. If a component is commented through,
solid lines indicate the terminals that are connected with each other, and the
corresponding external connections are not dimmed. This is demonstrated in
the figure below.

11+

To comment or uncomment a component interactively, select it and toggle Com-
ment out or Comment through in the Edit menu or the component’s context
menu. To comment or uncomment a component programmatically, use the com-
mand

plecs('set', 'componentPath', 'CommentStatus', 'status')

where status is one of CommentedOut, CommentedThrough or Active.

Getting Component Help

Press the Help button in the dialog box to view the documentation for the com-
ponent.
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Libraries

Libraries enable you to ensure that the custom components or masked subsys-
tems used in your circuit are always up-to-date. Or, the other way round, if you
are developing your own custom components, you can use a library to ensure
that changes you make to your component models are automatically propagated
to a user’s circuit upon loading.

Creating a New Library in PLECS Standalone

Any model file in PLECS Standalone can be used as a library file. Additionally
it is also possible to use PLECS Blockset libraries in PLECS Standalone. To
make model file available as a library the file has to be added to the library list
in the PLECS preferences (see chapter “Configuring PLECS” on page 124 for
details).

To create a new library file, create a new model file, copy the desired compo-
nents into it and save it in a directory on the library path. The library path is
also set in the PLECS preferences.

Creating a New Library in PLECS Blockset

To create a new component library, open the PLECS Extras library and copy
the PLECS Library block into a Simulink model or library. The Simulink model
must be named (i.e. saved) before you can copy components from the component
library.

To add the new library to the library browser it has to be added to the list of
user libraries in the PLECS Preferences (see chapter “Configuring PLECS” on
page 124 for details).

Creating a Library Reference

When you copy a library component — either into a circuit schematic or into an-
other or even the same component library — PLECS automatically creates a ref-
erence component rather than a full copy. You can modify the parameters of the
reference component but you cannot mask it or, if it is already masked, edit the
mask. You can recognize a library reference by the string "(link)" displayed next
to the mask type in the dialog box or by the string "Link" displayed in the title
bar of the underlying schematic windows.
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The reference component links to the library component by its full path, i.e.
the Simulink path of the PLECS Library block and the path of the component
within the component library as they are in effect at the time the copy is made.
If PLECS is unable to resolve a library reference, it highlights the reference
component and issues an error message.

You can fix an unresolved library reference in two ways

* Delete the reference component and make a new copy of the library compo-
nent.

¢ In PLECS Blockset, add the directory that contains the required Simulink
model to the MATLAB path and reload the circuit.

Updating a Library Reference

Library references are resolved upon loading of a circuit. Afterwards, any
changes that you make to a referenced library component are automatically
propagated to the referencing components when you start a simulation or (in
PLECS Blockset) when you update the simulation model.

Breaking a Library Reference

You can break the link between a library reference and the library component.
The reference then becomes a simple copy of the library component; changes to
the library component no longer affect the copy.

In order to break the link between a reference and its library component, select
the reference component, then choose Break library link from the Subsys-
tem submenu of the Edit menu or the component’s context menu.

It is often desirable to break the links to all user-defined libraries in a model,
for example when sending a model to another PLECS user who does not have
all the libraries that the model depends on. This can be done by selecting
Break all library links... from the Edit menu. Library links to the PLECS
component library are not affected by this functionality.
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Connections

Connections define the relationship and interaction between components.

Signal Connections and Physical Connections

Signals are drawn with green lines ending with an arrow head. They represent
a directed flow of values from the signal output of one component to the signal
input of one or several other components. Values can be either scalars or vec-
tors. The width of a signal is determined when the simulation is started.

Physical connections represent energy flow between two points and do not have
an inherent direction. They are drawn in separate colors for the different phys-
ical domains: black for electrical, red for magnetic, blue for thermal and violet
for mechanical. Physical connections can be created between physical terminals
of the same domain.

Creating Connections

To create a new connection, move the mouse pointer over an unconnected ter-
minal, press the mouse button, and drag the mouse pointer to the desired des-
tination. If you drag the mouse pointer near a matching terminal, the pointer
shape changes to a double cross, and the two terminals will be connected when
you release the mouse button. If you drag the mouse pointer over a component,
the connection will be routed to the nearest matching terminal (if any) of that
component.

Creating Branches

Branches are used to connect more than two terminals. To create a branch con-
nection, place the mouse pointer on an existing connection or node where you
want the branch to start. Press the right mouse button and drag the mouse
pointer to the desired destination. Instead of the right mouse button you can
also use the left mouse button while holding down the Ctrl key.

Alternatively, you can also create a branch by clicking on an unconnected termi-
nal and dragging the mouse pointer to a matching connection or node.
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Avutomatic Creation of Connections

If you select a component and hold the Alt key while hovering the mouse
pointer over another component, the schematic editor suggests connections be-
tween matching terminals or terminal groups of the two components. A termi-
nal group in this context is a contiguous set of terminals of the same kind along
one edge of a component. To create the connection(s), press the mouse button.
Only one pair of matching terminals or terminal groups is connected at one
time. If there are multiple candidates, the connection with the shortest path

is chosen.

This is illustrated in the figures below. First, the starting component, a voltage
source, is selected. Next, the mouse pointer is moved to the destination compo-
nent, a resistor, while holding down the Alt key. The editor suggests a connec-
tion between the closest two electrical terminals. Last, after a mouse click, the
connection is created, and the editor suggests another connection between the
remaining two terminals.

:
@n:
"]

You can also let the schematic editor create connections from multiple start-
ing components to a single destination component at once. This is useful e.g. to
combine the signal outputs of multiple meters into one Signal Multiplexer (see
page 673). First, select the many components, then move the mouse pointer to
the destination while holding down the Alt key. Press the mouse button to cre-
ate all connections at once.

v )
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Editing Connections

After a connection has been created, you can change its path by moving indi-
vidual segments. To move a connection segment, click it with the left mouse
button, then drag it to the desired destination.

You can also move parallel segments of different connections simultaneously. To
do so, select the connections, then click on any one of the parallel segments and
drag it to the desired destination. The other segments will be shifted simulta-
neously while maintaining their relative distances.

Vectorization

Some models are based on a repetitive structure. Such structures can be im-
plemented in a compact form with the concept of “Vectorization”. For this pur-
pose there is a De-/Multiplexer and Signal Selector component in the controls
domain and a Wire Multiplexer and Wire Selector block in each each physical
domain. These blocks allow to realize series and parallel connections of many
components without actually having to place all components in the schematic.
Besides this, source components can also output vector or bus signals. This way
the circuit structure becomes parameter dependent.

Vectorized Sources

Source components can be vectorized by specifying a vector for one of the pa-
rameters. If a vector is specified for multiple parameters they all need to have
the same length. For example the Phase parameter in the Sine Wave block al-
lows a vector [0, —120, 120].

&Y

Sine Wave
Frequency: 10
Phase: [0, -120, 120]

In case of a physical domain the vectorized source components will lead to com-
pletely vectorized circuits.

V:[123] = V:1 V:2 V:3
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Signal De-/Multiplexer

In a basic application a signal multiplexer and demultiplexer are used to form
and split bus signals. In the following example the sine wave block outputs a
bus signal of width 3.

Width: [2 1]
MV
Sine Wave Scope
Phase: [0, -120, 120] 0.5

The Demultiplexer component is used to split the bus signal into a bus signal of
width 2 and a scalar signal. The upper Gain multiplies each component of the
bus signal with 3 and the lower Gain block simply multiplies the scalar signal
with 0.5.

Vectorizing Physical Components

The following example shows how a chain of RC elements can be built using
wire multiplexers.

R1 R2 R3
R:1 R: 2 R:3
— — —

11+

| S | S | S
cilr 2 lr  c3 S
Cile-4 T~ C:2es4 T C:3e-d ]

Non-vectorized RC chain

In a first step the original circuit is built with two wire multiplexer components
of width 4. The first wire that enters the multiplexer leaves the second mul-
tiplexer on the first terminal (indicated with a dot). The same applies for the
input signals 2 to 4.

Because multiplexers can take vectors as Width parameter, the wires 2 to 4 can
be combined. In the third example the two multiplexers use the value [1 3] and
[3 1] for the Width parameter.

The vectorized implementation is a condensed form of the original circuit with
only one resistor and capacitor component. By using a variable for the Width
parameter ([1 n] and [n 1)), the length of the RC chain can be set from the model
initialization commands. The values for the capacitances and resistances have
to be a scalar or a vector with length of the RC chain.

62



Annofations

R1

RC chain built with a wire multiplexer

Width: [13]  Width: [3 1]

@ B R§[1:2’3']— <v+>

C:[12 3]*le-4

Vectorized version of the RC chain

Note The input signal to a vectorized switching device of width n can be a
scalar or a vector. If it is a scalar all n switching devices will have the same
(gate) input signal. If the input signal is a vector of length n every element of
the vector is the (gate) input signal to the corresponding switching device.

Annotations

You can annotate schematics with text labels and graphical elements, i.e. boxes,
lines and arrows. Annotations are purely for documentation purposes and have
no influence on the model behavior.

Text Annotations
To create a text annotation, double-click in an unoccupied area of a schematic

and start typing. To finish editing, press the Escape key or click anywhere out-
side the annotation box. You can move a text annotation by selecting and drag-
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ging it with the mouse. To edit an existing annotation, double-click it. While
you are editing an annotation, a toolbar is shown next to it allowing you to
change the style, size, color and alignment of the text.

Box Annotations

To create a box annotation, double-click in an unoccupied area of a schematic
and drag the mouse while holding the mouse button. To move a box annotation,
click on its border and drag it to the desired location. To change the size of a
box annotation, select it by clicking on its border, then drag one of its selection
handles. To change the appearance of a box annotation, double-click on its bor-
der. A toolbar will be shown next to the box allowing you to change the border
width, corner radius, border color and fill color of the box.

Line Annotations

To create a line annotation, press and hold the Shift key while double-clicking
in an unoccupied area of the schematic and dragging the mouse. To move a line
annotation, click on the line and drag it to the desired location. To change the
orientation of a line annotation, select it by clicking on the line, then drag one
of its selection handles. To change the appearance of a line annotation, double-
click on the line. A toolbar will be shown next to the line allowing you to change
the width, style and color of the line and the size and location of arrow heads.
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Subsystems

Subsystems allow you to simplify a schematic by establishing a hierarchy,
where a Subsystem block is on one layer and the elements that make up the
subsystem are on another. Subsystems also enable you to create your own
reusable components. For more information see “Masking Subsystems” (on page
68).

You can create a subsystem in two ways:

¢ Add a Subsystem block to your schematic, then open that block and add the
blocks it contains to the subsystem.

¢ Select a number of blocks, then group those blocks into a subsystem.

Creating a Subsystem by Adding the Subsystem Block

To create a new subsystem, first add a Subsystem block to the schematic, then
add the elements that make up the subsystem:

1 Copy the Subsystem block from the System library into your schematic.
2 Double-click on the Subsystem block in order to open it.

3 In the empty Subsystem window, build the subsystem. Use the different port
blocks (e.g. Signal Inport (see page 671), Signal Outport (see page 674) or
Electrical Port (see page 445)) to configure the interface of the subsystem.

Creating a Subsystem by Grouping Existing Blocks

If a schematic already contains the blocks you want to convert to a subsystem,
you can create the subsystem by grouping those blocks:

1 Select the blocks and connections that you want to include in the subsystem
within a bounding box.

2 Choose Create subsystem from the Edit menu. PLECS replaces the se-
lected blocks with a Subsystem block.
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Arranging Subsystem Terminals

When you add a port to a subsystem schematic, a corresponding terminal ap-
pears at a free slot on the border of the Subsystem block. If necessary, the Sub-
system block is resized automatically in order to accommodate the new termi-
nal.

You can move a terminal to another free slot on the border by dragging it with
the middle mouse button. While you hold down the mouse button, a circle
shows the free slot nearest to the mouse pointer. As an alternative you can
press the left mouse button while holding down the Shift key. When you re-
lease the mouse button, the terminal is moved.

The figures below show a Subsystem block before, during and after moving a
terminal.

=q
_r|;_Dort of{Port é":ki

Subsystem Subsystem Subsystem

Notice how the shape of the cursor changes to crosshairs as you move it into
the capture radius of the terminal. When you press and hold down the center
mouse button, the cursor shape changes to a pointing hand.

Resizing a Subsystem Block

To change the size of a Subsystem block, select it, then drag one of its selection
handles. While you hold down the mouse button, a dashed rectangle shows the
new size. When you release the mouse button, the block is resized. The mini-
mum size of a Subsystem block is limited by the number of terminals on each
side.

The figures below show a Subsystem block before, during and after resizing.

Port
Port APort C
Port [3

Subsystem
Subsysterii Subsystem

Notice how the terminals on the right edge of the Subsystem block are shifted
after you release the mouse button in order to fit into the new frame. The block



Subsystems

height cannot be reduced further because the terminals cannot be shifted any
closer.
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Masking Subsystems

Masking a subsystem allows you to create a custom user interface for a Subsys-
tem block that hides the underlying schematic, making it appear as an atomic
component with its own icon and dialog box. Many of the components in the

PLECS component library are in fact masked subsystems.

To mask a subsystem, select the Subsystem block, then choose Create mask...
from the Subsystem submenu of the Edit menu or the block’s context menu.
The mask editor appears. The mask editor consists of five tabbed panes that

are described in detail below.

Mask Icon

The Icon pane enables you to create icons that show descriptive text or labels,

graphics and images.

» Mask Editor: Machines/Slip-Ring IM

Icon | Dialog | Initialization I Probes | Documentation |

Drawing commands:

Language:

Icon:circle(0, 0, 1
Icon:circle(0Q, 0, 2

8)

S)

Icon:
Icon:
Icon:
Icon:
Icon:

line({-25,
line({-25,
line ({15,
line ({18,
line ({15,

-23}, {10, 10})

-23}, {-10, -10})

25%, {10, 10})
25}, {0, 0})
253, {-10, -10})

Icon:line({-18, -25

{is, 25,
Icon:circle(-26.5,
Icon:circle(26.5, -

O W oo =) s R

e

[~ show subsystem frame
I™" Hide terminal labels

[# Icon rotates

, -25, 25, 25,

35, 35, 25,
-13.5, .5)
13.5, .5)

-
o)

18}

[ o ]

Unmask:

Cancel

Apply

Help

Mask Editor Icon Tab
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Mask Icon Drawing Language

The Language selector lets you choose the programming language used for
the drawing commands. Choose Lua to create dynamic icons that can change
depending on user input. See “Getting Started with Lua” (on page 84) for a
brief introduction to this language. Choose Legacy to select the syntax used
by PLECS 4.1 and older.

Mask Icon Drawing Commands

The drawing commands available in the Lua language are described below. If
you enter more than one command, the graphic objects are drawn in the order
in which the commands appear. In case an error occurs during evaluation of
the commands, PLECS displays three question marks (? ? ?) in the mask icon;
if you hover the mouse over the subsystem block, a tooltip will show the error
message.

Text

The commands

Icon:text('text')
Icon:text(x, y, 'text')

display text in the center of the icon or centered around the coordinates x, y.
The text does not rotate with the icon; it is always displayed from left to right.

The second command can be followed by parameter/value pairs to specify addi-
tional properties listed in the table below.

Line

The command
Icon:1line(xvec, yvec)

draws the line specified by the vectors xvec and yvec. Both vectors must

have the same length. Note that vectors are entered using curly braces, e.g.

{1, 2, 8}. The vectors may contain non-finite values such as 0/0 or 1/0. When
non-finite values are encountered, the line is interrupted and continued at the
next point that has finite values.
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Text Properties

Property Description

FontSize An integer specifying the font size of the text.

TextFormat | Specify the string PlainText to display the text as is (the
default) or RichText to enable HTML markup such as
<b></b> or <sup></sup>.

Color — A string specifying the color name (preferred). All
appearance-sensitive “PLECS Colors” (on page 75) are
allowed.

— A vector {r, g, b} of three integers in the range from 0
to 255 specifying the color in RBG format. This color applies
in light mode and is automatically transformed in dark
mode (similar hue, inverted lightness).

— A table {light = {r, g, b}, dark = {r’, g’, b’}}
assigning custom colors in RGB format to each appearance.

Note: The table’s dark mode color defaults to the 1ight
mode color, such that {1ight = {r, g, b}} resultsina
fixed color for all appearances.

Paich

The command
Icon:patch(xvec, yvec)

draws a solid polygon with vertices specified by the vectors xvec and yvec. Both
vectors must have the same length. Note that vectors are entered using curly
braces, e.g. {1, 2, 3}.

Circle

The command
Icon:circle(x, y, r)

draws a circle with the center coordinates x, y and the radius r.
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Ellipse

The command
Icon:ellipse(x, y, rx, ry)

draws an ellipse with the center coordinates x, y and the radii rx and ry.

Arc

The command
Icon:arc(x, y, rx, ry, start, span)

draws an elliptical arc with the center coordinates x, y and the radii rx and ry
beginning at the start angle (in degrees) and extending span degrees counter-
clockwise. The 0 degree angle is at 3 o’clock. Clockwise arcs can be drawn using
a negative span angle.

Color

The commands
Icon:color('
Icon:color
Icon:color
Icon:color

colorname ')

r, & b)

{r, g, b})

{light = {r, g, b}, dark = {r’, g’, b'}})

PR

change the current drawing color. The new color can be defined by:

* A string colorname specifying the color name (preferred). All appearance-
sensitive “PLECS Colors” (on page 75) are allowed.

¢ Three integers r, g and b or a vector {r, g, b} of three integers in the range
from 0 to 255 specifying the color in RBG format. This color applies in 1ight
mode and is automatically transformed in dark mode (similar hue, inverted
lightness).

e A table {light = {r, g, b}, dark = {r’, g’, b’}} assigning custom colors
in RGB format to each appearance.
Note: The table’s dark mode color defaults to the 1ight mode color, such that
{light = {r, g, b}} results in a fixed color for all appearances.
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Image

The commands

Icon:image (xvec, yvec, 'filename')
Icon:image (xvec, yvec, 'filename', 'on')

read an image from the file filename and display it on the mask icon.

The parameter filename must be either an absolute filename (e.g.
C:\images\myimage.png) or a relative filename that is appended to the model’s
directory (e.g. images\myimage.png). Supported image formats are BMP, GIF,
JPG and PNG.

The two-element vectors xvec and yvec specify the minimum and maximum
coordinates of the image’s extent. Note that vectors are entered using curly
braces, e.g. {-10, 10}.

Use the optional flag 'on' to indicate that the image should rotate or flip to-
gether with the mask icon. By default, this is set to 'off', and the image orien-
tation remains fixed.

Only one image can be displayed on a mask icon; if you use multiple image com-
mands, only the last one will be effective.

Querying Parameter Values

The command
Dialog:get('variable')

returns the string value of the mask parameter associated with the variable
variable. Note that the parameter values are not evaluated. Thus, if the user
enters e.g. 2*2, the return value will be '2*2' and not '4'. The return value for
a Combo Box parameter is a string containing the integer value of the chosen
option or the expression entered by the user.

Querying Preferences

The command

Preferences:get('Appearance')
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returns the current app appearance as a string, either "light" or "dark". This
can be used for appearance-sensitive drawing commands beyond the normal
color transformation.

The command
Preferences:get('DrawANSI')

returns true if the Symbol format setting is set to ANSI instead of DIN. This
can be used for drawing commands which differ between these formatting con-
ventions.

Legacy Command Syntax

The legacy command syntax is listed in the following table. The meaning of the
command arguments is analogous to the Lua syntax. Vector parameters are
entered using square brackets with optional commas for separating the ele-
ments, e.g. [1, 2, 3] or [3 4 5]. Note that the legacy syntax does not support
all commands and options. Single-line comments start with a percent sign (%).

Legacy Command Syntax

Command | Syntax

Text text(’text’)
text(x, y, ’text’)
Line line(xvec, yvec)
Patch patch(xvec, yvec)
Circle circle(x, y, r)
Color color(r, g, b)
Image image (xvec, yvec, imread(’filename’))

image (xvec, yvec, imread(’filename’), ’on’)

Mask Icon Coordinates

All coordinates used by the mask drawing commands are expressed in pixels.
The origin of the coordinate system is always the center of the block icon; it is
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adjusted when the block is resized. In an unrotated and unflipped block, the x-
axis stretches from the left towards the right, and the y-axis stretches from the
top towards the bottom.

Use the icon frame and/or the terminal locations as reference points in order to
position graphic elements. Both the frame and the terminals snap to a grid of
10 by 10 pixels.

Note PLECS expects you to confine icon drawings to the boundaries of the
subsystem frame. PLECS will not clip your drawings to the subsystem frame,
but if you draw outside the frame, the drawings will not be erased properly e.g.
when the subsystem is moved.

Mask Icon Properties

Show subsystem frame
The subsystem frame is the rectangle that encloses the block. It is drawn if
this property is set, otherwise it is hidden.

Hide terminal labels
This property controls whether the terminal labels underneath the icon are
shown or hidden. A terminal label is only shown if this property is unset
and the name of the corresponding port block is visible.

Icon rotates
If drawing commands are provided, this property determines whether the
drawn icon rotates when the component is rotated. The drawn icon remains
stationary if this property is unchecked.
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PLECS Colors

The PLECS palette contains all available appearance-sensitive colors which all
PLECS components use for drawing their block/mask icon.

PLECS Palette

Color name Description

"text" default text color

"electrical" electrical domain color

"signal" signal connection color

"axis" axis color for icons

"thermal" thermal domain color
"thermalBg" thermal domain background
“magnetic" magnetic domain color
"magneticBg" magnetic domain background
"rotational" rotational domain color
"rotationalBg" rotational domain background
"translational" translational domain color
“translationalBg" | translational domain background
"event" event connection color
“normalFg" normal foreground

“normalBg" schematic background (configurable in dark mode)
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Mask Dialog

The Dialog pane enables you to define the parameters that will appear in the
dialog box of the masked subsystem.

M Mask Editor: Machines/Slip-Ring IM ﬂ

Icon Dialog | Initialization I Probes | Documentation |

Dizlog parameters:

ll Prompt Variable Tunable

- | B

tator leakage inductance Lis Edit C
il Rotor resistance Rr' Rr Edit r
Rotor leakage inductance L' Lir Edit C
il Magnetizing inductance Lm Lm Edit C
Turns ratio Ns/Nr ue Edit C
Inertia J J Edit r
Friction coefficient F F Edit r
Number of pole pairs p p Edit C
Initial rotor speed wmi wmi Edit E

Dialog callback: Combo box values:

1

oK I Unmask Cancel Apply Help

Mask Editor Dialog Tab

Prompts and Associated Variables

Mask parameters are defined by a Prompt, a Variable and a Type. The
prompt provides information that helps the user identify the purpose of a pa-
rameter. The variable name specifies the variable that will be assigned the pa-
rameter value. The possible parameter types are described in the table below.

Mask parameters appear on the dialog box in the order they appear in the
prompt list. You can add or remove parameters or change their order by using
the four buttons to the left of the prompt list.
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Parameter Types

Type Description

Edit Shows a line edit field. The entered text is interpreted as
a MATLAB/Octave expression and is evaluated when a
simulation is started.

String Shows a line edit field and a selector that controls whether
the entered text is interpreted as a literal string or as a
MATLAB/Octave expression that evaluates to a string.

Combo Box | Shows a pop-up menu that allows the user to select an item
from a list of possible options. Use the Combo box values
editor below the parameter list to enter the list of possible
options and their associated values that are assigned to the
parameter variable. The values must be unique integers.

Thermal Shows a thermal parameter editor that allows the user to
specify a thermal description (see section “Thermal Descrip-
tion Parameter” on page 139 for details). If you enter a text
in the Device type filter editor below the parameter list,
the thermal parameter editor will show only thermal de-
scriptions that have the matching device type. Otherwise,
all thermal descriptions will be shown.

Note In PLECS Standalone, the maximum length of variable names is 63
characters. This is due to the way in which a mask workspace is stored in
PLECS and exchanged with Octave. It is advisable to observe this limit also

in PLECS Blockset to ensure that a model can be exchanged with PLECS Stan-
dalone.

Tab Names
You can group parameters into separate tabs shown in the parameter dialog by

assigning a tab name in the Tab column. All parameters that have the same
tab name will appear on the same tab page in the parameter dialog.
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Tunable Parameters

By default, mask parameter values cannot be modified during a simulation.
However, if you check the box in the Tunable column, the corresponding pa-
rameter will be made tunable so that you can in fact modify it interactively dur-
ing a simulation by entering a new value in the parameter dialog. Whenever
you change the parameter, PLECS will re-evaluate the parameter variable and
the mask initialization commands and propagate the new variable values to
the underlying components, which in turn must have tunable parameters. If

a changed variable is used in a non-tunable component parameter, the change
will have no effect until the simulation is restarted.

Dialog Callback

The dialog callback is a Lua function that is executed whenever the user
changes a mask parameter. You can use it to disable or hide a parameter or
change its value depending on the value of another parameter.

Querying Parameter Values

The command
Dialog:get('variable')

returns the string value of the mask parameter associated with the variable
variable. Note that the parameter values are not evaluated. Thus, if the user
enters e.g. 2*2, the return value will be '2*2' and not '4'. The return value for
a Combo Box parameter is a string containing the integer value of the chosen
option or the expression entered by the user.

Setting Parameter Properties
The command
Dialog:set( 'variable', 'property', value, ...)

changes one or more properties of the mask parameter associated with the vari-
able variable. The properties are listed in the following table.
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Parameter Properties

Property | Description

value A string specifying the parameter value

Enable A Boolean (i.e. true or false) specifying the enable state of the
parameter. A disabled parameter is greyed out in the dialog
and cannot be modified.

Visible | A Boolean (i.e. true or false) specifying the visibility of the
parameter in the dialog

Note Parameters that are disabled or invisible are not evaluated, and the pa-
rameter variables are assigned a NaN value (not a number).

Hiding, Showing and Moving Terminals

The command
Block:showTerminal('name', flag)

shows or hides the terminal named name depending on the boolean value flag.
The companion port of a hidden terminal acts in the same way as if the termi-
nal was shown but unconnected.

The command
Block:moveTerminal('name', x, y)

moves the terminal named name to the relative coordinates x, y with respect
to the unrotated and unflipped block. Note that the terminal rotation is not
changed.

79



3 Using PLECS

80

Mask Workspace

Variable Scope

PLECS associates a local variable workspace with each masked subsystem
that has one or more mask parameters defined. Components in the underlying
schematics can access only variables that are defined in this mask workspace.

Initialization Commands

¥ Mask Editor: Machines/slip-Ring IM ﬂ
Icon | Dialog Initialization I Probes | Documentation
Dialog variables: Initialization commands:
g 1isd0 = is0(1);
Ur 2 isg0 = 1l/=sgrec(3)*(is0(1l)+2*1s0(2));
Lls 3 imd0 = (psisdgl(l)-Ll=*i=d0)/Lm:
Lm 4 imgl = (psisdgl(2)-Lls*i=sgl),/Lm;
Rr
&

Rs

is0

P
psisdg0
thmo
ue
wmi

OK I Unmask | Cancel Apply Help

Mask Editor Initialization Tab

Mask initialization commands are defined on the Initialization pane. They are
evaluated in the mask workspace when a simulation is started. You can enter
any valid MATLAB/Octave expression, consisting of MATLAB/Octave functions,
operators, and variables defined in the mask workspace. Variables defined in
the base workspace cannot be accessed. The dialog parameter variables are
listed on the left hand side of the tab.
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You can use mask initialization commands to check the user input, e.g. whether
a variable value is within a certain range, or to define additional workspace
variables that may be derived from mask parameters.

To show an error message in the Diagnostics window, e.g. that a certain mask
parameter value is not valid, use the command

error( 'error message')
To show a warning message in the Diagnostics window, use the command
b
plecs('warning', 'warning message')

Note that the native MATLAB/Octave command warning will only print the
warning message to the MATLAB command window or the Octave console.

Note In PLECS Standalone, the maximum length of variable names is 63
characters. This is due to the way in which a mask workspace is stored in
PLECS and exchanged with Octave. It is advisable to observe this limit also

in PLECS Blockset to ensure that a model can be exchanged with PLECS Stan-
dalone.

Mask Probe Signals

The Probes pane enables you to define the probe signals that the masked sub-
system will provide to the PLECS Probe. Mask probe signals appear in the
probe editor in the order they appear in the mask signal list. You can add or
remove signals or change their order by using the four buttons to the left of the
signal list.

Mask probe signals are defined as vectors of probe signals from components be-
low the subsystem mask. For this reason the controls in the lower half of the di-
alog are identical to those of the probe editor. In order to define a mask signal,
select the signal in the list and then drag the desired components into the dia-
log window. The new components are added to the bottom of the list of probed
components. Next, select the components one by one and enable the desired
component signals in the list on the right side by using the check boxes.
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M Mask Editor: Machines/Slip-Ring IM

Icon I Dialog I Initizlization Probes | Documentation I

1' Mask signals
iSta ase currents
Rotor phase currents
1' Stator flux (dg)
Magnetizing flux (dg)
il Rotor flux (dg)
Rotational speed
Rotor position
Electrical torque

—Probed components —Component signals
[ Measured current
;I Type INamel Path |
il Ammeter isa Slip-Ring IM
Ammeter isb Slip-Ring IM
il Ammeter isc Slip-Ring IM
[=1

oK I Unmask Cancel Apply

Help

Mask Editor Probes Tab

Mask Documentation

The Documentation pane enables you to define the descriptive text that is

displayed in the dialog box of the masked subsystem.

Mask Type

The mask type is a string used only for purposes of documentation. PLECS dis-
plays this string in the dialog box and appends "(mask)" in order to differentiate

masked subsystems from built-in components.

Mask Description

The mask description is informative text that is displayed in the dialog box in
the frame under the mask type. Long lines of text are automatically wrapped to
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M Mask Editor: Machines/Slip-Ring IM ﬂ

Icon I Dialog I Initialization I Probes Documentation |

Mask type: |Induch’on Machine (Slip Ring)|

Mask description:

Three-phase induction machine with accessible rotor windings. All parameters and electrical quantities
are referred to the stator side.

oK I Unmask | Cancel Apply Help

Mask Editor Documentation Tab

fit into the dialog box. You can force line breaks by using the Enter or Return
key.

Mask Help

The mask help is a URL that provides documentation in addition to that pro-
vided by the mask description. This documentation is shown in a separate win-
dow when the user clicks the Help button in the dialog box of the masked sub-
system. Currently, the following URL types are supported:

Remote URL A URL of the form https://www.plexim.com is opened using
the default browser of your operating system.

Local HTML File A local HTML file is specified with an absolute path (e.g.
file:///C:/absolute/path/helpdoc.html) or with a relative path (e.g.
file:relative/helpdoc.html). A relative path is resolved relative to the par-
ent folder of the model file containing the subsytem. If the subsystem is a li-
brary link or model reference, the relative path is resolved relative to the par-
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ent folder of the source library or model file. Local HTML files are also opened
using the default browser of your operating system.

Unprotecting Masked Subsystems

If you define a mask icon for a Subsystem block, PLECS automatically protects
the block and the underlying schematic. You can no longer resize the Subsys-
tem block or modify the sub-schematic. The purpose of this protection is to pre-
vent the user from making unintentional changes that might render the icon
useless.

If you want to change a masked Subsystem block, you can unprotect it by choos-
ing Unprotect from the Subsystem submenu of the Edit menu or the block’s
context menu. You can later protect it again by choosing Protect from the
same menus.

Getting Started with Lua

Lua is a simple yet powerful open-source scripting language. This section in-
troduces you to the basic concepts that you are likely to need in order to cre-
ate dynamic subsystem masks. For a full reference please visit the Lua site at
http://www.lua.org.

Types and Variables

Lua is a dynamically typed language, which means that types are not associ-
ated with variables but only with values. To define a variable, you simply as-
sign a value to it.

By default, Lua declares all variables as global. However, PLECS executes Lua
code in a protected environment that forbids the creation or modification of
global variables. Therefore, you must explicitly declare variables as local using
the local keyword, e.g.

local a = "a string"

The most basic types in Lua are: nil, boolean, number, string and table. You
can query the type of a value with the function type which returns the type
name as a string.

Nil Nil is a type with the single value nil. It is used to represent the absence
of a useful value.
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Booleans The Boolean type has two values false and true. It can be used in
conditional expressions. If you use other types in conditional expressions, be-
ware that Lua considers only the Boolean false and nil as false and anything
else as true. In particular, both the numerical 0 and the empty string ” or ""
are considered true in conditional tests.

Lua supports the logical operators and, or and not.

Numbers Lua differentiates between (double-precision) floating point num-
bers and (64-bit) integer numbers. Numerals with a decimal point or an expo-
nent are considered floats; otherwise, they are treated as integers.

Strings String literals in Lua can be delimited by single or double matching

quotes:
local a = "a string"
local b = 'another string'

The difference between the two kinds is that inside one kind of quotes you can
use the other kind of quote without needing to escape it. The escape character
is the backslash (\), and the common C escape sequences such as \n for newline
are supported.

Long strings literals are delimited with matching double square brackets that
enclose zero or more equal signs, e.g. [[...]] or [==[...]==]. They can span sev-
eral lines and do not interpret escape sequences.

Tables Tables are Lua’s generic data structuring mechanism. They are used

to represent e.g. arrays, sets or records. A table is essentially an associative ar-
ray that accepts as keys not only numbers or strings but any other value except
nil. A table is constructed with curly braces and a sequence of key/value pairs,

e.g.

a={x=10, y =20}
A numerical vector as used in the mask icon drawing commands is just a ta-
ble with 1-based consecutive integer keys and numeric values. It can be con-

structed using the shorthand form of omitting the keys and just specifying the
values:

a={1,2,3}

Alternatively, a numerical vector can be constructed using the following PLECS
specific syntax extension:
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a = Vector{ 1, 2, 3 }

A vector constructed in this way can be added to or multiplied with a scalar
value. This is especially helpful in icon drawing functions if the graphic object
shall be displaced or scaled:

ctor{ 1,
ctor{ 4,

*zoom_factor + x_offset

a_x = Ve 2, 3}
ay = Ve 5, 6 }*zoom_factor + y offset
Comments

A simple comment starts anywhere with two consecutive hyphens (- -) and runs
until the end of the line. Long comments start with two hyphens followed by
two square brackets (- - [ [) and continue until the first occurrence of two closing
square brackets (1]).

A common trick is to use --]] to end a long comment to quickly comment and
uncomment a block of code:

--[1
Icon:1line({-10, 10}, {-10, 10}) -- commented out

--11

To un-comment the code block, prepend another hyphen to the first line:

- L1
Icon:1line({-10, 10}, {-10, 10}) -- will be executed

--11

In the first example, the - - [[ starts a long comment that continues until (and
including) the 1] in the third line. In the second example, the first two hyphens
start an ordinary single-line comment, and so the second line is not commented
out. The two hyphens at the beginning of the third line again start a single-line
comment. Without these hyphens, the unpaired closing square brackets in the
third line would cause a syntax error.

Statements

Lua does not need an explicit separator between consecutive statements, but
you can use a semicolon if you wish. Also, line breaks are treated like ordinary
white space, so you can split a single statement into multiple lines without hav-
ing to use a special continuation mark.
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Relational Operators

Lua supports the following relational operators:

< > <= >= == ~=

Relational operators always return a Boolean value. The == operator tests for
equality and the ~= operator for inequality. They can be applied to any two val-
ues. If the values have different types, Lua considers them not equal. Other-
wise, they are compared according to their type.

Functions
A function is defined as follows

local function drawTriangle(x, V)
Icon:line(Vector{0O, 8.66, -8.66, 0}+x,
Vector{-10, 5, 5, -10}+y)
end

As with variables, the local keyword is required because without it the func-
tion would be declared globally, which PLECS forbids. A function definition
consists of the keyword function, a name (drawTriangle), a list of parameters
(x, vy), abody,i.e. alist of statements, and the terminator end. Parameters are
local variables that are initialized with the values of the arguments passed in
the function call.

The example above defines a function that draws a triangle with the center
point xz, y. The function can be called as follows

drawTriangle(-10, 0)
drawTriangle (10, 0)

A function can also return values using the return statement:

local function sum(values)
local result =0
for i = 1, #values do
result = result + values[i]

end
return result
end
local x = sum({1, 2, 3}) -- x will be 6
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Control Structures

Lua provides control structures for conditional execution and iteration.

if then else The if statement tests its condition and executes the then
branch if the condition is true and otherwise the else part. The condition can
result in any value, but as mentioned earlier, Lua treats all values other than
nil and false as true. In particular, both the numerical 0 and the empty string
('"') are treated as true.

if Dialog:get('choice') == '1' then
Icon:text('+")

else
Icon:text('-")

end

Multiple conditions can be tested with the elseif statement. It is similar to an
else followed by an if but avoids the need for and extra end:

if Dialog:get('choice') == '1' then
Icon:text('+")

elseif Dialog:get('choice') == '2' then
Icon:text('-")

else
Icon:text('+/-")

end

for The for statement has the following form:

for x = -10, 10, 5 do
Icon:line({x, x}, {-10, 10})
end

The loop variable, x, which is implicitly local to the loop, is successively as-
signed the values from -10 to 10 with an increment of 5, and for each value the
loop body is executed. The result of the example will be five parallel vertical
lines. The step value is optional; if it is omitted, Lua will assume a step value of
1.

Lua also provides other control structures (iterator-based for, while, repeat).
However, these are not relevant for dynamic masks.
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Circuit Browser

The Circuit Browser enables you to navigate a circuit diagram hierarchically.
To display the Circuit Browser, select Show circuit browser from the View
menu of the schematic editor. Note that this option is only available from the
main schematic window, i.e. the Circuit Browser will only be shown once for
every model.
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The editor window splits into two panes. The left pane shows the Circuit
Browser, the right pane displays the current schematic. The Circuit Browser
shows either a hierarchical or a flat list of all components and subsystems in
the circuit.

Selecting a component in the Circuit Browser will also select the same com-
ponent in the schematic and vice versa. By dragging the mouse or by holding
down the shift key you can select multiple components. If the selected compo-
nents are compatible with each other, their parameters can be edited simulta-
neously. The parameter dialog is displayed on double clicking the selected com-
ponents or on clicking the option Component parameters... from the context
menu.

The schematic is automatically updated to show the last selected component.
The schematic of a specific subsystem can be displayed by double clicking it in
the Circuit Browser.

The components can be sorted by clicking on one of the column headers. To
quickly find e.g. all diodes in a circuit, switch to the flat view (see below) and
sort it by clicking on Type. This will group all diodes together in the list.
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Viewing Options

In the toolbar of the Circuit Browser, several viewing options are available.

View As Tree i:

The first two buttons in the toolbar switch between hierarchical and flat view.
In the hierarchical (or tree) view, the first entry corresponds to the top-level
schematic of your circuit. A “+” or “~” sign next to a name indicates that the cor-
responding schematic contains one or more subsystems. By double-clicking on
the entry you can expand or collapse the list of these subsystems. This will also

show the schematic of the subsystem.

View As Flat List i=

The flat view lists all components of the entire circuit except the top-level cir-
cuit itself. This view has an additional column that shows the path of each com-
ponent.

Look Under Masks *

By default, the Circuit Browser treats a masked subsystem like a component,
i.e. it will not list the contents of the subschematic. You can change this behav-
ior by toggling this button.

Follow Library Links =

By default, the Circuit Browser treats a library link like a component, i.e. it will
not list the contents of the subschematic. You can change this behavior by tog-
gling this button.

Filter 1

The Filter button lets you choose, which components are shown in the Circuit
Browser. When filtering is turned off, all components are shown. By clicking on
the small arrow symbol, you can select between two filtering modes:



Circuit Browser

Show only subsystems When this mode is active, the Circuit Browser
shows only subsystems.

Show assertions When this mode is active, the Circuit Browser shows only
assertion blocks and components with attached assertions (see “Assertions” on
page 94). To view the associated assertion parameters, double-click on the entry
in the Circuit Browser.

Custom filter When this mode is active, a search bar is shown. The Circuit
Browser shows only those components that match the search criterion or all
components if the search string is empty.

The default filtering mode of the Circuit Browser can be specified in the PLECS
preferences (see section “Configuring PLECS” on page 124).
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PLECS Probe

FLELCS
Proke

L

The PLECS Probe enables you to monitor various quantities in a circuit. Most
intrinsic components provide one or more probe signals that describe their cur-
rent state, input, or output signals. For instance, an inductor provides a probe
signal that monitors the inductor current; the probe signals of a diode are the
diode voltage, current and conduction state.

The PLECS Probe can either be used in a PLECS schematic or — for PLECS
Blockset — in a Simulink model. To use the PLECS Probe in a schematic use the
Probe block from the “System” Library.

In order to use the PLECS Probe in Simulink, drag the Probe block from the
PLECS library into the Simulink model that contains the circuit which you
want to probe. Double-click the icon to open the probe editor window.

4 Probe Editor: Probe x|
—Probed dreuit
Circuit
—Probed components —Component signals
[~ MOSFET voltage
;I Type | MName | Path |
4| [MosFET FETL T Girauit I MOSFET current
Diode D1 Circuit I~ MOSFET gate input
& |nductor L1 Circuit =L
1| Capacitor C1 Circuit ¥ MOSFET conductivity
[~ MOSFET junction temp
[~ MOSFET conduction loss
[~ MOSFET switching loss
Close I Help |

This window contains the following information.

Probed circuit For the Simulink Probe the text box across the top shows the
name of the circuit that you are probing and its path, i.e. the Simulink system
containing the Circuit block.

Note A Simulink Probe must be in the same Simulink model as the Circuit
block whose components you want to monitor. In addition, a Simulink Probe
block only accepts components from one single Circuit block at a time.
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Probed components The list box on the left side shows the components

that you have selected for probing. The components are identified by their type,
name and path within the circuit. For adding components to this list, simply se-
lect them in the schematic editor and drag them into the probe editor. The new
components are appended at the bottom of the list. You can reorder the com-
ponents using the Up 4, Down 4 and Remove - buttons. If you click on the
Show component <& button, the currently selected component will be shown
in the schematic editor.

Component signals The list box on the right side shows the available probe
signals for the selected component. Use the check boxes next to the signal
names in order to enable or disable individual signals. You can simultaneously
edit the signal states of several components provided that the components have
the same type. In order to select multiple components, hold the Shift or Ctrl
key while clicking on a list entry.

For PLECS Probes that are used in a PLECS schematic there are two ways to
add components to the probe: Either drag them into the Probed components
area in the probe dialog (see above) or drop them onto the Probe block directly.

The output of the Probe block is a vector signal consisting of all enabled probe
signals. If no probe signal is enabled, the block will output a scalar zero.

Copying a Probe
When you copy a PLECS Probe in a PLECS schematic, one of the following
three cases can apply:

1 If a probed component is copied simultaneously with a Probe block referring
to it, the copied Probe block will refer to the copy of the component.

2 Else, if the Probe block is copied within the same circuit, the copied Probe
block will refer to the original component.

3 Else (i.e. if the Probe block is copied into a different circuit), the probe refer-
ence will be removed.

For technical reasons it is not possible to determine whether a PLECS Probe for
Simulink is copied simultaneously with a Circuit block. Therefore, PLECS only
distinguishes between the following two cases:

1 If you copy a Simulink Probe block within ke same model, the copied Probe
block will always refer to the original components.

2 If you copy a Probe block into a different model, all data is cleared from the
copied block.
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Assertions

Assertions allow you to monitor arbitrary signals during a simulation and raise
a warning or error message if they fail to meet a given condition. For instance,
imagine you want to ensure that a certain component operates within a safe
temperature range. Once the temperature leaves the defined operating range,
you would like to receive a notification. In PLECS, this can be achieved using
assertions.

Assertions are conditions that are assumed to hold during the entire simula-
tion of a model. When a condition becomes invalid, i.e. when an assertion fails,
PLECS executes a predefined action. The possible actions are:

* to ignore the failed assertion
* to add a warning message to the diagnostics window

¢ to add a warning message to the diagnostics window and additionally
pause the simulation

* to add an error message to the diagnostics window and immediately stop
the simulation

There is a global model parameter that allows you to override the actions de-
fined locally in the individual assertions (see “Simulation Parameters” on page
111).

Note In PLECS Standalone, assertions are partially disabled during analy-
ses (see “Analysis Tools” on page 179) and simulation scripts (see “Simulation
Scripts” (on page 253)). In a Steady-State Analysis, assertions are only enabled
during the final period shown at the end of the analysis. Assertions are not al-
lowed to pause the Steady-State analysis, but it may be aborted if an assertion
triggers an error message. In all other analyses, assertions are entirely dis-
abled. Assertions are not allowed to pause a simulation script, but a script may
be aborted if an assertion raises an error message.

PLECS provides two kinds of assertions: built-in assertion blocks and asser-
tions that can be established on components based on their probe signals.



Assertions

Assertion Blocks

There is one basic Assertion block (see page 367) that interprets its input signal
as a boolean value. While the value is non-zero, the assertion holds; whenever
the input becomes zero, the assertion fails.

Because assertions are often used to ensure that a signal is within a certain
range or below or above a certain limit, PLECS provides additional assertion
blocks to directly do this. These blocks are:

Assert Dynamic Lower Limit (see page 364)

Assert Dynamic Range (see page 365)

Assert Dynamic Upper Limit (see page 366)

Assert Lower Limit (see page 368)

Assert Range (see page 369)

Assert Upper Limit (see page 370)

Component Assertions

PLECS also provides the possibility to add assertions directly to components.
This can be used to define a valid range for any probe signal of a component.

To add assertions to a component, open its parameter dialog and click on the

Assertions tab. If the parameter dialog of a component does not provide this
tab, it is not possible to add assertions.

+4 Block Parameters: untitled/R1 il
Resistar
’7 Ideal resistar,

Parameters Assertions

Lower | Upper | Include
Lirnit Lirnit Lirits
Resistor voltage -101 10 v wWatning/pause

P.esis| IEL

Probe Signal Action

(04 I Cancel | Apply | Help |

Use the “+” and “-” buttons to add or remove assertions. In the different
columns, the parameters for the assertions can be provided: the probe signal
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that is limited by the assertion, the lower and upper limits, whether the lim-

its should be inclusive, and the action executed when the assertion fails (see
above). If the limits are included (by setting a check mark in that column), the
limits themselves are considered part of the valid range, otherwise the signal
has to be strictly within the limits. The values - inf and inf may be used to dis-
able the lower or upper limit, respectively.

Locating Assertions

To quickly get an overview of all assertions that are defined in a model, open
the Circuit Browser (see page 89) and set the filter option to Show assertions.
The Circuit Browser will then list only assertion blocks and components, for
which assertions have been defined.
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Controlling Access to Circuits and Subsystems

PLECS allows you to control user access to individual subsystems or to com-
plete circuits. In particular, you can prevent a user from viewing or modifying a
schematic while still allowing the user to simulate a circuit.

To change the access settings of a circuit, open the permissions dialog box by
choosing Circuit permissions... from the File menu. To change the settings of
a subsystem, choose Permissions... from the Subsystem submenu of the Edit
menu or the block’s context menu.

You can grant or deny the following privileges:
¢ The View privilege controls whether a user can view the schematic of a cir-
cuit or subsystem.

¢ The Modify privilege controls whether a user can modify the schematic of
a circuit or subsystem. For a subsystem it also controls whether the mask
definition may be modified.

If you apply access restrictions, you will be asked for a password to prevent an
unauthorized person from lifting these restrictions. The access settings can
only be changed again if the correct password is provided.

Encrypting Circuits and Subsystems
When PLECS saves a circuit with access restrictions to a model file, it encrypts

the respective sections to protect the circuit description from unauthorized ac-
cess.
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PLECS allows you to export the schematic to a bitmap or PDF file for documen-
tation. The supported image formats are:

¢ JPEG (Bitmap)

e TIFF (Bitmap)

¢ PNG (Bitmap)

* SVG (Scalable Vector Graphics)

¢ PDF (Portable Document Format)

To export a schematic choose Export... from the File menu and select your de-

sired output format. A second dialog lets you specify the export options for the
specific format, e.g. the bitmap resolution.

It is also possible to copy schematics to other applications directly via the clip-
board. To copy an image of the current schematic to the clipboard choose Copy
as image from the Edit menu, then select Paste from the Edit menu in your
target application.
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Using the PLECS Scope

The PLECS scope is used to display simulation results and offers powerful
zooming and analysis tools to simplify viewing and processing results. The
PLECS scope can be placed on the Simulink worksheet or in the PLECS circuit.
The appearance of the PLECS scope is depicted below. The scope contains a plot
area and optional Zoom view, Saved view and Data view windows.
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Ll
Getting Started

To use the scope, drag the scope block from the PLECS library onto your work-
sheet or schematic diagram. The scope block for Simulink can be found in the
top level of the PLECS library. The scope block for a PLECS circuit is located in

the PLECS Sources & Meters library.
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Double clicking on the Scope block opens the Scope window. The main window
of the scope can contain multiple plots. Plots can be quickly added or removed
by right clicking the plot area and selecting Insert plot above, Insert plot
below or Remove plot from the context menu.

The optional Zoom view, Saved view and Data view windows can be opened

by right-clicking on the toolbar area. They can also be opened from the View
menu. These optional windows can be docked and undocked from the main win-
dow. To dock them in main window, simply drag them to the desired location
inside the main window.

Legend

You can show a legend on top of each plot by choosing Show legend from the
View menu or from the context menu. The default text of a signal label is de-
rived from the name of the block from which the signal originates and possibly

a probe signal name. To modify the text, double-click on a label. If you erase the
complete label text, the default text is restored.

Zoom Operations

Zooming is performed by clicking on the plot area and dragging the mouse un-
til the desired area is selected. Two zoom modes exist: Constrained Zoom and
Free Zoom. The zoom mode is selected using the toolbar button. To temporarily
switch zoom modes, the Ctrl key (cmd key with macOS) can be pressed.
Constrained Zoom &

With Constrained Zoom, zooming is only performed in the x or y direction. The
zoom direction is selected by moving the mouse horizontally or vertically.

Free Zoom “.

With Free Zoom mode activated, the zoom area is defined by dragging the zoom
cursor over a certain portion of the plot.

Zoom to Fit [l

Zoom to fit will fit the entire waveform into the plot window.
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Zoom to Specification

A zoom range can also be manually specified. Double-clicking on the x or y axis
opens a dialog in which the x or y range of the zoom area can be entered.

Previous View, Next View @ ©

Every time a zoom action is performed, the view is stored in the view history.
The previous and next view buttons allow you to navigate backwards and for-
wards through the view history.

Panning

A zoom area can be panned by dragging the x or y axes of the plot with the
hand symbol that appears.

Zoom Area Window

The zoom area window displays the entire waveform and highlights the zoom
view that is displayed in the plot window. Constraint Zoom and Free Zoom can
also be performed in the zoom area window. The zoom area window is activated
by right clicking on the toolbar.

Scrolling

During a simulation, if the current x-axis range is smaller than the simulation
time span, the scope will automatically scroll the x-axis so that the current sim-
ulation time step is always shown. The scrolling mode (paged or continuous)
may be specified in the scope parameters.

Scrolling is suspended if you manually zoom or pan so that the current simu-
lation time is greater than the right x-axis limit. This is indicated by a stack of
small arrows at the right border of the plot. Scrolling is resumed if you click on
these arrows or if you zoom or pan so that the current simulation time is less
than the right x-axis limit.
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Y-Axis Auto-Scaling

The scope features a dynamic auto-scaling mode, in which the y-axis limits

are always adjusted to the currently visible waveforms. The state of the auto-
scaling mode is indicated by a small semi-transparent icon (2/=) in the top-
right corner of a plot. Clicking on this icon will toggle the state. Auto-scaling
will be enabled for all plots in the scope if you click the Zoom to Fit button. If
you zoom in the y direction of a plot, auto-scaling will be disabled for that plot.
The initial auto-scale state at simulation start is specified for each plot individ-
ually in the scope parameters (see page 664).

Changing Curve Properties

By default, the curves for the different signals and/or traces in a plot are drawn
with a pen that is defined by the palette selected in the PLECS preferences (see
“Scope Colors” on page 126).

To change individual curve properties (color, line style and width), right-click
on a plot and select Edit curve properties from the context menu. This will
open a table listing the properties of all visible curves. To change a particular
property, double-click on the corresponding table cell.

Locally changed properties are highlighted with a white background and are
stored persistently in the model file. In contrast, properties that are defined by
the global scope palette have a grey background. To remove all local changes
click on Restore Defaults.

Spreading Signals

When using a single plot to display multiple signals that assume only a small
number of discrete values (such as gate signals), it can be difficult to properly
see the value that a particular signal has. You can have the scope automati-
cally separate the signals in a plot by offsetting and scaling them appropriately.
All signals are scaled by the same factor and the offsets are distributed evenly
in order to maintain the proportions between the signal. Vertical scrolling and
zooming is disabled in this mode.

To enable signal spreading, right-click on a plot and select Spread signals
from the context menu. While spreading is enabled, the y-axis will only display
the zero-lines for the individual signals, and zooming in the y-direction is dis-
abled.
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Cursors 1t

The cursors are used for measuring waveform values and analyzing the sim-
ulation results. Cursors can be positioned by dragging them to a specific time
location, or by manually entering a value in the Time row in the Data Window.

When the cursors are moved, they will snap to the nearest simulation time
step. To place the cursors arbitrarily, hold down the Shift key while moving
the cursor. The values in the data window will be displayed in italics to indicate
they are interpolated from the two nearest time steps.

Data Window

When the cursors are activated, the data window appears if it was not already
open. By default, the data window displays two columns in which the time and
data value of each signal at the position of each cursor are given. The signal
names are also displayed and can be modified by double-clicking on the name.

A right-click into the Data Window shows a context menu. Selecting “Copy to
Clipboard” copies the current contents of the table to the system clipboard. Af-
terwards the data can be pasted into other applications, e.g. a spreadsheet tool
or word processor.

Signal Type

A small icon that represents the signal type is shown next to the signal name
in the data view window. Signals can be of the continuous, discrete or impulse
type. The scope automatically determines the signal type from the port settings
of the connected signal to ensure the signal is displayed correctly. The signal
type can be overridden if necessary by clicking on the signal type icon.

Analyzing Data

Right-clicking on the data view header line in the data view window allows for
additional data analysis columns to be displayed. For example, difference, RMS,
min, max, and total harmonic distortion (THD) analysis can be performed. The
analysis is performed on the data between the two cursors. For meaningful
RMS and THD values the cursor range must be equal to the period of the fun-
damental frequency.
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Locking the Cursors

Locking the cursors can be useful for performing measurements over a fixed
time period, such as the time period of an ac voltage. When dragging one of
the locked cursors, the other cursor will be moved in parallel at a specified time
difference. To lock the cursors, the Delta column in the Data Window must be
made visible by right-clicking on the table header. The desired cursor distance
can be entered in the Time row of the Delta column. The cursors can be un-
locked by double-clicking on the lock icon in the Delta column.

Fourier Analysis =

A Fourier analysis of the data in the current cursor range is accessible from the
View menu. The use of the Fourier analysis is detailed in section “Using the
Fourier Analysis” (on page 106).

Saving a View ®

A particular zoom view can be saved by pressing the eye button. The saved
views window will appear if it was not already displayed and the new view will
be added to the saved views list. To access a particular saved view, click on the
view name in the saved views window. Saved views can be renamed by double
clicking the name of the view, and reordered by clicking and dragging an entry
up and down in the list. A view can be removed with the red delete button.

Adding Traces =

After a simulation has been completed the resulting curves can be saved as a
trace. Traces allow to compare the results of different simulation runs.

A new trace is added by either pressing the Hold current trace button in the
toolbar or by pressing the green plus button next to the Current Trace entry
in the Traces window. To remove a trace press the red minus button next to the
trace in the Traces window. Held traces can be reordered by clicking and drag-
ging an entry up and down in the list.

Traces can also be added and removed by simulation scripts. For details, see
section “Holding and Clearing Traces in Scopes” (on page 274).

104



Using the PLECS Scope

Saving and Loading Trace Data

Existing traces in a scope can be saved by selecting Save trace data... from
the File menu. The saved traces can be loaded into a scope for later reference.
The scope into which the trace data is loaded must have the same number of
plots as the scope from which the data was saved. The number of input signals
per plot should also match, otherwise the trace data is lost when a new simula-
tion is started.

Scope Parameters ]

The scope parameters dialog allows for the appearance of the scope to be
changed and automatic or custom zoom settings to be applied to the x and y
axes. More information can be found in the parameter description of the Scope
block (see page 664). The plot background color can be changed in the PLECS
preferences (see section “Configuring PLECS” on page 124).

Printing and Exporting

A plot can be printed or exported from the File menu. When printing, the ap-
pearance of the plot and legend can be changed using the Page Setup option.
When exporting, the plot style can also be changed and the output size of the
image can be customized.

The data table can be exported to e.g. Microsoft Excel using the clipboard. To
copy the data to the clipboard open the context menu by right-clicking and
choose "Copy to clipboard".
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Using the Fourier Analysis
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The Fourier Analysis is available from the View menu in the PLECS scope win-
dow.

The Fourier analysis window shows the magnitude of the Fourier coefficients
for the given number of harmonics. The analysis range for the Fourier analysis
is determined by the cursors in the scope window. By default it is assumed that
the cursor range covers exactly one period of the base frequency, though this
can be changed in the Fourier parameters. Note that spectral leakage effects
will be visible if the cursor time range is not an exact integer multiple of the
inverse base frequency.

Calculation Parameters

Base Freqency
The analysis range T is always bound to the cursor range in the PLECS
scope. In general it consists of n periods of the base frequency, i.e. T = %
A click on the frequency input field f: in the window title bar opens the Base
Frequency dialog. Two modes are available to set the base frequency: by
freely positioning the cursors in the PLECS scope or by entering the numer-
ical values directly in the Base Frequency dialog.

The first mode is activated by selecting Calculate from cursor range
in the Base Frequency dialog. In this mode it is assumed that the cursor
range covers a single base period. The two cursors can be positioned inde-
pendently from each other and should be set as exactly as possible to the
start and end of a single base period. The corresponding base frequency is
displayed in the window toolbar.

If the base frequency is known beforehand, it can be entered directly by
choosing Set base frequency. In this mode the scope cursors are locked
to the number of base periods. Moving the cursors still allows you to select
the analysis range without changing the base frequency.

Number of Fourier Coefficients
The number of Fourier Coefficients which are calculated can be changed in
the input field N: in the window title bar.
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Display Parameters (]

Display frequency axis
The frequency axis is either shown underneath each plot or underneath the
last plot only.

Frequency axis label
The text is shown below the frequency axis.

Scaling
The Fourier analysis window offers three options to scale the Fourier coeffi-
cients: Absolute, linear displays the absolute value of each coefficient. Ab-
solute, logarithmic displays the common logarithm of the absolute values,
multiplied by 20. Relative, linear scales all coefficients such that the coef-
ficient of the base frequency is 1. When set to Relative, logarithmic (dB)
the coefficients are displayed on a logarithmic scale in Decibels relative to
the coefficient of the base frequency.

Table data
The table below the Fourier plots shows the calculated Fourier coefficients.
The values can be displayed without phase (Magnitude only), with phase
values in radians (Magnitude, phase (rad)) or with phase values in de-
gree (Magnitude, phase (degree)).

The following items can be set for each plot independently:

Title
The name which is displayed above the plot.

Axis label
The axis label is displayed on the left of the y-axis.

Y-limits
The initial lower and upper bound of the y-axis. If set to auto, the y-axis is
automatically scaled such that all data is visible.

Signal Type

As in the scope window the signal type in the Fourier analysis window can be
changed by clicking the small icon next to the signal name in the data view
window. Available types are bars, stems and continuous. By default the signals
are displayed as bars. Changing the signal type for one signal will affect all sig-
nals in the same plot.
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Zoom, Export and Print
The Fourier analysis window offers the same zoom, export and print operations

as the PLECS scope. See section “Using the PLECS Scope” (on page 99) for de-
tails.

Calculation of the Fourier coefficients

The following approximation is made to calculate the Fourier coefficients of a
signal with variable sampling intervals AT,,:

]:(n) = %/f(f)e*jw(mtdt ~ %Z / fm(t)efjwontdt
T

AT,
where
fm() = amt+b, forcontinuous signals
fm(@) = bm for discrete signals

A piecewise linear approximation is used for continuous signals. Compared to
a fast Fourier transformation (FFT) the above approach also works for signals
which are sampled with a variable sample rate. The accuracy of this approxi-
mation highly depends on the simulation step size, AT,,: A smaller simulation
step size yields more accurate results.
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Using the XY Plot

The XY plot is used to display the relationship between two signals, x and y. In
every simulation step the x and y input signals are taken as coordinates for a
new point in the XY plot. You can choose to draw trajectories by connecting con-
secutive points with a direct line, to draw a vector from the origin to the current
point or a combination of both.
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The time range window allows you to restrict the data that is used for plotting.
The window is accessible from the View menu.

The time range can be modified by moving its left and right boundary. The in-
active time range is grayed out. By clicking into the time range, the active time
range can be shifted without changing its length. Any change of the time range
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is reflected in the XY plot immediately. If vectors are drawn, the right end of
the time range determines the position of the vector head.

If a time range is specified in the XY plot parameters, it is used as the default
width of the time range in the time range window. A detailed parameter de-
scription is available in the XY Plot documentation (see page 834).

Zoom, Save View, Export and Print

The XY plot offers the same zoom, export and print operations as the PLECS
scope. See section “Using the PLECS Scope” (on page 99) for details.
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Simulation Parameters

PLECS Standalone Parameters

This section describes the simulation parameters available for PLECS Stan-
dalone. For the PLECS Blockset simulation parameters please refer to the fol-
lowing section (see page 118).

To open the parameter dialog, select Simulation parameters from the Simu-
lation menu of the schematic editor or press Ctrl-E.

Simulation Time

Start Time The start time specifies the initial value of the simulation time
variable ¢ at the beginning of a simulation, in seconds (s). If a simulation is
started from a stored system state (see “System State” on page 117), this pa-
rameter is ignored and the simulation time specified in the system state is used
instead.

Time Span The simulation ends when the simulation time has advanced by
the specified time span.

Solver

These two parameters let you choose between variable-step and fixed-step
solvers. A fixed-step solver uses the same step size — i.e. the simulation time
increment — throughout a simulation. The step size must be chosen by the user
so as to achieve a good balance between accuracy and computational effort.

A variable-step solver can adopt the step size during the simulation depending
on model dynamics. At times of rapid state changes the step size is reduced to
maintain accuracy; when the model states change only slowly, the step size is
increased to save unnecessary computations. The step size can also be adjusted
in order to accurately simulate discontinuities. For these reasons, a variable-
step solver should generally be preferred.

DOPRI is a variable-step solver using a fifth-order accurate explicit Runge-
Kutta formula (the Dormand-Prince pair). This solver is most efficient for non-
stiff systems and is selected by default. A stiff system can be sloppily defined as
one having time constants that differ by several orders of magnitudes. Such a
system forces a non-stiff solver to choose excessively small time steps. If DOPRI
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detects stiffness in a system, it will abort the simulation with the recommenda-
tion to switch to a stiff solver.

RADAU is a variable-step solver for stiff systems using a fifth-order accurate
fully-implicit three-stage Runge-Kutta formula (Radau ITA). For non-stiff sys-
tems DOPRI is more efficient than RADAU.

If auto is selected, PLECS starts a simulation with DOPRI and automatically
switches to RADAU if the system is found to become stiff during a simulation.
This is the default choice for a variable-step solver.

The fixed-step solver Discrete does not actually solve any differential equa-
tions but just advances the simulation time with fixed increments. If this solver
is chosen, the linear state-space equations of the physical model are discretized
as described in section “State-Space Discretization” (on page 35). All other con-
tinuous state variables are updated using the Forward Euler method. Events
and discontinuities that occur between simulation steps are accounted for by a
linear interpolation method.

Variable-Step Solver Options

Max Step Size The maximum step size specifies the largest time step that
the solver can take and should not be chosen unnecessarily small. If you sus-
pect that the solver is missing events, try reducing the maximum step size.
However, if you just require more output points for smoother curves, you should
increase the refine factor (see below).

Initial Step Size This parameter can be used to suggest a step size to be

used for the first integration step. The default setting auto causes the solver

to choose the step size according to the initial state derivatives. You should only
change this parameter if you suspect that the solver is missing an event at the
beginning of a simulation.

Tolerances The relative and absolute specify the acceptable local integration
errors for the individual state variables according to

err; < rtol - |z;| + atol;

If all error estimates are smaller than the limit, the solver will increase the
step size for the following step. If any error estimate is larger than the limit,
the solver will discard the current step and repeat it with a smaller step size.

The default absolute tolerance setting auto causes the solver to update the ab-
solute tolerance for each state variable individually, based on the maximum ab-
solute value encountered so far.
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Refine factor The refine factor is an efficient method for generating addi-
tional output points in order to achieve smoother results. For each successful
integration step, the solver calculates » — 1 intermediate steps by interpolating
the continuous states based on a higher-order polynomial. This is computation-
ally much cheaper than reducing the maximum step size (see above).

Fixed-Step Solver Options

Fixed step size This parameter specifies the fixed time increments for the
solver and also the sample time used for the state-space discretization of the
physical model.

Circuit Model Options

Diode Turn-On Threshold This parameter globally controls the turn-on be-
havior of line commutated devices such as diodes, thyristors, GTOs and sim-
ilar semiconductors. A diode starts conducting as soon as the voltage across

it becomes larger than the sum of the forward voltage and the threshold volt-
age. Similar conditions apply to the other line commutated devices. The default
value for this parameter is 0.

For most applications the threshold could also be set to zero. However, in cer-
tain cases it is necessary to set this parameter to a small positive value to pre-
vent line commutated devices from bouncing. Bouncing occurs if a switch re-
ceives an opening command and a closing command repeatedly in subsequent
simulation steps or even within the same simulation step. Such a situation can
arise in large, stiff systems that contain many interconnected switches.

Note The Diode Turn-On Threshold is not equivalent to the voltage drop
across a device when it is conducting. The turn-on threshold only delays the
instant when a device turns on. The voltage drop across a device is solely de-
termined by the forward voltage and/or on-resistance specified in the device pa-
rameters.

Disc. method This parameter determines the algorithm used to discretize
the state-space equations of the electro-magnetic model.
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ZC step size This parameter is used by the Switch Manager when a non-
sampled event (usually the zero crossing of a current or voltage) is detected.
It controls the relative size of a step taken across the event. The default is 1e-9.

Tolerances The error tolerances are used to check whether the state vari-
ables are consistent after a switching event. The defaults are 1e-3 for the rel-
ative tolerance and 1e-6 for the absolute tolerance.

Sample times

Synchronize fixed-step sample times This option specifies whether
PLECS should attempt to find a common base sample rate for blocks that spec-
ify a discrete sample time.

Use single base sample rate This option specifies whether PLECS should
attempt to find a single common base sample rate for all blocks that specify a
discrete sample time.

These options can only be modified for a variable-step solver; for a fixed-step
solver they are checked by default. For details see section “Multirate Systems”
(on page 41).

State-space calculation

Use extended precision When this option is checked, PLECS uses higher-
precision arithmetics for the internal calculation of the state-space matrices for
a physical model. Check this option if PLECS reports that the system matrix is
close to singular.

Remove unused state-space outputs When this option is checked, PLECS
removes the output equations for physical meters that are not used in the
model in order to avoid unnecessary calculations. You may need to uncheck this
option if you want to calculate state-space matrices in a simulation script, see
“Extraction of State-Space Matrices” (on page 191). This option is unchecked in
old models created with PLECS 4.7 or older and checked in new models created
with PLECS 4.8 or newer.

Enable state-space splitting When this option is checked, PLECS will at-
tempt to split the state-space model for a physical domain into smaller indepen-
dent models that can be calculated and updated individually. This can reduce
the calculation effort at runtime, which is particularly advantageous for real-
time simulations.
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Display state-space splitting When this option is checked, PLECS will is-
sue diagnostic messages that highlight the components that make up the indi-
vidual state-space models after splitting. This is useful e.g. in order to connect
Model Settings blocks in the appropriate places (see Electrical Model Settings
on page 444, Rotational Model Settings on page 641 and Translational Model
Settings on page 774).

Data types

Use floating-point data type for fixed-point signals When this option is
enabled, PLECS will replace all fixed-point data types with the target floating-
point data type (see “Data Types” (on page 43)).

Assertions

Assertion action Use this option to override the action that is executed when
an assertion fails (see Assertion block on page 367). The default is use local
settings, which uses the actions specified in each individual assertion. Asser-
tions with the individual setting ignore are always ignored, even if this option
is different from use local settings. Note that during analyses and simula-
tion scripts, assertions may be partly disabled (see “Assertions” on page 94).

Algebraic loops

Method Use this option to select the strategy adopted by the nonlinear equa-
tion solver. Currently, either a line search method or a trust region method can
be used.

Tolerance The relative error bound. The solver updates the block outputs it-
eratively until the maximum relative change from one iteration to the next and
the maximum relative residual of the loop equations are both smaller than this
value.

Diagnostics

Division by zero This option determines the diagnostic action to take if
PLECS encounters a division by zero in a Product block (see page 618) or a
Function block (see page 459). A division by zero yields oo or nan (,not a num-
ber”, if you divide 0/0). Using these values as inputs for other blocks may lead
to unexpected model behavior. Possible choices are ignore, warning and error.
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In new models, the default is error. In models created with PLECS 3.6 or ear-
lier, the default is warning.

Datatype overflow This option determines the diagnostic action to take if
PLECS encounters a data type overflow. PLECS can issue an error or a warn-
ing message or can continue silently. In the latter two cases, the result is han-
dled according to the individual data type overflow handling setting of the
block. If the individual setting is Assert with error, PLECS always issues
an error message.

Datatype inheritance conflict This option allows to apply less strict data
type inheritance rules (see “Data Types” (on page 43)). In new models, the de-
fault is error. In models created with PLECS 4.7 or earlier, the default is warn-
ing.

Continuous sample time conflict This option determines the diagnostic ac-
tion to take if PLECS detects a continuous sample time conflict (see “Continu-
ous Sample Time Conflicts” on page 40). In new models, the default is error. In
models created with PLECS 4.7 or earlier, the default is warning.

Negative switch loss This option determines the diagnostic action to take if
PLECS encounters negative loss values during the calculation of switch losses
(see “Loss Calculation” on page 135). PLECS can issue an error or a warning
message or can continue silently. In the latter two cases, the losses that are in-
jected into the thermal model are cropped to zero.

Stiffness detection This parameter only applies to the non-stiff, variable-
step DOPRI solver. The DOPRI solver contains an algorithm to detect when

a model becomes ,,stiff” during the simulation. Stiff models cannot be solved
efficiently with non-stiff solvers, because they constantly need to adjust the step
size at relatively small values to keep the solution from becoming numerically
unstable.

If the DOPRI solver detects stiffness in model, it will raise a warning or error
message depending on this parameter setting with the recommendation to use
the stiff RADAU solver instead.

Max. number of consecutive zero-crossings This parameter only applies
to variable-step solvers. For a model that contains discontinuities (also termed
»Zero-crossings”), a variable-step solver will reduce the step size so as to make
a simulation step precisely at the time when a discontinuity occurs (see “Event
Detection Loop” on page 34). If many discontinuities occur in subsequent steps,
the simulation may come to an apparent halt without actually stopping because
the solver is forced to reduce the step size to an excessively small value.
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This parameter specifies an upper limit for the number of discontinuities in
consecutive simulation steps before PLECS stops the simulation with an error
message that shows the responsible component(s). To disable this diagnostic,
set this parameter to 0.

Algebraic loop with state machines This option determines the diagnos-
tic action to take if PLECS detects an algebraic loop that includes a State Ma-
chine (see page 692). This may lead to unexpected behavior because the State
Machine will be executed multiple times for the same simulation step during
the iterative solution of the algebraic loop. Possible choices are ignore, warning
and error. The default is error.

System State

This parameter controls how the system state is initialized at the beginning of
a simulation. The system state comprises

¢ the simulation time,

¢ the values of all physical storage elements (e.g. inductors, capacitors, thermal
capacitances),

¢ the conduction states of all electrical switching elements (e.g. ideal switches,
diodes),

¢ the values of all continuous and discrete state variables in the control block
diagram (e.g. integrators, transfer functions, delays),

¢ custom state information of C-Script blocks

Block parameters When this option is selected, the state variables are ini-
tialized with the values specified in the individual block parameters.

Stored system state When this option is selected, the state variables are ini-
tialized globally from a previously stored system state; the initial values speci-
fied in the individual block parameters are ignored. This option is disabled if no
state has been stored.

Store system state... Pressing this button after a transient simulation run

or an analysis will store the final system state along with a time stamp and an
optional comment. When you save the model, this information will be stored in
the model file so that it can be used in future sessions.
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Note Adding, removing, renaming, changing path (when moving in or out
of a subsystem) or changing the number of internal states of blocks that have
continuous or discrete state variables associated with them will invalidate the
stored system state.

Model Initialization Commands

The model initialization commands are executed when a simulation is started
in order to populate the base workspace. You can use variables defined in the
base workspace when specifying component parameters (see “Specifying Com-
ponent Parameters” on page 52).

Note The maximum length of variable names is 63 characters. This is due to
the way in which a workspace is stored in PLECS and exchanged with Octave.

PLECS Blockset Parameters

This section describes the simulation parameters available in PLECS Blockset
for Simulink. For the PLECS Standalone simulation parameters please refer to
the next section (see page 111).

To open the parameter dialog, select PLECS parameters from the Simula-
tion menu of the schematic editor.

Circuit Model Options

Diode Turn-On Threshold This parameter globally controls the turn-on be-
havior of line commutated devices such as diodes, thyristors, GTOs and sim-
ilar semiconductors. A diode starts conducting as soon as the voltage across

it becomes larger than the sum of the forward voltage and the threshold volt-
age. Similar conditions apply to the other line commutated devices. The default
value for this parameter is 1e-3.
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For most applications the threshold could also be set to zero. However, in cer-
tain cases it is necessary to set this parameter to a small positive value to pre-
vent line commutated devices from bouncing. Bouncing occurs if a switch re-
ceives an opening command and a closing command repeatedly in subsequent
simulation steps or even within the same simulation step. Such a situation can
arise in large, stiff systems that contain many interconnected switches.

Note The Diode Turn-On Threshold is not equivalent to the voltage drop
across a device when it is conducting. The turn-on threshold only delays the
instant when a device turns on. The voltage drop across a device is solely de-
termined by the forward voltage and/or on-resistance specified in the device pa-
rameters.

Type This parameter lets you choose between the continuous and discrete
state-space method for setting up the physical model equations. For details
please refer to section “Physical Model Equations” (on page 29).

When you choose Continuous state-space, PLECS employs the Simulink
solver to solve the differential equations and integrate the state variables. The
Switch Manager communicates with the solver in order to ensure that switch-
ing occurs at the correct time. This is done with Simulink’s zero-crossing detec-
tion capability. For this reason the continuous method can only be used with a
variable-step solver.

In general, the default solver of Simulink, ode45, is recommended. However,
your choice of circuit parameters may lead to stiff differential equations, e.g.
if you have large resistors connected in series with inductors. In this case you
should choose one of Simulink’s stiff solvers.

When you choose Discrete state-space, PLECS discretizes the linear state-
space equations of the physical model as described in section “State-Space Dis-
cretization” (on page 35). All other continuous state variables are updated us-
ing the Forward Euler method. This method can be used with both variable-
step and fixed-step solvers.

Discrete State-Space Options

Sample time This parameter determines the rate with which Simulink sam-
ples the circuit. A setting of auto or -1 means that the sample time is inherited
from the Simulink model.
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Refine factor This parameter controls the internal step size which PLECS
uses to discretize the state-space equations. The discretization time step At is
thus calculated as the sample time divided by the refine factor. The refine factor
must be a positive integer. The default is 1.

Choosing a refine factor larger than 1 allows you to use a sample time that is
convenient for your discrete controller while at the same time taking into ac-
count the usually faster dynamics of the electrical system.

Disc. method This parameter determines the algorithm used to discretize
the state-space equations of the electro-magnetic model.

ZC step size This parameter is used by the Switch Manager when a non-
sampled event (usually the zero crossing of a current or voltage) is detected.
It controls the relative size of a step taken across the event. The default is 1e-9.

Tolerances The error tolerances are used to check whether the state vari-
ables are consistent after a switching event. The defaults are 1e-3 for the rel-
ative tolerance and 1e-6 for the absolute tolerance.

Diagnostics

Zero crossing detection disabled In order to accurately determine the
proper switching times of power semiconductors, PLECS highly depends on the
solver’s capability to locate zero crossings. If you switch off the zero crossing
detection in the Simulink solver or use the less accurate “Adaptive” detection
algorithm, PLECS will therefore issue a diagnostic message. This option allows
you to specify the severity level (warning or error) of this message.

If you encounter problems due to many consecutive zero crossings, it is usu-
ally not advisable to modify the zero crossing detection settings. Consecutive
zero crossings are often caused by insufficient simulation accuracy, typically

in conjunction with a stiff model. In this case it may help to tighten the rela-
tive tolerance of the Simulink solver (from the default 1e-3 to 1e-5 or 1e-6) and
to switch from the default solver ode45 to a stiff solver such as ode23tb and,
where applicable, set the Simulink solver option Solver reset method to Ro-
bust.

Number of consecutive gate signal changes If you configure a Signal In-
port block (see page 671) in a top-level schematic to be a gate signal, PLECS
expects this signal to change only at discrete instants. If instead the signal
changes in more than the specified number of consecutive simulation time
steps, PLECS will issue an error message to indicate that there may be a prob-
lem in the gate signal generator. You can disable this diagnostic by entering 0.
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Division by zero This option determines the diagnostic action to take if
PLECS encounters a division by zero in a Product block (see page 618) or a
Function block (see page 459). A division by zero yields +oco or nan (,not a num-
ber”, if you divide 0/0). Using these values as inputs for other blocks may lead
to unexpected model behavior. Possible choices are ignore, warning and error.
In new models, the default is error. In models created with PLECS 3.6 or ear-
lier, the default is warning.

Datatype overflow This option determines the diagnostic action to take if
PLECS encounters a data type overflow. PLECS can issue an error or a warn-
ing message or can continue silently. In the latter two cases, the result is han-
dled according to the individual data type overflow handling setting of the
block. If the individual setting is Assert with error, PLECS always issues
an error message.

Datatype inheritance conflict This option allows to apply less strict data
type inheritance rules (see “Data Types” (on page 43)). In new models, the de-
fault is error. In models created with PLECS 4.7 or earlier, the default is warn-
ing.

Continuous sample time conflict This option determines the diagnostic ac-
tion to take if PLECS detects a continuous sample time conflict (see “Continu-
ous Sample Time Conflicts” on page 40). In new models, the default is error. In
models created with PLECS 4.7 or earlier, the default is warning.

Algebraic loop with state machines This option determines the diagnos-
tic action to take if PLECS detects an algebraic loop that includes a State Ma-
chine (see page 692). This may lead to unexpected behavior because the State
Machine will be executed multiple times for the same simulation step during
the iterative solution of the algebraic loop. Possible choices are ignore, warning
and error. The default is error.

Negative switch loss This option determines the diagnostic action to take if
PLECS encounters negative loss values during the calculation of switch losses
(see “Loss Calculation” on page 135). PLECS can issue an error or a warning
message or can continue silently. In the latter two cases, the losses that are in-
jected into the thermal model are cropped to zero.

Assertion action Use this option to override the action that is executed when
an assertion fails (see Assertion block on page 367). The default is use local
settings, which uses the actions specified in each individual assertion. Asser-
tions with the individual setting ignore are always ignored, even if this option
is different from use local settings. Note that during analyses and simula-
tion scripts, assertions may be partly disabled (see “Assertions” on page 94).
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Use floating-point data type for fixed-point signals When this option is
enabled, PLECS will replace all fixed-point data types with the target floating-
point data type (see “Data Types” (on page 43)).

Sample times

Synchronize fixed-step sample times This option specifies whether
PLECS should attempt to find a common base sample rate for blocks that spec-
ify a discrete sample time.

Use single base sample rate This option specifies whether PLECS should
attempt to find a single common base sample rate for all blocks that specify a
discrete sample time.

These options can only be modified for a Continuous State-Space model; for a
Discrete State-Space model they are checked by default. For details see section
“Multirate Systems” (on page 41).

Algebraic loops

Method Use this option to select the strategy adopted by the nonlinear equa-
tion solver. Currently, either a line search method or a trust region method can
be used.

Tolerance The relative error bound. The solver updates the block outputs it-
eratively until the maximum relative change from one iteration to the next and
the maximum relative residual of the loop equations are both smaller than this
value.

State-space calculation

Use extended precision When this option is checked, PLECS uses higher-
precision arithmetics for the internal calculation of the state-space matrices for
a physical model. Check this option if PLECS reports that the system matrix is
close to singular.

Remove unused state-space outputs When this option is checked, PLECS
removes the output equations for physical meters that are not used in the
model in order to avoid unnecessary calculations. You may need to uncheck this
option if you want to calculate state-space matrices in a simulation script, see
“Extraction of State-Space Matrices” (on page 202). This option is unchecked in
old models created with PLECS 4.7 or older and checked in new models created
with PLECS 4.8 or newer.
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Enable state-space splitting When this option is checked, PLECS will at-
tempt to split the state-space model for a physical domain into smaller indepen-
dent models that can be calculated and updated individually. This can reduce
the calculation effort at runtime, which is particularly advantageous for real-
time simulations.

Display state-space splitting When this option is checked, PLECS will is-
sue diagnostic messages that highlight the components that make up the indi-
vidual state-space models after splitting. This is useful e.g. in order to connect
Model Settings blocks in the appropriate places (see Electrical Model Settings
on page 444, Rotational Model Settings on page 641 and Translational Model
Settings on page 774).

Simulink Coder

Target This option specifies the code generation target that is used when you
generate code with the Simulink Coder. For details on the available targets see
section “Code Generation Targets” (on page 293).

Inline circuit parameters for RSim target This option controls whether
PLECS inlines parameter values or whether it should keep them tunable when
it creates code for the RSim target. For details see section “Tunable Circuit Pa-
rameters in Rapid Simulations” (on page 295).
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The PLECS configuration parameters can be modified per user in the PLECS
Preferences dialog. Choose the menu entry Preferences... from the File menu
(PLECS menu on macOS) to open it.

General

The language used by PLECS can be specified in the Language field. PLECS
uses the language settings of your computer as default setting. Available lan-
guages are English and Japanese. To activate the new language settings,
PLECS must be restarted.

The setting Symbol format controls whether resistors and capacitors are
drawn in DIN or ANSI style. The table below shows the different component rep-
resentation for both settings.

DIN ANSI

o __lo oA\

2+ 2
E3 T

When the Grid setting is set to on, a grid is displayed in the background of
schematic windows for easier placement of components and their connections.

The Circuit browser default setting specifies the default filtering mode used
for all circuit browsers (see section “Circuit Browser” on page 89).

The Appearance controls the color scheme used by PLECS. You can choose be-
tween the classic 1ight scheme and the new dark scheme that is designed to
work well in a low-lit environment. On macOS, you can also let PLECS dynami-
cally adapt to the system default of your computer.

When PLECS is used in dark mode, the darkness of the schematic background
can be scaled by the option Dark background.

When a Diff is shown in a Diff result window, by default the left view shows
the "before" model and the right view the "after" model. Using the Diff result
window option, you can swap the views. Note that swapping the views only



Configuring PLECS

changes their location in the window and has no influence on the roles of the
"before" and "after" models.

The maximum amount of memory that is used by PLECS during the simula-
tion can be controlled with the setting Cache size limit. Once PLECS reaches
the memory limit it will discard earlier computation results which may have
to be recalculated later during the simulation. On the other hand the value
should not be higher than about one third of the physical memory of the com-
puter where PLECS is running, otherwise the simulation performance may be
degraded due to swapping.

In PLECS Standalone the Thread limit specifies the maximum number of
threads that may be used by an individual interactive analysis or an individ-
ual parallel simulation or analysis command. This can be further reduced using
simulation or analysis options.

In PLECS Standalone the RPC interface can be enabled or disabled for ex-
ternal scripting. When enabled, PLECS listens on the specified TCP port for
incoming RPC connections. See chapter “RPC Interface in PLECS Standalone”
(on page 262) for details on using the RPC interface.

When starting PLECS, a Welcome screen is shown if enabled.

When opening a model, PLECS can reopen all scope windows that were open
when the model was saved. The option Scope windows enables or disables
this behavior.

If PLECS crashes, a crash report dialog is shown with an error message and the
possibility to send a report to Plexim to help investigate the cause of the crash.
The online help of PLECS is shown in a separate process called "webengine"
that also shows a crash report dialog if it crashes. You can disable the crash
report dialog for the second process using the option Crash report dialog.

Libraries

To add custom libraries to the library browser add these libraries in the User
libraries settings. All custom libraries must be located on the library search
path, which is defined differently depending on the PLECS edition:

¢ For PLECS Standalone the library search path can be changed in the
Search path settings on the same preferences page.

¢ For PLECS Blockset the custom libraries must be located on the MATLAB
search path. The MATLAB search path can be set from the MATLAB file
menu. The Search path settings are not available in the PLECS Blockset
preferences.
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If the checkbox Show library link indicators is checked, PLECS will display
a small hollow curved arrow () in the lower left corner of each component that
links back to a library. A right-click on this link indicator opens a context menu
that allows you to break the library link or show the original component in the

library browser.

Note To create a new component library in PLECS Blockset, you need to copy
the PLECS Library block from the PLECS Extras library into a Simulink model
or library. For details on creating custom libraries see also section “Libraries”
(on page 57).

Thermal

The setting Thermal description search path contains the root directories
of the thermal library. See section “Thermal Library” (on page 140) for more
details.

Scope Colors

The Scope background setting determines whether the PLECS scopes are
drawn with a black or white background.

The Scope palette setting determines the appearance of the curves inside the
PLECS scopes. To create a new custom palette, select any existing palette and
click on Duplicate. To remove a palette, click on Remove. Note that the de-
fault palette is read-only and cannot be removed.

The Signals group box lists the base properties used for the curves in a scope
plot. You can specify color, line style and line width individually for each curve.
If a plot contains more curves than the number of entries in this list, PLECS
will restart at the beginning. The default palette specifies six solid, one pixel
wide line styles.

The Distinguish traces by setting specifies how different traces for a specific
signal are distinguished from each other (see “Adding Traces” on page 104). In
the default palette, traces are distinguished by brightness, i.e. by using differ-
ent shades of the base color. In custom palettes, you can alternatively distin-
guish traces by varying the color, line style or width. The selected property will
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then not be available in the signal list. Again, if a plot has more traces than the
number of entries in this list, PLECS will restart at the beginning.

Update

PLECS can be configured to check for updates every time it is started. If the

computer running PLECS is located behind a firewall, it may be necessary to
configure proxy settings. These settings can be determined automatically or

entered manually.

The Server name configures the fully qualified domain name or the IP address
of the HTTP proxy server. Leave empty to disable proxy usage.

The Server port configures the TCP port of the HTTP proxy server.

The Proxy user configures the username to use for proxy authentication.
Leave empty to disable proxy authentication.

The Proxy password configures the password for proxy authentication.

Note To check for updates PLECS sends its version to the PLEXIM update
server. No further personal information is transmitted.

Coder

For more information about the PLECS Coder, see “Code Generation” (on page
279).

The setting Target support packages path lets you specify a folder which
PLECS searches for target support packages for the PLECS Coder. A target
support package enables the PLECS Coder to generate code that is specific for a
particular target such as the PLECS RT Box.

The table Installed targets lists the support packages that are installed in
the specified folder. PLECS automatically searches the folder when you start it.
To refresh the list after you have installed a new target, click on the Refresh
button.
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Installing Extensions

The functionality of PLECS can be extended using packages called exten-
sions. Two extensions are available: WBS (Web-Based Simulation) and PIL
(Processor-In-the-Loop). To install and configure these extensions, the Exten-
sions dialog can be used: in PLECS, click on the menu entry PLECS Exten-
sions... from the File menu.

4 PLECS Extensions |

web | e |

—Web Framework Path

C:\Users\Public\PLECS_Web_Framework

—Installed Web Framewaorks

Path | Veersion I
<none

—Available Web Frameworks

Path Version | Install I
version_1 1.0 v
Install selected |
Close I Help I

WBS allows the visitor of a web page to run PLECS simulations interactively
in a web browser. The simulation models are provided by a PLECS simulation
server. PLECS Standalone can be used as a simulation server on the local com-
puter. No additional WBS license is needed as long as this feature is used only
for development and test purposes; for the deployment of the web service a sep-
arate server license is required. The PLECS WBS framework contains the nec-
essary files to set up the web service. Please see the accompanying documenta-
tion within the framework.

The PIL approach allows to run code on an embedded controller that is syn-
chronized with the simulation in PLECS. The necessary framework files for
generating suitable embedded applications can be installed by users that have
a separate PIL license.
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The dialog shows the available frameworks shipped with the current PLECS
release in the lower part and the already installed frameworks in the upper
part. To extract a framework an installation path has to be specified once (at
the top of the dialog). Select the desired version from the available frameworks
and click on Install selected.
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Thermal Modeling

Thermal management is an important aspect of power electronic systems and
is becoming more critical with increasing demands for compact packaging and
higher power density. PLECS enables you to include the thermal design with
the electrical design at an early stage in order to provide a cooling solution suit-
able for each particular application.

Heat Sink Concept

The core component of the thermal library is an idealized heat sink (see page
474) depicted as a semitransparent box in the figure below. A heat sink absorbs
the thermal losses dissipated by the components within its boundaries. At the
same time, a heat sink defines an isotherm environment and propagates its
temperature to the components which it encloses.
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Heat conduction from one heat sink to another or to an ambient temperature is
modeled with lumped thermal resistances and capacitances that are connected



4 themal Modeling

to the heat sinks. This approach allows you to control the level of detail of the
thermal model.

Implementation

Each heat sink has an intrinsic thermal capacitance versus the thermal refer-
ence node. All thermal losses absorbed by the heat sink flow into this capaci-
tance and therefore raise the heat sink temperature. Heat exchange with the
environment occurs via the external connectors.

(=]

A+ A3
Thermal Heatsink

losses temperature

HeatSink

You may set the intrinsic capacitance to zero, but then you must connect the
heat sink either to an external thermal capacitance or to a fixed temperature,
i.e. the Constant Temperature block (see page 393) or the Controlled Tempera-
ture block (see page 401).

Thermal Loss Dissipation

132

There are two classes of intrinsic components that dissipate thermal losses:
semiconductor switches and ohmic resistors.

Semiconductor Losses

Power semiconductors dissipate losses due to their non-ideal nature. These
losses can be classified as conduction losses and switching losses. For complete-
ness the blocking losses due to leakage currents need to be mentioned, but they
can usually be neglected.

Semiconductor losses are specified by referencing a thermal data sheet in the
component parameter Thermal description. See section “Thermal Descrip-
tion Parameter” (on page 139) and “Thermal Library” (on page 140) for more
details.



Thermal Loss Dissipation

Conduction Losses

The conduction losses can be computed in a straightforward manner as the
product of the device current and the device voltage. By default the on-state
voltage is calculated from the electrical device parameters as v = V; + R, - ¢.

However, PLECS also allows you to specify the on-state voltage used for the
loss calculation as an arbitrary function of the device current and the device
temperature: v = v,,(4,7"). You may also specify additional custom function ar-
guments. This function is defined in the Conduction loss tab of the thermal
description as a 2D look-up table or a functional expression (see “Thermal Edi-
tor” on page 142).
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A setting of 0V for a single temperature and current value means no conduc-
tion losses. If you do not specify a thermal description in the device parameters,
the default will be used, i.e. the losses are calculated from the electrical device
parameters.

Note Ifyou specify the Thermal description parameter, the dissipated ther-
mal power does not correspond to the electrical power that is consumed by the
device. This must be taken into account when you use the thermal losses for
estimating the efficiency of a circuit.
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Switching Losses

Switching losses occur because the transitions from on-state to off-state and
vice versa do not occur instantaneously. During the transition interval both the
current through and the voltage across the device are substantially larger than
zero which leads to large instantaneous power losses. This is illustrated in the
figure below. The curves show the simplified current and voltage waveforms
and the dissipated power during one switching cycle of an IGBT in an inverter
leg.
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In other simulation programs the computation of switching losses is usually
challenging because it requires very detailed and accurate semiconductor mod-
els. Furthermore, very small simulation time-steps are needed since the du-
ration of an individual switching transition is in the order of a few hundred
nanoseconds.

In PLECS this problem is bypassed by using the fact that for a given circuit the
current and voltage waveforms during the transition and therefore the total
loss energy are principally a function of the pre- and post-switching conditions
and the device temperature: £ = E,, (Ublock; ton; L), £ = Eoff (Vblock, ton, I). You
may also specify additional custom function arguments. These functions are
defined in the tabs Turn-on loss and Turn-off loss of the thermal editor as 3D
look-up tables or functional expressions (see “Thermal Editor” on page 142) .

A setting of 0J for a single voltage, current and temperature value means no
switching losses.
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Note Due to the instantaneous nature of the switching transitions, the dissi-
pated thermal energy cannot be consumed electrically by the device. This must
be taken into account when you use the thermal losses for estimating the effi-
ciency of a circuit.

Loss Calculation

As described above, the conduction and switching losses are defined by means
of look-up tables. From these tables the actual losses are calculated during

a simulation using linear interpolation if the input values (on-state current,
pre- and post-switching current or voltage, junction temperature) lie within the
specified index range. If an input value lies out of range, PLECS will extrapo-
late using the first or last pair of index values.

If the calculated loss value is negative, PLECS will issue a diagnostic message
and/or crop the value to zero. You can select the diagnostic action to be taken
with the diagnostic parameter Negative switch loss in the simulation pa-
rameters dialog (see “PLECS Standalone Parameters” on page 111 and “PLECS
Blockset Parameters” on page 118).
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Supported Devices

Semiconductor components that implement this loss model are

¢ the Diode (see page 411),

¢ the Thyristor (see page 739),

¢ the GTO (see page 466),

¢ the GTO with Diode (see page 468),

¢ the IGBT (see page 482),

¢ the IGBT with Diode (see page 502),

¢ the Reverse Blocking IGCT (see page 508),
¢ the Reverse Conducting IGCT (see page 510),
¢ the MOSFET (see page 564),

¢ the MOSFET with Diode (see page 567) and
¢ the TRIAC (see page 792).

In addition, the Set/Reset Switch (see page 666) is also included in this group to
enable you to build your own semiconductor models.

Ohmic Losses

Ohmic losses are calculated as i2 - R resp. u?/R. They are dissipated by the fol-
lowing components:

¢ the Resistor (see page 630),

the Variable Resistor with Variable Series Inductor (see page 820),

the Variable Resistor with Constant Series Inductor (see page 817),

the Variable Resistor with Variable Parallel Capacitor (see page 818) and
the Variable Resistor with Constant Parallel Capacitor (see page 816).

Heat Sinks and Subsystems

By default, if you place a subsystem on a heat sink, the heat sink temperature
is propagated recursively into all subschematics of the subsystem. All thermal
losses dissipated in all subschematics flow into the heat sink. In some cases
this is not desirable.
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The implicit propagation mechanism is disabled if a subschematic contains one
or more heat sinks or the Ambient Temperature block (see page 360). This lat-
ter block provides a thermal connection to the heat sink enclosing the parent
subsystem block.

Anode

/\ Ambient

R: Ron

.
vac(V) R: Roff

UCathode

As an example the figure above shows the subschematic of the Diode with Re-
verse Recovery (see page 413). By default, this diode model would only dissi-
pate the ohmic losses from the three resistors and the conduction losses of the
internal ideal diode. However, the losses from the reverse recovery current in-
jected by the current source would be neglected because current sources (and
also voltage sources) do not dissipate thermal losses.

The Diode with Reverse Recovery therefore uses a Controlled Heat Flow block
(see page 400) to inject the electrical power loss into the thermal model via the
Ambient Temperature block. The power loss is calculated by multiplying the
device voltage and the device current.

Temperature Initialization

The state variables of a thermal model are the temperatures of thermal capaci-
tances, and like other state variables they need to be initialized with a starting

137



4 themal Modeling

138

value. For this purpose the Thermal Capacitor (see page 728) and other com-
ponents that implicitly contain thermal capacitances have a parameter Initial
temperature that allows you to specify this starting value.

However, you can also let PLECS calculate the initial value for you based on
other temperatures in the thermal system. To do so, simply leave the parame-
ter blank or enter nan (a floating point constant standing for “Not A Number”).
At the beginning of a simulation, PLECS will perform a “DC analysis”, treat-
ing thermal capacitances with known initial values like constant temperature
sources and calculating the unknown initial values such that the system would
be in steady state.

As an example, consider the following thermal system consisting of a constant
temperature source and three thermal R/C pairs. If you leave the Initial tem-
perature parameter of the three capacitances blank, all three will “inherit”

the starting temperature from the source. On the other hand, if you leave only
the parameters of the first two capacitances blank and specify an initial value
of 125 for the third one, PLECS will initialize the first capacitance with 7Ty =
25+(125—25)- 53— = 45 and the second one with Ty = 25+ (125—-25)- 5353 = 75.
Of course, as soon as the simulation starts, the temperatures in all three capac-
itances will eventually drop to the temperature of the source.
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Thermal Description Parameter

Thermal Description Parameter

Most semiconductor components in PLECS have a parameter Thermal de-
scription. Also, masked subsystems can have mask parameter of type Ther-
mal (see “Mask Dialog” on page 76). Thermal parameters can be used in two
ways:

¢ to select a data sheet from the thermal library or

* to assign the value of a reference variable that is defined e.g. as a thermal
mask parameter or in the base workspace.

Selecting Thermal Data Sheets

To select a data sheet from the thermal library, choose the menu entry From
library.... This will open a submenu that shows all data sheets that match the
device type; e.g. in the dialog box of a thyristor only those data sheets appear
that have their Type field set to Thyristor.

Cn-resistance Raon:

f0.247 r

Thermal description:

’Infineon,l'SDPMSﬁD | s ~ |

Initial kemperature; From library, .. ABE 3

| T_init By reference Fairchid  *

| Edit. . Semikron ¥

Zancel Apply
Mew thermal description. .. |

Selecting a data sheet from a thermal library

Ok,

If no data sheet is available, the menu entry is disabled. See section “Thermal
Library” (on page 140) for more information on how to create new data sheets.

Using Reference Variables
To use a reference variable in the Thermal description parameter, select the

menu entry By reference from the parameter menu. Afterwards, the reference
variable can be entered in the text field.
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The reference variable can be the variable name of a Thermal mask parameter
in the mask definition of a parent Subsystem (see “Mask Dialog” on page 76).

The reference variable can also be a string specifying a thermal description file.
The string must begin with file: followed by the file path of the data sheet. It
is possible to use an absolute file path to a thermal description file including the
.xml extension, for example:

thLosses = 'file:C:\Thermal\Vendor\mydiode.xml'

Alternatively, the name of a data sheet from the thermal library can be speci-
fied. In this case the data sheet must be on the thermal search path. Its name
must be provided as a relative path without the .xml extension, for example:

thLosses = 'file:Vendor/mydiode'

Thermal Library

PLECS uses a library of thermal data sheets for semiconductors. The data
sheets of the thermal library are created and edited with the thermal editor
(see “Thermal Editor” on page 142). By separating the thermal descriptions of
semiconductors from their electrical behavior it is possible to use specific pa-
rameters from semiconductor manufactures for thermal simulations in conjunc-
tion with the generic electrical switch models from PLECS.

Library Structure

PLECS uses directory names to hierarchically organize the data sheets in the
thermal library. The reference to a data sheet consists of its relative path and
its filename starting from the directories on the thermal search path.

The search path for thermal libraries is specified in the PLECS preferences (see
section “Configuring PLECS” (on page 124)). Each search path entry is the root
directory for a library tree. On program startup PLECS searches each root di-
rectory in the search path recursively for .xml files and merges the available de-
scriptions into one logical structure. The accessible data sheets can be updated
manually by pressing the Rescan button in the PLECS preferences window. If
a new data sheet is created and saved below a directory which is already on the
search path, the library is updated automatically.

A common way to organize data sheets within a thermal library is to use the
manufacturer name as the first directory level and the part number as the file-
name of the data sheet.
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Global and Local Data Sheets

In addition to the global library search paths specified in the Preferences win-
dow PLECS searches a private directory for each model. This allows for shar-
ing models with other users without the need to synchronize the whole ther-
mal library. The private directory is located in the same directory as the model
file. Its name is the name of the model file (without the .md1 or .plecs exten-
sion) plus a suffix plecs, e.g. p1SMPS_CCM_plecs for model p1SMPS_CCM.md1l
(p1SMPS_CCM.plecs).

If a library file with the same relative path is found both in the global and the
local library, the file from the local library is used.

Creating New Data Sheets

To create a new thermal data sheet, choose Thermal description... or Ther-
mal package description... from the New... submenu of the File menu.

The data sheet should be saved on the thermal search path, otherwise it will
not be added to the thermal library and cannot be accessed.

Browsing the Thermal Library

PLECS allows for browsing the thermal library with the Thermal library
browser. It is invoked from the Window menu.

The tree view on the left shows all local and global data sheets of the thermal
library for the current model.
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Thermal Editor

The Thermal Editor is used for creating, viewing and editing thermal data
sheets. To create a new data sheet, choose Thermal description... or Ther-
mal package description... from the New... submenu of the File menu. In
order to access the data sheet in a PLECS model, you must save it in a direc-
tory on the thermal search path. See section “Thermal Library” (on page 140)
for details of the structure of the thermal library.

Existing library data sheets can be edited either in the Thermal library
browser (accessible from the Window menu) or by assigning a data sheet to
a semiconductor in the Thermal description parameter and then selecting
the menu entry Edit....

M C/PLECS/Thermal/Infineon/SPP20N60C3.xml ﬂ

File Edit View
Manufacturer: Part number: Type:
|infineon |sPp20ms0C3 |MosFET =l

Turn-on loss | Turn-off loss | Conduction loss | Therm. impedance | Variables I Custom tables | Cornmentl

Computation method: ILookup table ;I

™ Invert voltage axis Energy scale: ||.|J 'I /

25°
0A 3A 68A | 9A 13 A
oV opl 0pd apl opl 0pd
190 V 0yl 1.75p] 3.25p] S5pl 11pd
380V oyl 3.5p] 6.5u] 10 2213

oK I Cancel Save Help
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The top row of the Thermal Editor window shows three input elements:

Manufacturer, Part number These text fields are for documentation pur-
poses only.

Type This string is used by the Thermal Description parameter of semi-
conductor devices and thermal mask parameters to filter matching thermal de-
scriptions (see “Selecting Thermal Data Sheets” on page 139).

Thermal Description for a Single Device

When you edit the thermal description of a single device, the editor shows the
following tabs:

Turn-on loss, Turn-off loss, Conduction loss On these tabs you define the
switching and conduction losses of the device. See “Editing Switching Losses”
(on page 143) and “Editing Conduction Losses” (on page 144).

Therm. impedance On this tab you define the thermal impedance between
the junction and the case of the device. See “Editing the Thermal Equivalent
Circuit” (on page 145).

Constants On this tab you define custom constants that can be used in the
loss formulae for switching and conduction losses.

Variables On this tab you define custom variables that can be used in the
loss formulae for switching and conduction losses. Custom variables can be
edited in the parameter dialog of the component using the thermal description
(see “Specifying custom variable values” on page 147). On this tab you can also
specify hard limits both for your custom variables and for intrinsic variables,
i.e. the blocking voltage, the device current and the junction temperature.

Custom tables On this tab you define custom lookup tables that may be used
to define device losses.

Comment This tab provides you with a text field that you may use for docu-
mentation purposes.

Editing Switching Losses

Switching losses are defined on the Turn-on loss and Turn-off loss tabs. The
Computation method popup specifies whether the loss function is defined as
a 3D lookup table, a functional expression or a combination of both.

If you select Lookup table, the pane below will show a 3D lookup table with
the blocking voltage, the device current and the junction temperature as input
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variables. For more information regarding lookup tables see “Editing Lookup
Tables” (on page 148).

If you select Formula, the pane below will show a text field that allows you to
enter a functional expression. A formula may consist of numerical constants
including pi, arithmetic operators (+ - * / "), mathematical functions (abs,
acos, asin, atan, atan2, cos, cosh, exp, log, 1og10, max, min, mod, pow, sgn, sin,
sinh, sqrt, tan, and tanh), brackets and the function arguments. The default
function arguments are the blocking voltage v, the device current i and the
junction temperature T. You may define additional function arguments on the
Variables tab (see “Adding Custom Variables” on page 146. You may also ref-
erence custom lookup tables using the function lookup (see “Adding Custom
Lookup Tables” on page 148).

If you select Lookup table and formula, the pane below will show both
lookup table and formula field. With this method, an energy E is first computed
from the lookup table and may then be used in the formula to calculate the final
loss energy value. For instance, in order to quickly increase the switching loss
by 20 %, you could enter 1.2*E into the formula field.

Editing Conduction Losses

Conduction losses are defined by means of the on-state voltage drop on the
Conduction loss tab. The Computation method popup specifies whether
the voltage drop is defined as a 2D lookup table, a functional expression or a
combination of both.

If you select Lookup table, the pane below will show a 2D lookup table with
the device current and the junction temperature as input variables. For more
information regarding lookup tables see “Editing Lookup Tables” (on page 148).
On using the import wizard for constructing lookup table data from vendor
plots, see “Import data from plot images” (on page 155).

If you select, Formula, the pane below will show a text field that allows you
to enter a functional expression. The default function arguments are the de-
vice current i and the junction temperature T. You may define additional func-
tion arguments on the Variables tab (see “Adding Custom Variables” on page
146. You may also reference custom lookup tables using the function lookup
(see “Adding Custom Lookup Tables” on page 148).

If you select Lookup table and formula, the pane below will show both
lookup table and formula field. With this method, a voltage v is first computed
from the lookup table and may then be used in the formula to calculate the final
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voltage drop value. For instance, in order to quickly increase the voltage drop
by 20 %, you could enter 1.2*v into the formula field.

Gate Dependent Conduction Losses

A MOSFET can conduct current in both directions, and so the conduction losses
of a MOSFET with integrated anti-parallel diode depend on the gate signal
when the current flows in reverse direction. To account for this effect, you can
provide two separate conduction loss definitions, one of which is used when the
gate signal is non-zero, and the other, when the gate signal is zero.

To create separate tabs that define the conduction losses with respect to the
gate signal, select the MOSFET with Diode device type, right-click on the
tab bar and select Use gate dependent conduction losses from the context
menu.

Editing the Thermal Equivalent Circuit

The thermal equivalent circuit of a component describes its physical structure
in terms of thermal transitions from the junction to the case. Each transition
consists of a thermal resistor and a thermal capacitor. They can be edited on
the Therm. impedance tab of the thermal editor. The thermal equivalent cir-
cuit is specified either in Cauer or Foster form.

The structure of a Cauer network is shown in the figure below. In the thermal
editor the number of chain elements n and the values for R; in (K/W) and C; in
(J/K) for each chain element need to be entered.

? R1 R2 Rn Case
L f F—ﬂ".DtI:4 F—f
ﬁ + c1 + +

:I: :1: Cc2 :1: Cn

Caver network

Junction

The figure below illustrates the structure of a Foster network. In the thermal
editor the number of chain elements n and the values for R; in (K/W) and 7; in
(s) for each chain element need to be entered. Foster networks can be converted
to Cauer networks by pressing the button Convert to Cauer.
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Rn

Case
o... +

Tn/Rn

T1/R1 T2/R2

Junction

Foster network

Note Internally, PLECS always uses the Cauer network to calculate the ther-
mal transitions. Foster networks are converted to Cauer networks at simula-
tion start. Strictly speaking, this conversion is only accurate if the temperature
at the outer end of the network, i.e. the case, is held constant. For practical pur-
poses the conversion should yield accurate results if the external thermal ca-
pacitance is much bigger than the capacitances within the network.

Adding Custom Variables

Custom variables, such as gate resistance or stray inductance, that you wish to
use in the definition of device losses may be defined on the Variables tab.

‘4 C:/PLECS/Thermal/Example {IGBT.xml ﬂ
File

Manufacturer: Part number: Type:

IExampIe IExampIe IGET I IGET LI

Turn-onloss | Turn-offloss Conduction loss I Therm. impedance Variables | Custom tables Commentl

ll Prompt Variable | Min | Max
_:JE e iy
Device current i
1' Junction temperature T 150
Gate resistance Rg
LI Stray inductance Lsigma

oK I Cancel | Save | Help |

Use the Add +, Remove —, Up 4 and Down & buttons on the left to add or
remove custom variables or to reorder them. Note that the first three lines in
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the list are reserved for the intrinsic variables and may not be removed or re-
ordered.

A custom variable is defined by a Prompt, which should provide a brief de-
scription of the purpose of the variable, and a Variable, which must be a
unique identifier. This identifier may then be used in the formula expressions
that define the device losses. You may specify a Default value that is used if
the end user of the thermal description does not provide a value.

In the Min and Max columns you may enter minimum and maximum allowed
values for both intrinsic and custom variables. During a simulation, PLECS
will monitor the actual values of the variables and raise a diagnostic message
if a variable value exceeds a specified limit. The default action is to show an er-
ror and stop the simulation but this may be changed in the simulation parame-
ters dialog using the diagnostic parameter Loss variable limit exceeded (see
“PLECS Blockset Parameters” on page 111 and “PLECS Standalone Parame-
ters” on page 111).

Specifying custom variable values

When you select a thermal description with custom variables on the Thermal
tab of a semiconductor parameter dialog, the dialog will show additional pa-
rameter fields for the custom variables using the prompts mentioned above. An
example dialog is shown below.

x

IGET
The IGET is dosed while & non-zero gate signal is applied. The
device can conduct current only from collector to emitter,

Parameters  Thermal | Asserﬁonsl

Thermal description:

|Therma|,|'ExampleﬂGBT - < |
Gate resistance:

|7

Stray inductance:

| 7509

Initial temperature:

Jo I~

oK I Cancel Apply Help

147



4 themal Modeling

Instead of static values that remain constant during a simulation you may also
specify the label of a Signal Goto block (see page 670) for a custom variable.
The label is a string consisting of a prefix for the scope (g: for global, s: for
schematic and m: for masked subsystem) and the tag name of the Goto block.
For example, if your model contains a Goto block with global scope and the tag
name Rg, you would enter 'g:Rg’ (including the quotation marks) in order to
reference this signal in a custom variable of a thermal description. This can be
used e.g. to simulate the effect of a gate drive that can dynamically change the
effective gate resistance.

Adding Custom Lookup Tables

Custom lookup tables are defined on the Custom tables tab. To add a new ta-
ble, click on New... and specify a unique name and the number of dimensions of
the new table. Use the Duplicate..., Rename... and Remove buttons to dupli-
cate, rename or remove an existing custom table.

Custom tables can be used in function expressions for device losses using the
lookup function, which is called with a string specifying custom table name and
one to three numeric arguments depending on the number of dimensions of the
table.

For example, consider that you have defined a custom variable Rg for the gate
resistance and a custom table Gate Resistance Eon Scaler that describes
how the turn-on losses scale in terms of the gate resistance. You could then use
the Lookup table and formula method on the Turn-on loss tab, specify the
nominal losses in the turn-on-loss lookup table and enter the following function
expression:

E*lookup('Gate Resistance Eon Scaler', RQ)

Editing Lookup Tables

When editing an intrinsic lookup table on one of the three loss tabs or a cus-
tom lookup table, you can add and remove new interpolation points for a table
dimension with the Edit menu or the context menu in the table. To enter mul-
tiple values at once, separate them by semicolons or spaces.

To rotate and tilt a three-dimensional table view, click on an empty space with
the left mouse button and drag the mouse while keeping the mouse button
pressed.
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Lookup method

When calculating function values from a lookup table, PLECS uses linear in-
terpolation if an input value lies within the index range for the corresponding
table dimension. If the input value lies outside the index range, PLECS will ex-
trapolate using the first or last pair of index values.

Copy, Paste and Scaling

Thermal data can be copied and pasted within the tables of the thermal editor,
and to or from other programs, like e.g. Microsoft Excel. This can be done using
the context menu or by pressing Ctrl-C/Ctrl-V (or cmd-C/ecmd-V on macOS).
To specify the target location for the data, you have to select a part of the table
that has the same number of rows and columns as the copied data. When copy-
ing from another program, only the first correctly formatted number in each ta-
ble cell will be copied, any additional information (e.g. units) will be discarded.

Values selected in a table can be scaled by a given factor by right-clicking and
choosing Scale selected values... from the context menu. To convert a value
from 0.23 J to 0.23mJ, e.g., you can scale it with a factor of 0.001. To only change
the unit but not the actual value, i.e. to change 0.23 J to 230 J, use the Energy
scale drop box at the top right.
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Thermal Package Description

A thermal package description is used to describe the thermal behavior of a
power module that consists of multiple semiconductor chips. It contains the loss
descriptions of the individual semiconductors as well as a structural model of
the thermal coupling between the semiconductors and the package case.

The concept is illustrated using the example of a T-type inverter module shown
in the schematic below.

1%

(-,
[ IGBT_HILO-17Y D_HILO-1
X X
IGBT_MID-2] [IGBT_MID-3
(-, ()
D_MID-2 D_MID-3
Al IGBT_HILO-47X D_HILO-4
(-,

Thermal Package
Impedance

The module contains two different types of IGBTs and two different types of
diodes because the high-side and low-side semiconductors (1 and 4) need to
block higher voltages than the mid-point semiconductors (2 and 3). The pack-
age description therefore needs to contain four semiconductor device descrip-
tions and a thermal model for the coupling between eight semiconductors and
the module case.

When you edit a thermal package description, the editor shows the following
tabs:

Device Types On this tab you define the different semiconductor types that
the package contains. The left hand side shows the list of device types, the
right hand side shows tabs to define the switching and conduction losses and
the thermal impedances of the individual device types. Each device type has a
name filter that is used to associate the thermal description for this device type
with the individual components in the module.
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For the example module, the thermal package description would contain
four device types with name filters IGBT _HILO-*, IGBT _MID-*,D HILO-* and
D_MID-* as shown in the screenshot below.

o o

X

Edit View File

Part: Example Type: LTType v

ce  Comstants  Varisbles  CustomTables  Comment

Device Types
IGBT_HILO-* (1GET)
1GBT_MID-* (1GE)
D_HILO-* (Diode) -
D_MID-* (Diode) (O tnvert voltage axis ~ Energy scale: 3

EQ] )
04

i [A]

Thermal Impedance On this tab you define the thermal impedance between
the individual semiconductor devices and the case of the package. This defini-
tion considers devices to be heat sources, the case to be a temperature source
and the impedance to be an LTI system with or without internal states.

The heating of an IGBT or diode device inside the T-type inverter module not
only increases the temperature directly at the heat source device but also
causes the temperature of all other devices to rise. A straightforward way to de-
scribe such thermal coupling effects is to model the temperature rise of one de-
vice by summing the individual contributions to that temperature rise from all
the heat sources contained in the package. For the eight devices of the T-type

inverter module such a thermal linear superposition model can be formulated in
matrix notation as

ATigBT HILO-1 Zin Zip - Zig Q1GBT HILO-1
ATh HILO-1 Zs1 Zso -+ Zag Qp_A1L0-1
ATh HILO-4 Zg1 Zgo - Zgg Qp_HI1LO-4

A single component of the impedance matrix describes a thermal impedance
that relates a heating power to a temperature difference. For example, heating
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up the second device with the heating power Qp mro.1 contributes also to in-
creasing the temperature difference ATiger HiLo-1 = 71GBT HILO-1 — Lcase Of the
first device, which is captured in the transient thermal impedance Z; »(¢). In
PLECS, Z; »(t) is described by a Foster or Cauer thermal chain that can be de-
fined by clicking on a matrix element and setting type, number of elements and
chain parameters as exemplified below.

o c ¥ X
Edit  View File

1GBT_HILO-1 D_HILO-1 1GBT_MID-2 D_MID-2 1GET_MID-3 D_MID-3 1GBT_HILO-4 D_HILO-4
IGBT_HILO-1 0 z; 0 0 0 0
D_HILO-1

1GET_MID-2

D_MID-2

D_MID-2

IGBT_HILO-4

0
0
0
1GET_MID-3 0
0
0
0

D_HILO-4

“Thermal impedance: IGET_HILO-1 (measured), D_HILO-1 (hested)

Type: Foster v Number of lements: 1 7

1
R TR,

15

eeeeeeeeeeeee

From the provided impedance matrix, PLECS will then transform all thermal
chains to the Cauer type and generate the matrices of a state-space model

x = Ax+ Bu
y = Cx+ Du

where u is a vector comprising the device heat sources and case temperature
source(s), y is a vector of the same length comprising the device temperatures
and the heat flow out of the case and x is the vector of internal states.

The corresponding numerical representation of the state-space model can be
displayed by clicking on the Edit State-Space Matrices... button at the bot-
tom right. In the window shown below, it is then possible not only to view the
generated state-space matrices, but also to make changes to them that go be-
yond the linear superposition model. On the left-hand side you specify the num-
ber of internal states, the number of devices in the package, the width of the
case connection and the device names which must match the names of the ac-
tual devices in the module subsystem. On the right-hand side you enter the
numerical values of the state-space matrices. Note that direct changes made
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pppppppppp Type: ATType v
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o
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to the state-space matrices are not converted back to the thermal impedance
matrix when you return to the linear superposition model by clicking the Edit
Impedance Matrix... button at the bottom right.

Constants, Variables, Custom tables, Comment Constants, variables and
custom tables are shared by all device types in a package description. Please
see section “Thermal Description for a Single Device” (on page 143) for a de-
scription of these tabs.

Using a Thermal Package Description

A thermal package description is typically used in conjunction with a masked
subsystem that defines the electrical behavior of the module. The subsystem
mask defines a Thermal parameter with a Device type filter that matches
the type of the thermal package description (see also “Mask Dialog” on page
76).

The mask variable that is associated with this thermal parameter (here:
thermal) is then referenced as is in the Thermal description parameters of
the individual semiconductor devices in the subsystem. The component names
(e.g. IGBT_HILO-1 or IGBT_HILO-4) are matched against the name filters (e.g.
IGBT_HILO-*) to extract the appropriate loss definitions and thermal impedance
for the semiconductor device.

The thermal impedance between the devices and the module case is modeled by
the Thermal Package Impedance component (see page 733) that is placed on top
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2] Mask Editor: Example/3-Level T-Type Module x

Icon Dialog Initialization Probes Documentation

Dialog parameters:

+ Prompt Variable Tab Type Tunable
= | Thermal Description  thermal Thermal
t
L 2
Dialog callback: Device type filter:
1 IL-T-Type

Unmask Cancel Apply Help

of the semiconductor devices similar to a heat sink. This component also has
a parameter Thermal description that expects the thermal mask variable
thermal to extract the definition of the thermal network from it.

This is illustrated in the following figure.

[ Block Parameters: Example/3-Level T-Type Module... [ Block Parameters: Example/3-Level T-Type Module..
IGBT Thermal Package Impedance
The IGET is dosed while a non-zero gate signal is applied. The Model thermal coupling in a semiconductor package.
device can conduct current only from collector to emitter.
Parameters

Parameters Thermal Assertions Mumber of terminals:

Thermal description: | 1 “:‘

|ﬁ1ermal| | hd Thermal description:

Custom variables: |ﬂ1ermal| ||:|
| Initial temperature:

Thermal inter face resistance: | ||:|

o I

Initial temperature:

Cancel Apply Help Cancel Apply Help
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Importing Data from Graphical Datasheets

PLECS provides an Import Wizard that facilitates the import of data from
graphs that are typically used on real datasheets. The wizard is opened by

clicking on the magic wand icon (# ) that appears in the top right corner of any
page that allows you to enter tabular data, i.e. the loss and custom tables and
the thermal impedance.

*| PLECS ﬂ

File | Edit View
Manufacturer: Part number: Type:
| | | =
Turn-on loss | Turn-off loss | Conduction loss | Therm. impedance | Variables I 1
Computation method: ILookup table ;I PLECS ﬂ
: = oS @ —X-Axis [A
Energy scale: IJ 'l /|M|Import1 'l/ ° ||ﬁ|}9 }:) }—) s [A]
X-min: IO
[
AT T 1 ¥max: [ 1600
41 T I E.,,
s i Snap: |1'I"I' QI
30 / Scale: IIinear vI
25 ! - )
= Enrl | | FY-Axs )] —————
'E =0 | /-/ / Y-min: I[J
w
15 J -
- -miax: |4
10 = Scale: Ilinear 'I
o5 el .
o1l |11 —Plotimage
00 - + + Opactyy ~—————_|
padity:
0y, 40 800 124500 o 1600
L[4 Crientation: Mirror axes |
25° |
400 A 200 A 300 A I 1000 A
ov v 0.55666 1 0.890241] 131811 181671
4I |»

oK I Cancel | Save | Help |

When you open the import wizard for the first time on a particular page, you
are requested to provide a graph image. To import an image, drag a image file
to the empty wizard area or click on the appropriate underlined text to open a
file browser that lets you choose an image file. Image files must have a bitmap
file format (PNG, GIF, BMP, JPG or XPM). To import graphs from a PDF file,
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take a snapshot of the desired graph, then select Paste from the Edit menu
of the editor window or press Ctrl-V (cmd-V on macOS) to paste the snapshot
into the wizard.

After the image has been imported, a green coordinate system is drawn on top
of it. Your first task should be to align the green axes with the coordinate sys-
tem in the image. You can move an axis or change its length by dragging the
axis itself or its end point with the mouse.

Ensure that the axes have the proper dimensions. For turn-on and turn-off
losses, the x-axis is expected to be in amperes (A) and the y-axis, in joules (J);
for conduction losses, the x-axis is expected to be in amperes (A) and the y-axis,
in volts (V). If the dimensions in the image are swapped, you can flip the image
by clicking on the Mirror axes button in the image configuration dialog (see
below).

Configuring the Graph Import

After you have aligned the green coordinate system, you need to enter the axis
limits into the configuration dialog that has opened automatically when the im-
age was imported. If you have closed the dialog, you can open it again by click-

ing on the [=] button in the wizard toolbar or on one of the green axis limit la-
bels.

In addition to the minimum and maximum settings, the x-axis has a Snap
property that is initialized automatically from the axis limits. You can override
the snap value by entering a number here; entering 0 disables snapping. To re-
store the automatically calculated value, click on the f button.

Both the x-axis and y-axis have a Scale property that lets you choose between a
linear and logarithmic scale. By default, double-logarithmic scaling is used for
thermal impedances only; for all other imports the scaling defaults to linear.

The Opacity slider lets you change the opacity of the graph image from fully
transparent (or invisible) to fully opaque. The Mirror axes button will mirror
the graph image diagonally so that the two axes are exchanged. This is useful
e.g. when importing conduction losses where the graph typically shows Volts on
the x-axis and Amperes on the y-axis.

Adding and Moving Points

Points are added by double-clicking anywhere in the coordinate system. If snap-
ping is enabled, the x-value is adjusted to the nearest snap value. To move
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points, drag them with the left mouse button. If snapping is enabled, you can
temporarily disable it by pressing and holding the Shift key when you click on
a point.

To add new curves (e.g. for another temperature value) use the corresponding
entry from the Edit menu or from the context menu of the table at the bottom
of the editor. If there is more than one curve, a double-click will add new points
to all curves: The point at the mouse location is added to the current curve, i.e.
the curve that you added or interacted with most recently. For all other curves,
points are added based on their neighboring points’ coordinates.

Also, if there is more than one curve, the movement of points is restricted to
the y-direction. The reason for this is that all curves in the look-up table share
the same x-values, so changing the x-value of a point in one curve will affect all
other curves as well. You can temporarily override this restriction by pressing
and holding the Shift key when you click on a point.

Zooming and Panning

You can zoom into the graph for more precise placement of points and axes.
Zooming is controlled via the View menu and the corresponding buttons in the
toolbar. You can also zoom in and out by holding the Ctrl key (Cmd key on ma-
cOS) while rolling the mouse wheel. When you have zoomed into the graph, you
can pan the image using the sliders or by holding the Ctrl or Cmd key while
pressing and dragging the left mouse button. Pressing the spacebar will zoom
the graph to fit the window.

Adding and Managing Graph Images

Sometimes, the curves for one look-up table come from different graphs. To add

a new graph image to the wizard, click the = button in the toolbar. To change
the visibility of a particular curve on the current graph, use the check box in

the corresponding row header in the table at the bottom. Press the . " button
in the toolbar to rename the current graph; graph names are used purely for

documentation purposes. To remove a graph (but not the curves), press the &
button.

Fitting Thermal Impedances

When a vendor datasheet provides the thermal impedance as a heating curve
rather than Foster or Cauer network coefficients, you can use the import wizard
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to fit Foster coefficients to a given heating curve. First, import the graph of the
heating curve as described above and place a number of points on the heating
curve, then choose the desired number of Foster elements. As a general rule,
you must place at least two points per Foster element. As soon as these require-
ments are met, PLECS will calculate a set of Foster coefficients and display the
result as an orange curve on top of the graph.

H| PLECS ﬂ

File Edit View
Manufacturer: Part number: Type:
| | | =
Turn-on loss | Turn-off loss | Conduction loss ~ Therm. impedance | Variahles | Custom table 4| #
Type: IFosher 'l Number of elements: |3 3 / | ° ||ﬁ) | }f) }9 }3
L]
DRES
0.1
et Dot I
& L .
g nor __.H/__f' Zyq1GETE
£ i
c L Rl
E o0t
w
0.0001
a.0001 -
gty TR 1&[;] 1 ®
i 2 3
R 0.001137 KW 0.002528 K/w 0.009303 Kfw
T 0.001717 s 00179 s 0.1973s
Mean squared error; 1,2693%-8  Recalculate | Accept |

Cancel | Save | Help |

[ o |

PLECS uses a non-deterministic optimization algorithm to minimize the error
between the calculated curve and the points that you have placed. This algo-
rithm may not converge at all or converge at a local instead of the global mini-
mum. If the current fit is not satisfactory, you can calculate a new one by press-
ing the Recalculate button. Once the results are acceptable, press the Accept
button to close the wizard and transfer the calculated Foster values.
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Note The fitting algorithm can handle only single pulse curves. Vendor
datasheets sometimes also show heating curves for repeated pulses with dif-
ferent duty cycles; these curves cannot be used to calculate Foster coefficients
with PLECS.

If the fitting algorithm repeatedly does not find a satisfactory solution, you may
need to increase the number of Foster elements. Typically, three to five Foster
elements should yield good results.
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Semiconductor Loss Specification

Care must be taken to ensure the polarity of the currents and voltages are cor-
rect when specifying conduction and switching loss data for semiconductor
switches and diodes. If one or both polarities are in the wrong direction, the
losses will be zero or incorrect. The voltage and current polarities of a single
semiconductor switch, diode and semiconductor switch with diode are defined in
PLECS as shown in the figure below.

Qs

Voltage and current polarity of single semiconductor switch, diode and semi-
conductor switch with diode

Single Semiconductor Switch Losses

The blocking voltage experienced by a single semiconductor switch is positive;
therefore, switching losses are defined in the positive voltage/positive current
region. Conduction losses are also defined in the positive voltage/positive cur-
rent region.

Diode Losses

The voltage and current waveforms during a typical diode switching cycle are
shown in the next figure. Turn on losses occur at t = ¢; and turn off losses at

t = to. The switching energy loss in both cases is calculated by PLECS using
the negative blocking voltage and positive conducting current at the switching
instant. These values are shown in the figure as dots. Therefore, the lookup ta-
bles for the turn-on and turn-off switching losses must be specified in the nega-
tive voltage/positive current region.

Conduction losses occur when ¢; < ¢t < t. During this time period, the cur-
rent and voltage are both positive. Therefore the conduction loss profile must be
specified in the positive voltage/positive current region.



Semiconductor Loss Specification

I diode

/\

e

Vdiode

Diode voltage and current during switching

Losses of Semiconductor Switch with Diode

Semiconductor switches with an integrated diode such as the IGBT with Diode
model allow losses for both the semiconductor switch and diode to be individ-
ually specified using a single set of lookup tables. The conduction and switch-
ing loss tables for the semiconductor switch are specified for the same volt-
age/current regions as for the single semiconductor switch without diode. Due
to the polarity reversal of the diode, the diode losses are appended to the loss
tables of the semiconductor switch by extending the tables in the negative volt-
age/negative current direction for the diode conduction losses, and in the pos-
itive voltage/negative current direction for the diode switching losses. An ex-
ample turn-off loss table and conduction loss profile for a semiconductor switch
with diode are shown in the next two figures. A summary of the valid voltage
and current regions for defining conduction and switching losses for the differ-
ent types of semiconductors is given below:

Switch with Diode

Diode Switch
Switch Diode

\Y% I A% I \Y I v I

Conduction Loss + + + + + + - -

Switching Loss - + + + + + + -
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Diode turn-off losses Switch turn-off losses

\
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Turn-off loss lookup table for semiconductor switch with diode

1.5 Switch conduction profile
1
] — |
0.5 /
Von[V]
DiOde /
0 conduction profile
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-5 -2 -1 0 1 - - |
ionlA]

Conduction loss profile for semiconductor switch with diode



Magnetic Modeling

Inductors and transformers are key components in modern power electronic cir-
cuits. Compared to other passive components they are rather difficult to model
for the following reasons:

¢ Magnetic components, especially transformers with multiple windings can
have complex geometric structures. The flux in the magnetic core may be
split into several paths with different magnetic properties. In addition to the
core flux, each winding has its own leakage flux.

¢ Core materials such as iron alloy and ferrite express a highly non-linear be-
havior. At high flux densities, the core material saturates leading to a greatly
reduced inductor impedance. Moreover, hysteresis effects and eddy currents
cause frequency-depending losses.

In PLECS, the user can build complex magnetic components in a special mag-
netic circuit domain. Primitives such as windings, cores and air gaps are pro-
vided in the Magnetics Library. The available core models include saturation
and hysteresis. Frequency dependent losses can be modeled with magnetic re-
sistances. Windings form the interface between the electrical and the magnetic
domain.

Alternatively, less complex magnetic components such as saturable inductors
and single-phase transformers can be modeled directly in the electrical domain.

Equivalent circuits for magnetic components

To model complex magnetic structures with equivalent circuits, three different
approaches exist: Coupled-inductors, the resistance-reluctance analogy and the
capacitance-permeance analogy.



5 Magnetic Modeling

164

Coupled inductors

In the coupled inductor approach, the magnetic component is modeled directly
in the electrical domain as an equivalent circuit, in which inductances repre-
sent magnetic flux paths and losses incur at resistors. Magnetic coupling be-
tween windings is realized either with mutual inductances or with ideal trans-
formers.

Using coupled inductors, magnetic components can be implemented in any cir-
cuit simulator since only electrical components are required. This approach

is most commonly used for representing standard magnetic components such
as transformers. The figure below shows an example for a two-winding trans-
former, where L,; and L, represent the leakage inductances, L,, the non-
linear magnetizing inductance and Ry the iron losses. The copper resistances
of the windings are modeled with R; and R.

R1 Lol Lo2 R2
C O—
Lm Ideal Transformer
N1:N2
- O

Transformer implementation with coupled inductors

However, the equivalent circuit bears little resemblance to the physical struc-
ture of the magnetic component. For example, parallel flux paths in the mag-
netic structure are modeled with series inductances in the equivalent circuit.
For non-trivial magnetic components such as multiple-winding transformers or
integrated magnetic components, the equivalent circuit can be difficult to derive
and understand. In addition, equivalent circuits based on inductors are impos-
sible to derive for non-planar magnetic components.

Reluctance-resistance analogy

The traditional approach to model magnetic structures with equivalent elec-
trical circuits is the reluctance-resistance analogy. The magnetomotive force
(MMF) F is regarded as analogous to voltage and the magnetic flux ® as analo-
gous to current. As a consequence, magnetic reluctance of the flux path R corre-
sponds to electrical resistance:



Equivalent circuits for magnetic components

f
R=3

The magnetic circuit is simple to derive from the core geometry: Each section of
the flux path is represented by a reluctance and each winding becomes an MMF
source.

To link the external electrical circuit with the magnetic circuit, a magnetic in-
terface is required. The magnetic interface represents a winding and estab-
lishes a relationship between flux and MMF in the magnetic circuit and voltage
v and current : at the electrical ports:

4d
:Ni
v i

i=—
N
where N is the number of turns. If the magnetic interface is implemented with
an integrator, it can be solved by an ODE solver for ordinary differential equa-
tions:

@:%/vdt

The schematic below outlines a possible implementation of the magnetic inter-
face in PLECS.

K:1/N

Implementation of magnetic interface

Although the reluctance-resistance duality may appear natural and is widely
accepted, it is an awkward choice for multiple reasons:

¢ Physically, energy is stored in the magnetic field of a volume unit. In a mag-
netic circuit model with lumped elements, the reluctances should therefore
be storage components. However, with the traditional choice of mmf and
flux as magnetic system variables, reluctances are modeled as resistors, i.e.
components that would usually dissipate energy. It is also confusing that the
magnetic interface is a storage component.
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* To model energy dissipation in the core material, inductors must be em-
ployed in the magnetic circuit, which is even less intuitive.

* Magnetic circuits with non-linear reluctances generate differential-algebraic
equations (DAE) resp. algebraic loops that cannot be solved with the ODE
solvers offered in PLECS.

¢ The use of magnetic interfaces results in very stiff system equations for
closely coupled windings.

Permeance-capacitance analogy

To avoid the drawbacks of the reluctance-resistance analogy the alternative
permeance-capacitance analogy is most appropriate. Here, the MMF F is again
the across-quantity (analogous to voltage), while the rate-of-change of magnetic
flux ® is the through-quantity (analogous to current). With this choice of sys-
tem variables, magnetic permeance P corresponds to capacitance:

dF

dt

Hence it is convenient to use permeance P instead of the reciprocal reluctance
R to model flux path elements. Because permeance is modeled with storage
components, the energy relationship between the actual and equivalent mag-
netic circuit is preserved. The permeance value of a volume element is given by:

d="P

_ 1 _ HOMYA
P=R="

where o = 47 x 1077 N/A? is the magnetic constant, x, is the relative perme-
ability of the material, A is the cross-sectional area and [ the length of the flux
path.

Magnetic resistors (analogous to electrical resistors) can be used in the mag-
netic circuit to model losses. They can be connected in series or in parallel to a
permeance component, depending on the nature of the specific loss. The energy
relationship is maintained as the power

-Ploss = F(I)

converted into heat in a magnetic resistor corresponds to the power loss in the
electrical circuit.

Windings form the interface between the electrical and the magnetic domain.
A winding of N turns is described with the equations below. The left-hand side
of the equations refers to the electrical domain, the right-hand side to the mag-
netic domain.



Magnetic Circuit Domain in PLECS

Because a winding converts through-quantities (® resp. i) in one domain into
across-quantities (v resp. F') in the other domain, it can be implemented with
a gyrator, in which N is the gyrator resistance R. The figure below shows the
symbol for a gyrator and a possible implementation in PLECS.

Gyrator symbol and implementation

In principle, the gyrator component could be used with regular capacitors to
build magnetic circuits. However, neither the gyrator symbol nor the capacitor
adequately resemble a winding respectively a flux path. Moreover, any direct
connection between the electrical and magnetic domain made by mistake would
lead to non-causal systems that are very difficult to debug. Therefore, dedicated
magnetic components should be used when modeling magnetic circuits.

Magnetic Circuit Domain in PLECS

The magnetic domain provided in PLECS is based on the permeance-
capacitance analogy. The magnetic library comprises windings, constant and
variable permeances as well as magnetic resistors. By connecting them accord-
ing to the physical structure the user can create equivalent circuits for arbi-
trary magnetic components. The two-winding transformer from above will look
like the schematic below when modeled in the magnetic domain.

P,1 and P,, represent the permeances of the leakage flux path, P,, the non-

linear permeance of the core, and Gy, dissipates the iron losses. The winding
resistances R; and R; are modeled in the electrical domain.
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Transformer implementation in the magnetic domain

Modeling Non-Linear Magnetic Material

Non-linear magnetic material properties such as saturation and hysteresis can
be modeled using the variable permeance component. The permeance is deter-
mined by the signal fed into the input of the component. The flux-rate through
a variable permeance P(t) is governed by the equation:

. d dFr d
o= — . —PpP._ 4+ _P.
dt(P Fy="P dt+dt7)F

Since F is the state variable the equation must be solved for (fi—f. Therefore, the
control signal must provide the values of both P(¢) and £ P(¢).

The control signals must also provide the flux ®(¢) through the permeance.
This enables the solver to enforce Kirchhoff’s current law for all branches k of
a node:

k=1

When specifying the characteristic of a non-linear permeance, we need to dis-
tinguish carefully between the total permeance Py (F') = ®/F and the differen-
tial permeance Py (F) = d®/dF.

If the total permeance Pio (F') is known, the flux-rate $ through a time-varying
permeance is calculated as:



Magnetic Circuit Domain in PLECS

. do
* = w
= & (P F)
= (Ptot_f_d:;’t.}?).g

In this case, the control signal for the variable permeance component is:

P(t) Piot + 45 Prot - F
Ap@) | = 0
(t) Prot - F

In most cases, however, the differential permeance Pqig(F') is provided to char-
acterize magnetic saturation and hysteresis. With

. d®
> = —
dt
@ ar
- dF dt
dF
= 'Pdiff'a ;

the control signal is

'P(t) Paisr
Ap) | = 0
D(t) Piot - F

Saturation Curves for Soft-Magnetic Material

Curve fitting techniques can be employed to model the properties of ferromag-
netic material. As an example, a saturation curve adapted from the modified
Langevian equation for bulk magnetization without interdomain coupling is
used, which is referred to as the coth function:
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B = B, h—— — ot H
sat (COt a 3H> + Hsat
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procedure. Calculating the derivate of B with respect to H yields

@—B <tanh2(H/a)—1 _a> N
A~ 7\ tanb? (Hja)  H?) M

With the relationships ® = B - Aand F' = H - [ the control signal Pg;g for the
variable permeance is easily derived from the equation above.
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Mechanical Modeling

One-dimensional mechanics describe the mechanical interaction between bod-
ies that have exactly one degree of freedom. A translational body (or Mass) can
move along a single axis, and a rotational body (or Inertia) can rotate around

a single axis. With this limitation one-dimensional mechanical systems can be
modeled similarly to electrical systems using simple analogies that are listed in
the following table.

Electrical and Mechanical Analogies

Electrical Translational | Rotational

Voltage Speed Angular speed

Current Force Torque

Capacitor Body (mass) Body (moment of inertia)
Inductor Spring Spring

Resistor Damper Damper

Transformer | Lever Gear

Switch Clutch Clutch




6 Mechanical Modeling

Flanges and Connections

The two mechanical subdomains use separate connectors: a translational
flange ) and a rotational flange t. You can draw connections between flanges of
the same type. By creating branch connections you can connect more than two
flanges. Flanges that are connected to each other have the same displacement
(i.e. position or angle), and the connection will exert whatever force is necessary
in order to maintain this relationship.

Body components (i.e. the translational Mass and the rotational Inertia) have
two rigidly connected flanges so that the two systems shown below are equiva-
lent:

(-[ ° ° ° ]') ml m3
ml m2 m3 m2

Equivalent connections of three translational bodies

Force/Torque Flows and Sign Conventions

172

As the above table of electrical and mechanical analogies suggests, forces or
torques acting on components are modeled as flows from one flange to another.
The direction of a positive flow is indicated either with a dot next to a flange or
with an arrow in the component icon.

Force and torque flows must be balanced, i.e. the sum of all flows towards
a component must generally be zero, but there are two exceptions to this
rule:

¢ Reference components only have a single flange so balancing is not possible
for a single instance. Reference components in fact represent connectors of
a single, global reference frame, and it is the net flow towards this reference
frame that must be zero.

* Body components have an implicit internal connection to the global reference
frame. A positive net flow towards a body causes the body to accelerate in the
positive direction.



Positions and Angles

In this context it is important to note that the positive direction does not neces-
sarily correlate with the graphical orientation of the components. For instance,
the schematic shown below models the equation

F1+F2:m~a

i.e. both forces accelerate the body in the positive direction, even though in the
schematic the two forces might appear to oppose each other.

F1 m F2

Mass and two forces

Positions and Angles

In contrast to other modeling environments, PLECS does not generally use
flange displacements as state variables in the component equations in order to
avoid having to solve Index-2 problems. Instead, absolute or relative displace-
ments are only calculated when required e.g. in a hard-stop component or if you
explicitly measure them using a sensor. The displacements are then calculated
by integrating the corresponding absolute or relative speed.

Initial Conditions

As with all integrators, displacement meters must be provided with proper
initial values. PLECS allows you to specify these initial values directly in the
components that require them or indirectly via neighboring components. For
this purpose, most components have an initial displacement parameter that de-
faults to an empty string, which means "don’t care” or don’t know”.

At simulation start, PLECS will automatically calculate required but unknown
initial values from the values that you have provided. An error will be flagged
if you do not supply enough data to determine required initial values. On the
other hand, an error will also be flagged, if you provide too much and inconsis-
tent data.

The example shown below models a body with mass m that is subject to a grav-
itational force m - g and suspended from a spring. The spring is initially un-
stretched (dzg = 0) but its equilibrium displacement z is not specified.
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x0: .
m-9 dx0: Og x0:
m
x0:

Spring and mass

If the model is run as is, PLECS will flag an error because it does not have
enough data to calculate this equilibrium length and the initial value of the
position sensor. To fix this, you can specify any one of the following three pa-
rameters:

1 the initial value z( of the position sensor
2 the initial position z of the body
3 the equilibrium displacement z; of the spring

Note that you may specify more than one of the above values, but if you do so,
the settings must be consistent.

Angle Wrapping

When calculating angles by integrating angular speed, care must be taken to
avoid numerical problems during longer simulations. For this reason, PLECS
automatically wraps the integral in the interval between —7 and +7 when you
measure an absolute angle with a position sensor that has one flange internally
connected to the rotational reference frame. Note that relative angles — mea-
sured with a position sensor that has two accessible flanges — are not wrapped
because you can wind a torsion spring by more than one turn.

Ideal Clutches
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Analogous to its ideal electrical switches, PLECS features ideal mechanical
clutches that engage and disengage instantaneously. While engaged they make
an ideal rigid connection between their flanges and while disengaged they
transmit zero force (or torque).



Ideal Clutches

Inelastic Collisions

PLECS permits you to connect an ideal clutch between two bodies and engage
the clutch while they move (or rotate) at different speeds. PLECS models such
an event as a perfectly inelastic collision and calculates the common speed after
the collision based on the conservation law of angular momentum so that e.g.

+_ le; + sz;
Ji1+ J2

where J; and .J; are the moments of inertia of the two bodies, w; and w, are
the two angular speeds prior to the collision and w™ is the common angular
speed after the collision.

It is important to note that kinetic energy is lost during an inelastic colli-
sion even though the clutch is ideal and lossless. Assuming for simplicity that
J, = Jo = J sothat wt = %(wf + w; ), the kinetic energy of the system before
and after the collision is for example

E- = %J(wf2+wz_2>
Et = %(2J)w+2
1.,
- ZJ(w1 +w2)2
= E —-Et = iJ(wl—wg)Q

This is demonstrated using the simple example shown below consisting of two
2
bodies with the same inertia J = 12" One initially rotates with w; = prad

rad?
while the other is stationary w; = 0. There is no friction or external torque
acting on the bodies. When the clutch engages at ¢t = 1s, the two bodies immedi-
ately rotate with the same speed wt = .5% and the total kinetic energy of the

system reduces instantaneously from .5 J to .25 J.

It is interesting to compare this response with that of a more detailed model,
in which the clutch is modeled with a finite damping coefficient when en-
gaged. Additionally the two shafts connecting the bodies with the clutch are
assumed to have a certain elasticity and damping coefficient. The correspond-
ing schematic and plots are shown below; for comparison the response from the
idealized model is superimposed with dashed lines.
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Inelastic collision with ideal clutch

The damping coefficients and spring constants have been exaggerated so that
there is visible swinging. Note however, that after the transients have settled,
the two bodies rotate at the same common speed as in the idealized model.
Likewise, the final mechanical energy stored in the system is the same as in
the idealized model.
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Inelastic collision with non-ideal clutch and elastic shafts
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Analysis Tools

Steady-State Analysis

Many specifications of a power electronic system are often given in terms of
steady-state characteristics. A straight-forward way to obtain the steady-state
operating point of a system is to simulate over a sufficiently long time-span un-
til all transients have faded out. The drawback of this brute-force approach is
that it can be very time consuming. Usually a system has time constants that
are much longer than the switching period. This applies in particular to electro-
thermal models.

Algorithm

The steady-state analysis of a periodic system is based on a quasi-Newton
method with Broyden’s update. In this approach the problem is formulated as
finding the roots of the function

f(x) =x —Fr(x)
where x is an initial vector of state variables and Fr(x) is the final vector of
state variables one period 7T later.

Evaluating f(x) or Fr(x) therefore involves running a simulation from ts,,t to
tstart + 1. The period, T, must be the least common multiple of the periods of all
sources (signal or electrical) in the model.

The above problem can be solved iteratively using

_ of (x
X]H_l:Xk*Jkl'f(Xk) s Jk: 0()()

X

The Jacobian J is calculated numerically using finite differences. If n is the
number of state variables, calculating the Jacobian requires n + 1 simulation



7 Analysis Tools

180

runs where each state variable in turn is slightly perturbed and the difference
between the perturbed and unperturbed solution is computed to obtain one col-
umn of J:

f(x+ Ax;) — f(x)
‘AX1|

ji = 5 1=1...n

Because this is computationally expensive, only the first Jacobian is actually
computed this way. In subsequent iterations, the Jacobian is updated using
Broyden’s method, which does not require any additional simulations.

The convergence criterion of the iterations is based on the requirement that
both the maximum relative error in the state variables and the maximum rel-
ative change from one iteration to the next are smaller than a certain limit rtol:

|fi ()]

Xk4+1 — Xk
max |z;(7)|

Xk

< rtol and <rtol foralli=1,...,n

A steady-state analysis comprises the following steps:

1 Simulate until the final switch positions after one cycle are equal to the ini-
tial switch positions. This is called a circular topology.

2 Calculate the Jacobian matrix J, for the initial state.

3 Iterate until the convergence criterion is satisfied. If during the iterations
the final switch positions after one cycle differ from the initial switch posi-
tions, go back to step 1.

Fast Jacobian Calculation for Thermal States

To reduce the number of simulation runs and thus save computation time
PLECS can calculate the Jacobian matrix entries pertaining to thermal states
directly from the state-space matrices rather than using finite differences.

There is a certain error involved with this method since it neglects the feedback
from the thermal states to the electrical states (or Simulink states). While this
will not affect the accuracy of the final result of the steady-state analysis it may
slow down the convergence. Normally, however, the overall performance will be
much faster than calculating the full Jacobian matrix.

The calculation method is controlled by the parameter JacobianCalculation
(see below).



Steady-State Analysis

Non-Periodic Case

If the operating point of the system is defined as non-periodic (DC), a variant
of the algorithm described above is performed. As in the periodic case, Newton
iterations are executed to find the steady-state. Here, the algorithm searches
for the roots of the function

f(x)=x%

i.e. the time derivative of the vector of state variables x. Since no simulation
has to be performed to compute f, the full Jacobian J is calculated in each itera-
tion. The convergence criterion remains the same as for the periodic case.

Limitations
Hidden state variables

In PLECS Blockset, the steady-state analysis depends on the fact that a model
can be completely initialized with the InitialState parameter of the sim com-
mand. However, certain Simulink blocks that clearly have an internal memory
do not store this memory in the state vector and therefore cannot be initialized.
Among these blocks are the Memory block, the Relay block, the Transport De-
lay block and the Variable Transport Delay block. If a model contains any block
with hidden states, the algorithm may be unable to find a solution.

State variable windup

If the effect of a state variable on the system is limited in some way but the
state variable itself is not limited, it might wind up towards infinity. In this
case the algorithm may fail to converge or return a false solution. In order to
avoid this problem you should limit the state variable itself, e.g. by enabling the
Limit output checkbox of an Integrator block.

Reference

D. Maksimovié, "Automated steady-state analysis of switching power convert-
ers using a general-purpose simulation tool", Proc. IEEE Power Electron-
ics Specialists Conference, June 1997, pp. 1352-1358.
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AC Analysis

The AC Analysis uses the Steady-State Analysis to compute the transfer func-
tion of a periodic system at discrete analysis frequencies. For each frequency
the following steps are executed:

1 Apply a sinusoidal perturbation to the system under study.
2 Find the periodic steady-state operating point of the perturbed system.

3 Extract the system response at the perturbation frequency using Fourier
analysis.

The perturbation frequencies are defined by specifying the sweep range and the
number of points to be placed within this range on a linear or logarithmic scale.

Note The period length of the perturbed system is the least common multiple
of the unperturbed system period and the perturbation period. In order to keep
this number and thus the simulation time small the algorithm may slightly ad-
just the individual perturbation frequencies.

In PLECS Standalone, the operating point can be defined as “non-periodic”
(DC). In this case, no sweep is executed, but the Bode plot is computed directly
from the state space matrices at the steady-state.

Impulse Response Analysis

An alternative and faster method to determine the open loop transfer function
of a system is the Impulse Response Analysis. Instead of perturbing a system
with sinusoidal stimuli of different frequencies, one at a time, a single impulse
is applied when the system is in steady state. The system transfer function can
then be calculated very efficiently over a wide frequency range (from zero to
half the system frequency) by computing the Laplace transform of the transient
impulse response.

Algorithm

The impulse response analysis is performed in three steps:



Impulse Response Analysis

1 Find the steady-state operating point of the system under study.

2 Apply a perturbation in form of a discrete impulse for the duration of one pe-
riod.

3 Calculate the Laplace transform of the transient impulse response.

Compensation for Discrete Pulse

Theoretically, in order to compute the system transfer function from the
Laplace transform of the system response, the system must be perturbed with a
unit Dirac impulse (also known as delta function). This is not practical for nu-
merical analysis, so the algorithm applies a finite rectangular pulse instead.
For transfer functions such as the line-to-output transfer function or the out-
put impedance this can be compensated for by dividing the Laplace transform
of the system response by the Laplace transform of the rectangular pulse. This
is achieved by setting the parameter Compensation for discrete pulse to
discrete pulse, which is the default.

However, when calculating control-to-output transfer functions that involve the
duty cycle of a switched converter, the rectangular input signal interferes with
the sampling of the modulator. In this case the compensation type should be set
to external reference. This causes the Impulse Response Analysis block to
have two input signals that should be connected as shown in this figure.

iL

PLECS

$  Circuit
v_load

Modulator

Scope

o> PLECS
Impulse Resp.

+0 Analysis

Circuit

Control to Output
Transfer Function

Finally, you can set the compensation type to none which means that the com-
puted transfer function is taken as is. Use this setting if the modulator uses
regular sampling and the sampling period is identical to the system period.

Reference
D. Maksimovié, "Automated small-signal analysis of switching power convert-

ers using a general-purpose time-domain simulator”, Proc. Applied Power
Electronics Conference, February 1998.
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The Multitone Analysis is similar to an AC Analysis. Again the response of the
system to a small perturbation signal is analysed. However, instead of multiple
sinusoidal signals of different frequencies, only one multitone signal is applied.
It is composed of several sinusoidal signals and therefore contains all investi-
gated frequencies at once.

The multitone signal is computed as

u(t) = \/Eésm (27rkfbt + ”(kN_l)Q) :

where N is the number of tones and f; the base frequency. In PLECS, the user
can control the amplitude of the perturbation signal by a factor that is multi-
plied to u(t).

Algorithm

The simulation is divided into two phases. It is assumed that the system
reaches its steady-state in the first phase of duration 7;. In the second phase
of duration 7, = 1/f;, the response of the system is recorded for the Fourier
analysis.

The Multitone Analysis performs these steps:

1 Perform an unperturbed simulation of length T; + T},. Record the system re-
sponse during 7T} in yg.

2 Perform a simulation of the same length and perturbed by u. Record the sys-
tem response during 7} in y.

3 Compute the Fourier transforms U of v and Y of y — yo.
4 Compute the transfer function as G = Y/U.

Remarks

The Multitone Analysis is faster than the AC Analysis because it only needs to
compute the response to one signal instead of a set of signals for each frequency.
On the other hand, the analysed frequencies are restricted to multiples of the
base frequency. Since the Multitone Analysis does not use the Steady-State
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Analysis, it still works in cases where the Steady-State Analysis fails, provided
T; is large enough.

Note that the lengths of the yy and y vectors are different in general. To com-
pute the difference y — 39, the missing values are linearly interpolated.

References

S. Boyd, "Multitone signals with low crest factor", IEEE Transactions of Cir-
cuits and Systems, Vol. CAS-33, No. 10, 1986.

C. Fernandez, P. Zumel, A. Fernandez-Herrero, M. Sanz, A. Lazaro, A. Bar-
rado, "Frequency response of switching DC/DC converters from a single
simulation in the time domain", Applied Power Electronics Conference
and Exposition (APEC), 2011 Twenty-Sixth Annual IEEE , March 2011.
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In PLECS Standalone all analyses are managed in the Analysis Tools Dialog
shown below. To open the dialog, select Analysis tools... from the Simulation
menu of the schematic editor.

‘4 Analysis Tools: BuckOpenLoop ll

Analysis bype: Steady-State Analysis

Description: ISteady State Analysis

Cutput TF (AC Sweep) Setup | options |

AC Sweep

Contral to Oukput TF {Impulse Response)  ©@Perating point: |periodic LI
Irnpulze Response &nalysis .

Contral ko Oukput TF (Multitone Analysis) System period: I le-S

Multitore Analysis

Output Impedance (4C Sweep) Simulation start time: |D

AC Sweep

Cutput Impedance (Impulse Response)
Irnpulze Response &nalysis

Cutput Impedance (Mulkitone Analysis)
Multitore Analysis

+|—| Show log | Startanalysisl Accept | Rewvert | Help |

Show final cycles: |5

The left hand side of the dialog window shows a list of the analyses that are
currently configured for the model. To add a new analysis, click the button
marked + below the list and select the desired analysis type. To remove the
currently selected analysis, click on the button marked -. You can reorder the
analyses by clicking and dragging an entry up and down in the list.

The right hand side of the dialog window shows the parameter settings of the
currently selected analysis. Each analysis must have a unique Description.
The other parameters available for the different analysis types are described
further below.

The button Start analysis/Abort analysis starts the currently selected analy-
sis or aborts the analysis that is currently running. The button Show log/Hide
log shows or hides a log window that displays the progress of an analysis and
diagnostic messages.

Steady-State Analysis

Operating point
This parameter defines whether the operating point of the system is peri-
odic or non-periodic (DC). If it is periodic, the system period can be specified
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using the next parameter.

System period
The system period is the least common multiple of the periods of all sources
(signal or electrical) in the model, in seconds (s). If the parameter setting
does not reflect the true system period or an integer multiple thereof, the
analysis will yield meaningless results or fail to converge altogether. A set-
ting of 0 is equivalent to defining the system as non-periodic. When set to
auto, which is the default, PLECS will try to determine the system period
automatically.

Simulation start time
The start time ¢4, to be used in the transient simulation runs, in seconds
(s). Simulations run from ts;,,¢ to tsars + T, Wwhere T is the system period
specified above. The default is 0.

Show final cycles / timespan
The number of steady-state cycles for which a transient simulation is run at
the end of an analysis. Or, if the simulation is non-periodic, the duration of
the final transient simulation. The default is 1.

Number of init. cycles
The number of cycle-by-cycle simulations to be performed before the Newton
iterations are started. When an analysis fails to converge because the start-
ing point was too far from the steady-state solution, this parameter can help
to get better starting conditions. The default is 0.

Termination tolerance
The relative error bound. The analysis continues until both the maximum
relative error in the state variables and the maximum relative change from
one iteration to the next are smaller than this bound for each state variable.

Max. number of iterations
Maximum number of Newton iterations allowed.

Rel. perturbation for Jacobian
Relative perturbation of the state variables used to calculate the approxi-
mate Jacobian matrix.

Jacobian calculation
Controls whether Jacobian matrix entries for thermal state variables are
calculated via finite differences (full) or directly from the state-space ma-
trices (fast). The default is fast.

Max. number of threads
Specifies the maximum number of parallel threads that may be used during
the analysis. When set to auto, the limit specified in the PLECS preferences
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is used.

AC Sweep

In order to perform an AC sweep, you need to insert a Small Signal Perturba-
tion (see page 681) and a Small Signal Response (see page 682) block in order

to define the points at which the perturbation is injected and the response is
measured. The Small Signal Gain (see page 680) block can be used to obtain the
closed loop gain of a feedback loop.

At the end of an analysis, a scope window will open and display the Bode dia-
gram of the transfer function. You can also open the scope manually by clicking
one Show results button.

Operating point
This parameter defines whether the operating point of the system is peri-
odic or non-periodic (DC). If it is periodic, the system period can be specified
using the next parameter.

System period
The system period is the least common multiple of the periods of all sources
(signal or electrical) in the model, in seconds (s). If the parameter setting
does not reflect the true system period or an integer multiple thereof, the
analysis will yield meaningless result or fail to converge altogether. A sys-
tem period of 0 is equivalent to defining the system as non-periodic. When
set to auto, which is the default, PLECS will try to determine the system
period automatically.

Frequency range
A vector containing the lowest and highest perturbation frequency, in hertz
(Hz).

Amplitude
A vector containing the amplitudes of the perturbation signal at the lowest
and highest frequency. The amplitudes at intermediate frequencies are in-
terpolated linearly. If a scalar is entered, the amplitude will be constant for
all frequencies.

Perturbation
The Small Signal Perturbation block that will be active during the analysis.
All other perturbations blocks will output 0.

Response
The Small Signal Response block that will record the system response dur-
ing the analysis.
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Simulation start time
The start time ¢.;..+ to be used in the transient simulation runs, in seconds
(s). Simulations run from ts;,,¢ to tstars + 7', Where T is the system period
specified above. The default is 0.

Frequency scale
Specifies whether the sweep frequencies should be distributed on a 1inear
or logarithmic scale.

Number of points
The number of automatically distributed frequencies.

Additional frequencies
A vector specifying frequencies to be swept in addition to the automatically
distributed frequencies, in hertz (Hz).

Max. number of threads
Specifies the maximum number of parallel threads that may be used during
the analysis. When set to auto, the limit specified in the PLECS preferences
is used.

For a description of the steady-state options please refer to “Steady-State Anal-
ysis” (on page 186).

Impulse Response Analysis

In order to perform an impulse response analysis, you need to insert a Small
Signal Perturbation (see page 681) and a Small Signal Response (see page 682)
block in order to define the points at which the perturbation is injected and the
response is measured.

At the end of an analysis, a scope window will open and display the Bode dia-
gram of the transfer function. You can also open the scope manually by clicking
one Show results button.

For a description of the parameters please refer to “AC Sweep” (on page 188).
In an impulse response analysis, the computational effort for an individual fre-
quency is very cheap. Therefore, the parameter Additional frequencies is
omitted; instead, the Number of points can be set to a large value in order ob-
tain smooth curves.
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Multitone Analysis

In order to perform a multitone analysis, you need to insert a Small Signal Per-
turbation (see page 681) and a Small Signal Response (see page 682) block in
order to define the points at which the perturbation is injected and the response
is measured.

At the end of an analysis, a scope window will open and display the Bode dia-
gram of the transfer function. You can also open the scope manually by clicking
one Show results button.

Initial simulation period
The duration of an initial simulation performed before the response is mea-
sured. It is assumed that during this period, the system reaches its steady
state. The total simulation duration will be the sum of this parameter and
one period of the base frequency signal.

Frequency range
A vector containing the lowest and highest frequency of the multitone per-
turbation signal, in hertz (Hz). The highest frequency is rounded up to-
wards the next integer multiple of the lowest frequency.

In a multitone analysis, the frequencies are linearly spaced (see “Multi-
tone Analysis” (on page 184)). Since the Bode plot has a logarithmic scale,
PLECS thins out the higher frequency values to accelerate the analysis.

If the lowest and highest frequencies are far apart, i.e. separated by several
orders of magnitude, the multitone analysis may become slow. One reason
is that the simulation times become long and the simulation steps small,
since they depend on the lowest and highest frequencies, respectively. You
may try to speed up the analysis by specifying intermediate frequency val-
ues, i.e. by entering a frequency vector with more than two elements. Each
intermediate value must be greater than ten times the preceding value. If
the frequency vector contains n elements, n — 1 separate multitone analyses
are performed and the Bode plot is composed of the respective results. Since
the frequency range of each individual multitone analysis is smaller than
the overall range, the total time needed may become shorter.

Amplitude
The amplitude of the perturbation signal. Note that the actual perturbation
signal may have a sightly different amplitude due to its composition from
the different tones.

Perturbation

The Small Signal Perturbation block that will be active during the analysis.
All other perturbations blocks will output 0.
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Response
The Small Signal Response block that will record the system response dur-
ing the analysis.

Simulation start time
The start time ¢4, to be used in the transient simulation runs, in seconds
(s). The default is 0.

Max. number of threads
Specifies the maximum number of parallel threads that may be used during
the analysis. When set to auto, the limit specified in the PLECS preferences
is used.

Extraction of State-Space Matrices

PLECS allows you to extract the state-space matrices describing the linear por-
tion of a circuit model for a given combination of switch positions. The com-
mands used for this purpose are listed below. These commands can be used
both in a Simulation Script (see page 253) and on the Octave console. In each
of the commands circuit is the name of the circuit model.

names = plecs('get', circuit, 'StateSpaceOrder');

returns a struct containing the names of the components associated with the
circuit model’s inputs, outputs, states and switches.

plecs('set', circuit, 'SwitchVector', switchpos);
sets the vector of switch positions for the subsequent analysis to switchpos.
t = plecs('get', circuit, 'Topology');

returns a struct with the state-space matrices A, B, C, D and I for the vector of
switch positions specified by the previous command. The matrix I is the iden-
tity matrix if all electrical states are independent. Otherwise it specifies the
relationship between the dependent variables.

The matrices obtained can be further used for state-space averaging (see page
207).

Above commands can also be invoked via the RPC interface (see page 262) us-
ing an analogous syntax.
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Application Example

The demo model “Buck Converter with Analysis Tools” implements the buck
converter shown below. It operates at a switching frequency of 100 kHz with a
fixed duty-cycle of 15/28. To run a transient simulation from zero initial condi-
tions, select Start from the Simulation menu.

e m s —_+_ Scope
Gl T

A vo'

Vi 28 (D FEr PIVAN C:500e-6 == (v} R: 3 |<><—@

To view the analyses configured in this model select Analysis tools... from the
Simulation menu. The only periodic source in the model is the carrier signal
used in the modulator. Hence, the parameter System period for all analyses is
specified as T'= 1/100kHz = 10~ °s.

Steady-State Operation

To view the steady-state operation of the converter, select Steady-State Anal-
ysis from the list and click on Start analysis. After the analysis has found the
periodic operating point, the scope will show five steady-state cycles.

Control-to-Output Transfer Function

For the calculation of the control-to-output transfer function, a small pertur-
bation needs to be added to the modulation index. This is done with the Small
Signal Perturbation block m', which has the Show feed-through input set-
ting enabled. The system output in this case is defined as the output voltage of
the converter. The output signal of the voltmeter is therefore connected to the
Small Signal Response block vo'.

To calculate the transfer function using the AC Sweep, select Control to Out-
put TF (AC Sweep) from the list and click on Start analysis. The analysis
sweeps the frequency range between 100 Hz and 50 kHz. 21 points are placed
logarithmically within this range; to obtain a smoother output, additional data
points are generated between 800 and 1400 Hz.
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To calculate the transfer function using the Impulse Response Analysis, select
Control to Output TF (Impulse Response) from the list and click on Start
analysis.

Output Impedance

For the calculation of the output impedance, a small perturbation current is
injected into the converter output using a current source that is controlled
by the Small Signal Perturbation block i’ and the output voltage response
is measured. As above, two analyses have been configured that calculate the
impedance using the AC Sweep and the Impulse Response Analysis.

Loop Gain

The demo model “Buck Converter with Loop Gain Analysis” implements the
controlled buck converter shown below. A PID controller regulates the output
voltage to 15V.

»| N
»-| N
+_ Verr m m s Scope
vref A } .
PID PWM 7 L:50e-6 —’E
Controller A vo'

v:-28 (%) Y C:500e-6 = (vj— R3 | 1(D—G)

aY
ZJ
Loop Gain Meter

For the calculation of the voltage loop gain, the Small Signal Gain block Loop
Gain Meter has been inserted into the feedback path. If you look under the
mask of the Small Signal Gain, you can see how the block both injects a small
perturbation and measures the system response.

To calculate the loop gain, select Analysis tools... from the Simulation menu,
then choose Closed Loop Gain from the list of analyses and click Start anal-
ysis.
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Usage in PLECS Blockset

In PLECS Blockset, you configure analyses by copying the appropriate blocks
from the Analysis Tools library in PLECS Extras into your model.

Steady-State Analysis

To perform a steady-state analysis, copy the Steady-State Analysis block (see
page 851) into your model. An analysis can be run interactively from the block
dialog or via a MATLAB command. The calling syntax is

plsteadystate (block);

where block is the Simulink handle or the full block path of the Steady-State
Analysis block. The block handle or path can be followed by parameter/value
pairs. Otherwise, the settings specified in the block dialog are used.

The following table lists the parameters of the Steady-State Analysis block.
The Parameter column shows the parameter names to be used with the
plsteadystate command. The Description column indicates whether and
where you can set the value in the dialog box. Parameters that are not acces-
sible in the dialog box can be modified using the set_param command.

Steady-State Analysis Parameters

Parameter Description

TimeSpan For a fixed system period, the period length;
this is the least common multiple of the peri-
ods of independent sources in the system. For

a variable system period, the maximum time
span during which to look for a trigger event
marking the end of a period. Set by the System
period length/Max simulation time span
field.

TStart Simulation start time. Set by the Simulation
start time field.
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Steady-State Analysis Parameters (contd.)

Parameter Description

Tolerance Relative error tolerance used in the conver-
gence criterion. Set by the Termination toler-
ance field.

MaxIter Maximum number of iterations allowed. Set by

the Max number of iterations field.

Display Specifies the level of detail of the diagnostic
messages displayed in the command window
(iteration, final, off). Set by the Display
drop-down list.

HideScopes Hide all Simulink scope windows during an
analysis in order to save time.

HiddenStates Specifies how to handle Simulink blocks with
‘hidden’ states, i.e. states that are not stored in
the state vector (error, warning, none). Set by
the Hidden model states drop-down list.

FinalStateName Name of a MATLAB variable used to store the
steady-state vector at the end of an analysis.
Set by the Steady-state variable field.

NCycles Number of steady-state cycles that should be
simulated at the end of an analysis. Set by the
Show steady-state cycles field.

JPert Relative perturbation of the state variables
used to calculate the approximate Jacobian
matrix.

JacobianCalculation | Controls the way the Jacobian matrix is calcu-
lated (full, fast). The default is fast.

NInitCycles Number of cycle-by-cycle simulations that
should be performed before the actual steady-
state analysis. This parameter can be used to
provide the algorithm with a better starting
point. The default is 0.
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These examples show how to run analyses for the block Steady State in the
model mymodel:

plsteadystate('mymodel/Steady State');
starts an analysis using the parameters specified in the dialog box.

plsteadystate('mymodel/Steady State','TStart',0,...
'FinalStateName','x0"');

plsteadystate('mymodel/Steady State','TStart',1,...
'FinalStateName', 'x1');

performs two analyses with different start times and assigns the resulting
steady-state vectors to two different variables x0 and x1. This is useful e.g. if
the model has a reference signal with a step change and you want to determine
the steady state before and after the change.

AC Sweep / Loop Gain Analysis

To perform an AC sweep, copy the AC Sweep block (see page 840) into your
model. The block outputs a perturbation signal, which must be injected into the
system. The system response must be fed back into the block input.

To perform a loop gain analysis, copy the Loop Gain Analysis (AC Sweep) block
(see page 846) into your model and insert it into the path of a feedback loop.

An analysis can be run interactively from the block dialogs or via a MATLAB
command. The calling syntax is

placsweep (block) ;

where block is the Simulink handle or the full block path of the AC Sweep or
Loop Gain Analysis block. The block handle or path can be followed by parame-
ter/value pairs. Otherwise, the settings specified in the block dialog are used.

The following table lists the parameters of the AC Sweep and Loop Gain Anal-
ysis blocks. The Parameter column shows the parameter names to be used
with the placsweep command. The Description column indicates whether and
where you can set the value in the dialog box. Parameters that are not accessi-
ble in the dialog box can be modified using the set _param command.
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AC Analysis Parameters

Parameter

Description

TimeSpan

Period length of the unperturbed system. Set by the
System period length field.

TStart

Simulation start time. Set by the Simulation
start time field.

FregRange

Range of the perturbation frequencies. Set by the
Frequency sweep range field.

FreqScale

Specifies whether the sweep frequencies should be
distributed on a 1linear or logarithmic scale. Set
by the Frequency sweep scale field.

NPoints

Number of data points generated. Set by the Num-
ber of points field.

InitialAmplitude

Perturbation amplitude at the first perturbation
frequency. Set by the Amplitude at first freq
field.

Method

Method used for obtaining the periodic steady-state
operating point of the perturbed system:

Brute force simulation - start from model
initial state,Brute force simulation - start
from unperturbed steady state, Steady-state
analysis - start from model initial state,
Steady-state analysis - start from unper-
turbed steady state.

Set by the Method drop-down list.

Tolerance

Relative error tolerance used in the convergence
criterion. Set by the Termination tolerance field.

MaxIter

Maximum number of iterations allowed. Set by the
Max number of iterations field.

Display

Specifies the level of detail of the diagnostic mes-
sages displayed in the command window (itera-
tion, final, off). Set by the Display drop-down
list.
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AC Analysis Parameters (contd.)

Parameter

Description

HideScopes

Hide all Simulink scope windows during an analy-
sis in order to save time.

HiddenStates

Specifies how to handle Simulink blocks with "hid-
den’ states, i.e. states that are not stored in the
state vector (error, warning, none). Set by the
Hidden model states drop-down list.

OutputName

Name of a MATLAB variable used to store the
transfer function at the end of an analysis. Set by
the Output variable field.

BodePlot

Plot a Bode diagram of the transfer function at the
end of an analysis. Set by the Plot Bode diagram
drop-down list.

JPert

Relative perturbation of the state variables used to
calculate the approximate Jacobian matrix.

NInitCycles

If a steady-state analysis is used to obtain the
starting point of the ac analysis (see parameter
Method above), this parameter specifies the num-
ber of cycle-by-cycle simulations that should be
performed before the steady-state analysis. This
parameter can be used to provide the algorithm
with a better starting point. The default is 0.

These examples show how to run analyses for the block AC Sweep in the model

mymodel:

placsweep('mymodel/AC Sweep');

starts an analysis using the parameters specified in the dialog box.

placsweep('mymodel/AC Sweep', 'TStart',0,...
"OutputName', 'T0"');

placsweep('mymodel/AC Sweep', 'TStart',1,...
"OutputName', 'T1');
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performs two analyses with different start times and assigns the resulting
transfer functions to two different variables TO and T1. This is useful e.g. if the
model has a reference signal with a step change and you want to determine the
transfer function before and after the change.

Impulse Response Analysis

To perform an impulse response analysis, copy the Impulse Response Analysis
block (see page 844) into your model. The block outputs a perturbation signal,

which must be injected into the system. The system response must be fed back
into the block input.

An analysis can be run interactively from the block dialogs or via a MATLAB
command. The calling syntax is

plimpulseresponse (block);

where block is the Simulink handle or the full block path of the Impulse Re-
sponse Analysis block. The block handle or path can be followed by parame-
ter/value pairs. Otherwise, the settings specified in the block dialog are used.

The following table lists the parameters of the Impulse Response Analysis
block. The Parameter column shows the parameter names to be used with the
plimpulseresponse command. The Description column indicates whether and
where you can set the value in the dialog box. Parameters that are not accessi-
ble in the dialog box can be modified using the set_param command.

Impulse Response Analysis Parameters

Parameter Description

TimeSpan Period length of the unperturbed system. Set by the
System period length field.

TStart Simulation start time. Set by the Simulation start
time field.

FreqRange Range of the perturbation frequencies. Set by the Fre-

quency sweep range field.
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Impulse Response Analysis Parameters (contd.)

Parameter Description

FreqScale Specifies whether the sweep frequencies should be dis-
tributed on a 1inear or logarithmic scale. Set by the
Frequency sweep scale field.

NPoints Number of data points generated. Set by the Number
of points field.

Perturbation | Perturbation amplitude of the discrete impulse. Set by
the Perturbation field.

Compensation | Specifies whether and how the effect of the sampling
should be compensated (none, discrete pulse, ex-
ternal reference). Set by the Compensation for
discrete pulse drop-down list.

Tolerance Relative error tolerance used in the convergence cri-
terion of the initial steady-state analysis. Set by the
Termination tolerance field.

MaxIter Maximum number of iterations allowed during the ini-
tial steady-state analysis. Set by the Max number of
iterations field.

Display Specifies the level of detail of the diagnostic messages
displayed in the command window (iteration, final,
off). Set by the Display drop-down list.

HideScopes Hide all Simulink scope windows during an analysis in
order to save time.

HiddenStates | Specifies how to handle Simulink blocks with ’hidden’
states, i.e. states that are not stored in the state vec-
tor (error, warning, none). Set by the Hidden model
states drop-down list.

OutputName Name of a MATLAB variable used to store the transfer
function at the end of an analysis. Set by the Output
variable field.
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Impulse Response Analysis Parameters (contd.)

Parameter Description

BodePlot Plot a Bode diagram of the transfer function at the
end of an analysis. Set by the Plot Bode diagram
drop-down list.

JPert Relative perturbation of the state variables used to
calculate the approximate Jacobian matrix.

NInitCycles Number of cycle-by-cycle simulations that should be
performed before the initial steady-state analysis. This
parameter can be used to provide the algorithm with a
better starting point. The default is 0.

Multitone / Loop Gain Analysis

To perform a multitone analysis, copy the Multitone Analysis block (see page
849) into your model. The block outputs a perturbation signal, which must be
injected into the system. The system response must be fed back into the block
input.

To perform a loop gain analysis, copy the Loop Gain Analysis (Multitone) block
(see page 847) into your model and insert it into the path of a feedback loop.

An analysis can be run interactively from the block dialogs or via a MATLAB
command. The calling syntax is

plmultitone (block);

where block is the Simulink handle or the full block path of the Multitone Anal-
ysis or Loop Gain Analysis block. The block handle or path can be followed by
parameter/value pairs. Otherwise, the settings specified in the block dialog are
used.

The following table lists the parameters of the Multitone Analysis and Loop
Gain Analysis blocks. The Parameter column shows the parameter names

to be used with the placsweep command. The Description column indicates
whether and where you can set the value in the dialog box. Parameters that are
not accessible in the dialog box can be modified using the set_param command.
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Multitone Analysis Parameters

Parameter Description

FreqRange Range of the perturbation frequencies. Set by the
Frequency sweep range field.

Amplitude Amplitude of the perturbation signal. Set by the
Amplitude field.

TStart Simulation start time. Set by the Simulation
start time field.

Display Specifies the level of detail of the diagnostic mes-
sages displayed in the command window (itera-
tion, final, off). Set by the Display drop-down
list.

HideScopes | Hide all Simulink scope windows during an analy-
sis in order to save time.

OutputName | Name of a MATLAB variable used to store the
transfer function at the end of an analysis. Set by
the Output variable field.

BodePlot Plot a Bode diagram of the transfer function at the
end of an analysis. Set by the Plot Bode diagram
drop-down list.

Extraction of State-Space Matrices
PLECS allows you to extract the state-space matrices describing the linear por-
tion of a circuit model for a given combination of switch positions. The com-

mands used for this purpose are listed below. In each of the commands circuit
is the full Simulink path of a PLECS Circuit block.

names = plecs('get', circuit, 'StateSpaceOrder');

returns a struct containing the names of the components associated with the
circuit model’s inputs, outputs, states and switches.

plecs('set', circuit, 'SwitchVector', switchpos);
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sets the vector of switch positions for the subsequent analysis to switchpos.
t = plecs('get', circuit, 'Topology');

returns a struct with the state-space matrices A, B, C, D and I for the vector of
switch positions specified by the previous command. The matrix I is the iden-
tity matrix if all electrical states are independent. Otherwise it specifies the
relationship between the dependent variables.

The matrices obtained can be further used for state-space averaging (see page
207).

Application Example

This section demonstrates the application of the analysis tools in PLECS Block-
set for the design of the regulated buck converter system operating at a switch-
ing frequency of 100 kHz shown in the figure below. The converter shall supply a
regulated 15V to a resistive load at a nominal load current of 5 A.

(
iL s = L:50e-6 | iL v_load
PLECS * A
S Circuit M—O
load
v_ref Compensator Modulator Vo Scope FET . *
V: 28| D C: 500e-6= R:3

Circuit

The examples used in this section follow the design example in [Erickson],
chapter 9. They have been implemented in the demo models called “Buck Con-
verter with Parameter Sweep” , “Buck Converter with Analysis Tools” and
“Buck Converter with Loop Gain Analysis” . These demo models can be found
in the Demo Models Browser of PLECS.

Steady-State Analysis

We first examine the open-loop behavior of the system. In order to get the de-
sired output voltage we need to apply a fixed duty-cycle of V5, /Vire = 15V/28 V.
You can verify this by using the Steady-State Analysis block to obtain the
steady-state waveform of the output voltage.

For this purpose you copy the block into the model and double-click it to open
the dialog box. The parameter System period length is already set to the
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correct value, i.e. 1e-5. Set the parameter Show steady-state cycles to e.g.
10 so that you can more easily check that the system is indeed in the steady
state when the analysis finishes. Then click on Start analysis. The algorithm
should converge after the first iteration, and the scope should show the wave-
form in the figure below.

15.002

I AN A AT
N AVAVAVAVAVAVAVAVAVA

14.998
0 0.1 0.2 0.3 0.4 0. 0.8 0.9 1

t/s x10_4

1A%

load

Steady-state output voltage

AC Sweep

Open-loop control-to-output transfer function In order to determine the
control-to-output transfer function you need to perturb the steady-state duty-
cycle and measure the corresponding perturbation of the output voltage. This
is achieved by connecting an AC Sweep block as shown below. The block output
is the perturbation signal; it is added to the steady-state duty cycle. The block
input is connected to the load voltage signal.

The initial amplitude of the perturbation is set to 1e-3 which is approx. 2/1000
of the duty cycle. We want to sweep a frequency range between 100 Hz and
50kHz with a few extra points between 800 Hz and 1200 Hz. This is achieved by
setting the parameter to [100 800:50:1200 50000]. As expected, the resulting
bode plot of the transfer function shows a double pole at fy = 1/(27VLC) ~
1kHz and a dc gain of G = 28V ~ 29 dB.

Open-loop output impedance Although not required for the compensator
design we will now calculate the output impedance for demonstration purposes.
To do so we need to inject a small ac current into the converter output and mea-
sure the resulting perturbation of the output voltage. We therefore connect

a controlled current source in parallel with the load resistor as shown below.
This current source is controlled by the perturbation signal of the AC Sweep
block. The block input is again connected to the load voltage signal. The aver-
age steady-state output current is 5 A; we therefore set the initial perturbation
amplitude to 1e-2.
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Open-loop control-to-output transfer function

Impulse Response Analysis

Alternatively you can determine the open-loop transfer functions using the Im-
pulse Response Analysis block as shown in the figure below. In this analysis
method the calculation of an individual output point is relatively inexpensive;
we therefore set the number of points to 300 and extend the sweep range to [10
50000]. In order to compensate for the discrete rectangular pulse used to per-
turb the system, we choose the setting external reference for the control-to-
output transfer function and discrete pulse for the output impedance.

Loop Gain Analysis

Compensator settings The compensator should attain a crossover frequency
of f. = 5kHz. At this frequency the open-loop control-to-output transfer func-
tion has a phase of nearly —180°. It should be lifted by 52° to get a peak over-
shoot of 16 %. This is achieved using a PD compensator with a zero at f, =
1.7kHz, a pole at f, = 14.5kHz and a dc gain of k = (f./f0)?>\/f-/f»/Go = 0.3.
For a zero stationary error a PI compensator with an inverted zero at f;, =

500 Hz is added.
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Using the Impulse Response Analysis block

The compensator is implemented as shown above. The compensator output is
limited to 0.1...0.9. In order to prevent windup problems during the steady-
state analysis the integrator is limited to the same range.

Loop gain The gain of the closed control loop is measured by inserting the
Loop Gain Analysis block into the loop path. A good place is the feedback path
as shown below. The average steady-state load voltage is 15 V; the initial per-
turbation amplitude is therefore chosen as 1e-2. The convergence of the initial
steady-state analysis can be accelerated by pre-charging the capacitor to its av-
erage steady-state voltage.

The resulting bode plot of the closed-loop gain shown in the figure below. Also
shown are the open-loop control-to-output function with a dashed line and the
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PID compensator transfer function with a dotted line. As you can see, the de-
sign goals for crossover frequency and phase margin have been reached.

State-Space Averaging

Another method for obtaining the open-loop transfer functions of a circuit is a
technique called state-space averaging. This topic is fairly complex and could
easily fill a book of its own. This manual therefore assumes that you are famil-
iar with the concept and just highlights how to use PLECS in the process.

The small-signal ac model of a dc converter operating in continuous conduction
mode (CCM) is described by the equation system

)~((t) = Ax(t) + Bfl(t) + {(Al — AQ))_( + (Bl - Bg)ﬁ}ﬁl(t)

y(t) = Cx(t)+Du(t) + {(C1 — C2)x + (D1 — Dy)u}m(t)

4
dt

where the quantities x(¢), a(t), y(t) and m(t) are small ac variation around the
operating point x, u, y and m. The averaged state-space matrices A, B, C and

1 b num(s)
:In ' den(s)

PD Compensator PI Compensator

10 10° 10° 10° 10°
flHz

PID compensator and transfer function
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D are defined as

A = mA +(1-m)A,
B = mB;+(1-m)B;
C = mC;+(1—-m)Cq
D = mD;+(1-m)D,

where the subscript 1 denotes the interval when the switch is conducting and
the diode blocking, and the subscript 2 denotes the interval when the switch is
blocking and the diode conducting.

You can use PLECS to calculate the different matrices A, A, etc. and from
these the various transfer functions. Using the buck converter from the previ-
ous example, the first step is to determine the internal order of the switches:

load_system('plBuckSweep');
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names = plecs('get', 'plBuckSweep/Circuit',
'StateSpaceOrder');
names.Switches

ans =
'Circuit/FET'
"Circuit/D'

Next you retrieve the state-space matrices for the two circuit topologies:

plecs('set', 'plBuckSweep/Circuit', 'SwitchVector', [1 0]);
t1 = plecs('get', 'plBuckSweep/Circuit', 'Topology');

plecs('set', 'plBuckSweep/Circuit', 'SwitchVector', [0 1]);
t2 = plecs('get', 'plBuckSweep/Circuit', 'Topology');

Now you can calculate the averaged state-space matrices:

t2.A*
t2.B*
t2.C*
t2.D*

1-m);
1-m);
1-m);
1-m);

Ow>» 3

o
I'-|'
—
w
*
3

+ + + +

Output impedance The output impedance is the transfer function from a
state-space input (the current source I_ac) to a state-space output (the volt-
meter Vm). Such a transfer function is given by:

Since the circuit model is a MIMO (multi-input multi-output) model, you need
to specify the indices of the proper elements in the input and output vector. You
can identify them using the fields Inputs and Outputs of the struct names that
you retrieved earlier:

names.Inputs
ans =

'Circuit/V_dc'
'Circuit/I_ac'
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names.Outputs

ans =
'"Circuit/Vm'
'"Circuit/Am'
'"Circuit/FET'
'Circuit/FET'
'"Circuit/D'
'"Circuit/D'

So, the output impedance is the transfer function from input 2 to output 1. If
you have the Control System Toolbox, you can now display the Bode diagram:

bode(ss(A,B(:,2),C(1,:),D(1,2)), {2*pi*100, 2*pi*50000})

The figure below shows the output impedance drawn with a solid line. The dots
represent the data points returned by the ac sweep.
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Open-loop control-to-output transfer function The control-to-output
transfer function describes the effect of the small ac variation 7 on the system
outputs. From the small-signal ac model equations we find that

== CCO(SI - Ac0)71B00 + Dco
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with

Note that B, and D, are column vectors since there is only one scalar input
variable, m. The vector 1 is a column vector consisting of the dc input voltage
and the small-signal ac current.

This leads to the following program code:

u = [28; 0];

B_co

D _co

(-(t1.A-t2.A)*(A\B)+(t1.B-t2.B))*u;
(-(t1.C-t2.C)*(A\B)+(t1.D-t2.D))*u;

bode(ss(A,B_co,C(1,:),D_co(1)), {2*pi*100, 2*pi*50000})

The figure below shows the control-to-output transfer function drawn with a
solid line. The dots represent the data points returned by the ac sweep.
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Open-loop control-to-output transfer function
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C-Scripts

C-Scripts provide a powerful and comfortable mechanism for implementing cus-
tom control blocks in the C programming language. They enable you to interact
with the solver engine on a level very similar to that of built-in blocks.

Typical applications where C-Scripts are useful include:

¢ Implementing complex non-linear and/or piecewise functions. These would
otherwise need to be modeled with complex block diagrams that are hard to
read and maintain.

¢ Implementing modulators or pulse generators that require exact but flexible
time step control.

¢ Incorporating external C code, e.g. for a DSP controller, into a simulation
model.

There is no need to manually compile any code or even to install a compiler. A
built-in compiler translates your C code on-the-fly to native machine code and
links it dynamically into PLECS.

A detailed description of how C-Scripts work is given in the following section.
For a quick start you can also have a look at the C-Script examples further be-
low.

How C-Scripts Work

Since C-Scripts interact so closely with the solver engine, a good understand-
ing of how a dynamic system solver works is advantageous. This is described in
detail in the chapter “How PLECS Works” (on page 27).
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C-Script Functions

A C-Script block, like any other control block, can be described as a mathemat-
ical (sub-)system having a set of inputs u, outputs y and state variables z., 24
that are related to each other by a set of equations:

Yy = foutput(tauvxmmd)
l’geXt = fupdate (t, U, Tc, Id)

Te fderivative(ta Uu, Z‘C,J)d)

A C-Script block has an individual code section for each of these functions and
two additional sections for code to be executed at the start and termination

of a simulation. The C code that you enter in these sections is automatically
wrapped into C functions; the actual function interface is hidden to allow for
future extensions. You can access block variables such as inputs, outputs and
states by means of special macros that are described further below. The solver
calls these C functions as required during the different stages of a simulation
(see “Model Execution” on page 33).

Start Function

The start function is called at the beginning of a simulation. If the C-Script has
continuous or discrete state variables, they should be initialized here using the
macros ContState(i) and DiscState(i).

Output Function

The output function is called during major and minor time steps in order to
update the output signals of the block. The block inputs and outputs and the
current time can be accessed with the macros InputSignal(i, j), OutputSig-
nal(i, j) and CurrentTime.

If you need to access any input signal during the output function call, you must
check the Input has direct feedthrough box on the Setup pane of the C-
Script dialog. This flag influences the block execution order and the occurrence
of algebraic loops (see “Block Sorting” on page 31).
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In general, output signals should be continuous and smooth during minor time
steps; discontinuities or sharp bends should only occur during major time steps.
Whether or not the call is made for a major time step can be inquired with the
IsMajorStep macro. For details see “Modeling Discontinuities” below.

Note It is not safe to make any assumptions about the progression of time be-
tween calls to the output function. The output function may be called multiple
times during the same major time step, and the time may jump back and forth
between function calls during minor time steps. Code that should execute ex-
actly once per major time step should be placed in the update function.

Update Function

If the block has discrete state variables, the update function is called once dur-
ing a major time step after the output functions of all blocks have been pro-
cessed. During this call, the discrete state variables should be updated using
the DiscState macro.

Derivative Function

If the block has continuous state variables, the derivative function is called
during the integration loop of the solver. During this call, the continuous state
derivatives should be updated using the ContDeriv macro.

Derivatives should be continuous and smooth during minor time steps; discon-
tinuities or sharp bends should only occur during major time steps. For details
see “Modeling Discontinuities” below.

Terminate Function

The terminate function is called at the end of a simulation — regardless of
whether the simulation stop time has been reached, the simulation has been
stopped interactively, or an error has occurred. Use this function to free any re-
sources that you may have allocated during the start function (e.g. file handles,
memory etc.).
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Store Custom State Function

This function is called at the end of a simulation before the terminate function.
Use this function to store any custom values which are needed to restore the
state of the C-Script. Continuous and discrete states are automatically stored.
Use the macros WriteCustomStateDouble, WriteCustomStateInt and Write-
CustomStateData to serialize your data.

Restore Custom State Function

This function is called after the start function and before the first call of the
output function. The continuous and discrete states have already been restored
at this point. Use this function to initialize your block with a previously stored
custom state. Use the macros ReadCustomStateDouble, ReadCustomStateInt
and ReadCustomStateData to deserialize your data and SetErrorMessage to re-
port any issues to the user during restoring.

Code Declarations

This code section is used for global declarations and definitions (that is, global
in the scope of the C-Script block). This is the place to include standard library
headers (e.g. math.h or stdio.h) and to define macros, static variables and
helper functions that you want to use in the C-Script functions.

You can also include external source files. The directory containing the model
file is automatically added to the included search path, so you can specify the
source file path relative to the model file.

Modeling Discontinuities

If the behavior of your C-Script block changes abruptly at certain instants, you
must observe the following two rules in order to obtain accurate results:

1 If the time at which a discontinuity or event occurs is not known a priori but
depends on the block inputs and/or states, you must define one or more zero-
crossing signals, which aid the solver in locating the event. Failure to do so
may result in a jitter on the event times.

2 During minor time steps, continuous state derivatives and output signals
must be continuous and smooth functions. Failure to observe this may lead
to gross numerical integration errors.
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Defining Zero-crossing Functions

To define zero-crossing signals, register the required number of signals on

the Setup pane of the C-Script dialog. In the output function, use the macro
ZCSignal(i) to assign values to the individual zero-crossing signals depending
e.g. on the block inputs or states or the current simulation time. The solver con-
stantly monitors all zero-crossing signals of all blocks. If any one signal changes
its sign during the current integration step, the step size is reduced so that the
next major time step occurs just after the first zero-crossing. (See also “Event
Detection Loop” on page 34.)

For instance, to model a comparator that must change its output when the in-
put crosses a threshold of 1, you should define the following zero-crossing sig-
nal:

ZCSignal(0) = InputSignal(0, 0) - 1.;

Without the aid of the zero-crossing signal, the solver might make one step at
a time when the input signal is e.g. 0.9 and the next step when the input signal
has already increased to e.g. 1.23, so that the C-Script block would change its
output too late.

With the zero-crossing signal, and provided that the input signal is continuous,
the solver will be able to adjust the step size so that the C-Script output will
change at the correct time.

Note If a zero-crossing signal depends solely on the simulation time, i.e. if an
event time is known a priori, it is recommended to use a discrete-variable sam-
ple time and the NextSampleHit macro instead. (See “Discrete-Variable Sample
Time” below.)

Keeping Functions Continuous During Minor Time Steps

The solver integrates the continuous state derivatives over a given interval (i.e.
the current time step) by evaluating the derivatives at different times in the
interval. It then fits a polynomial of a certain order to approximate the integral.
(See also “Integration Loop” on page 34.) The standard Dormand-Prince solver,
for instance, uses 6 derivative evaluations and approximates the integral with a
polynomial of 5th order.
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Obviously, the derivative of this polynomial is again a polynomial of one order
less. On the other hand, to approximate a discontinuous or even just a non-
smooth derivative function, a polynomial of infinite order would be required.
This discrepancy may lead to huge truncation errors. It is therefore vital to de-
scribe the continuous state derivatives as piecewise smooth functions and make
sure that only one subdomain of these functions is active throughout one inte-
gration step.

The output signal of a C-Script block might be used as the input signal of an
integrator and thus might become the derivative of a continuous state variable.
Therefore, output signals should be described as piecewise smooth functions as
well.

Returning to the example of the comparator above, the complete output func-
tion code should look like this:

if (IsMajorStep)
{
if (InputSignal(0, 0) >= 1.)
OutputSignal(0, 0) = 1.;
else
OutputSignal(0, 0) = 0.;
}

ZCSignal(0) = InputSignal(0, 0) - 1.;

The condition if (IsMajorStep) ensures that the output signal can only
change in major steps. It remains constant during the integration loop regard-
less of the values that the input signal assumes during these minor time steps.
The zero-crossing signal, however, is also updated in minor time steps during
the event detection loop of the solver.

Sample Time

A C-Script block can model a continuous system, a discrete system, or even a
hybrid system having both continuous and discrete properties. Depending on
which kind of system you want to model, you need to specify an appropriate
Sample time on the Setup pane of the C-Script dialog. The sample time de-
termines at which time steps (and at which stages) the solver calls the different
C-Script functions.
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Continuous Sample Time

Blocks with a continuous sample time (setting 0 or [0, 0]) are executed at
every major and minor time step. You must choose a continuous sample time
if

¢ the C-Script models a continuous (or piecewise continuous) function,

¢ the C-Script has continuous states or,

¢ the C-Script registers one or more zero-crossing signals for event detection.

Semi-Continuous Sample Time

Blocks with a semi-continuous sample time (setting [0, -1]) are executed
at every major time step but not at minor time steps. You can choose a semi-
continuous instead of a continuous sample time if the C-Script produces only
discrete output values and does not need zero-crossing signals.

Discrete-Periodic Sample Time

Blocks with a discrete-periodic sample time (setting 7}, or [1},, T;,]) are exe-
cuted at regularly spaced major time steps. The sample period 7}, must be a
positive real number. The sample offset 7, must be a positive real number in
the interval 0 < T, < T}; it may be omitted if it is zero.

The time steps, at which the output and update functions are executed, are cal-
culated as n - T}, + T, with an integer n.

Discrete-Variable Sample Time

Blocks with a discrete-variable sample time (setting -2 or [-2, 0]) are exe-
cuted at major time steps that are specified by the blocks themselves.

In a C-Script you assign the time, when the block should be executed next, to
the macro NextSampleHit. This can be done either in the output or update func-
tion. At the latest, after the update function call, the NextSampleHit must be
greater than the current simulation time. Otherwise, the simulation will be
aborted with an error.

If a C-Script only has a discrete-variable sample time, the time of the first sam-
ple hit must be assigned in the start function. Otherwise, the C-Script will
never be executed. During the start function, the simulation start time is avail-
able via the macro CurrentTime.
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Note For discrete-variable sample times, PLECS Blockset can control the
time steps taken by the Simulink solvers only indirectly by using an internal
zero-crossing signal. Therfore, the actual simulation time at a discrete-variable
sample hit may be slightly larger than the value that was specified as the next
sample hit.

The solvers of PLECS Standalone, however, can evaluate the sample hit re-
quests directly and are therefore guaranteed to meet the requests exactly.

Multiple Sample Times

If you want to model a hybrid system, you can specify multiple sample times in
different rows of an n x 2 matrix. For example, if your C-Script has continuous
states but you must also ensure that it is executed every 0.5 seconds with an
offset of 0.1 seconds, you would enter [0, 0; 0.5, 0.1].

You can use the macro IsSampleHit (i) in the output and update functions in
order to inquire which of the registered sample times has a hit in the current
time step. The index i is a zero-based row number in the sample time matrix.
In the above example, if your C-Script should perform certain actions only at

the regular sampling intervals, you would write

if (IsSampleHit(1))
{
// this code is only executed at t == n*0.5 + 0.1

}

To access the sample times during execution of the C-Script, use the macros
SampleTimePeriod (i) and SampleTimeOffset(i). In the case of inherited sam-
ple times, the actual resolved values are returned, not [-1, 0] (see “Sample
Times” on page 38).

User Parameters

If you want to implement generic C-Scripts that can be used in different con-
texts, you can pass external parameters into the C functions.

External parameters are entered as a comma-separated list in the Parameters
field on the Setup pane of the C-Script dialog. The individual parameters can
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be specified as MATLAB expressions and can reference workspace variables.
They must evaluate to real scalars, vectors, matrices, 3d-arrays or strings.

Within the C functions you can inquire the number of external parameters with
the macro NumParameters. The macros ParamNumDims (i) and ParamDim(i, j)
return the number of dimensions of the individual parameters and their sizes.
In the case of strings, 1 and the length of the string measured in C characters
(char) is returned, respectively. Note that because the strings are UTF-8 en-
coded, the length returned by ParamDim(i, j) may be larger than the number
of unicode characters in the string.

To access the actual parameter values, use the macro ParamRealData(i, j),
where j is a linear index into the data array. For example, to access the value in
a certain row, column and page of a 3d-array, you write:

int rowIdx = 2;
int collIdx
int pageldx = 1;

int numRows Parambim(0, 0);

int numCols = ParamDim(0, 1);

int elIdx = rowIdx + numRows*(colIdx + numCols*pageldx);
double value = ParamRealData(0, elIdx);

Il
o

To access string parameters, use the macro ParamStringData(i). For example,
to use the second parameter as an error message, you may write:

SetErrorMessage (ParamStringData(1));

Runtime Checks

If the box Enable runtime checks on the Setup pane of the C-Script dialog
is checked, C-Script macros that access block data (e.g. signals values, states,
parameters etc.) are wrapped with protective code to check whether an array
index is out of range. Also, the C-Script function calls are wrapped with code
to check for solver policy violations such as modifying states during minor time
steps or accessing input signals in the output function without enabling direct
feedthrough.

These runtime checks have a certain overhead, so once you are sure that your
C-Script is free of errors you can disable them in order to increase the simula-
tion speed. This is not recommended, however, because in this case access viola-
tions in your C-Script may cause PLECS to crash.
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Note The runtime checks cannot guard you against access violations caused
by direct memory access.

C-Script Examples

This section presents a collection of simple examples that demonstrate the dif-
ferent features of the C-Script and that you can use as starting points for your
own projects. Note that the functionality of the example blocks is already avail-
able from blocks in the PLECS library.

A Simple Function - Times Two

The first example implements a block that simply multiplies a signal with 2.
This block is described by the following system equation:
y= foutput(ta U, Te, 'rd) =2-u

Block Setup The block has one input, one output, no states and no zero-
crossing signals. It has direct feedthrough because the output function depends
on the current input value. Since the output signal is continuous (provided that
the input signal is) the sample time is also continuous, i.e. [0, 0] or simply 0.

Output Function Code

OutputSignal(0, 0) = 2.*InputSignal(0, 0);
In every major and minor time step, the output function retrieves the current
input value, multiplies it with 2 and assigns the result to the output.
Discrete States - Sampled Delay

This example implements a block that samples the input signals regularly with
a period of one second and outputs the samples with a delay of one period. Such
a block is described by the following set of system equations:

y = foutput(taua Ic;zd) = T4

next
d

8
|

fupdate(tvu7xcyxd) = u
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Remember that in a major time step the solver first calls the block output func-
tion and then the block update function.

Block Setup The block has one input and one output. One discrete state vari-
able is used to store the samples. The block does not have direct feedthrough
because the input signal is not used in the output function but only in the up-
date function. The sample time is [1, 0] or simply 1.

Output Function Code
OutputSignal(0, 0) = DiscState(0);
Update Function Code

DiscState(0) = InputSignal(0, 0);

Continuous States - Integrator

This example implements a block that continuously integrates the input signal
and outputs the value of the integral. Such a block is described by the following
set of system equations:

y = foutput(t;u>$07xd) = T
Te = fderivative(tauaxcaxd) = u

Block Setup The block has one input and one output. One continuous state
variable is used to integrate the input signal. The block does not have direct
feedthrough because the input signal is not used in the output function but only
in the derivative function. The sample time is continuous, i.e. [0, 0] or simply
0.

Output Function Code

OutputSignal(0, 0) = ContState(0);
Derivative Function Code

ContDeriv(0) = InputSignal(0, 0);
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Event Handling - Wrapping Integrator

This examples extends the previous one by implementing an integrator that
wraps around when it reaches an upper or lower boundary (e.g. 27 and 0). Such
an integrator is useful for building e.g. a PLL to avoid round-off errors that
would occur if the phase angle increased indefinitely. This wrapping property
can actually not be easily described with mathematical functions. However, the
C code turns out to be fairly simple.

Block Setup The block has the same settings as in the previous example. Ad-
ditionally, it requires two zero-crossing signals, in order to let the solver find the
exact instants, at which the integrator state reaches the upper or lower bound-
ary.

Output Function Code

#define PI 3.141592653589793
if (IsMajorStep)
{
if (ContState(0) > 2*PI)
ContState(0) -= 2*PI;
else if (ContState(0) < 0)
ContState(0) += 2*PI;
}
ZCSignal(0)
ZCSignal(1)

ContState(0);
ContState(0) - 2*PI;

OutputSignal(0, 0) = ContState(0);

In every major time step, if the integrator state has gone beyond the upper or
lower boundary, 27 is added to or subtracted from the state so that it lies within
the boundaries again. In every major and minor time step, the zero-crossing
signals are calculated so that they become zero when the state is 0 resp. 27. Fi-
nally, the integrator state is assigned to the output.

Note, that the state must not be modified during minor time steps, because then
the solver is either itself updating the state (while integrating it) or trying to
find the zeros of the zero-crossing functions, which in turn depend on the state.
In either case an external modification of the state will lead to unpredictable
results.

Derivative Function Code

ContDeriv(0) = InputSignal(0, 0);
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Piecewise Smooth Functions - Saturation

This example implements a saturation block that is described by the following
piecewise system equation:

1, for u>1
y = foutput(tylhxc’xd) = u, for —1<u<l1
-1, for 1<u

When implementing this function, care must be taken to ensure that the active
output equation does not change during an integration loop in order to avoid
numerical errors (see “Modeling Discontinuities” on page 216).

Block Setup The block has one input, one output and no state variables. In
order to make sure that a major step occurs whenever the input signal crosses
the upper or lower limit, two zero-crossing signals are required.

Output Function Code

static enum { NO_LIMIT, LOWER_LIMIT, UPPER_LIMIT } mode;
if (IsMajorStep)

if (InputSignal(0, 0) > 1.)
mode = UPPER_LIMIT;
else if (InputSignal(0, 0) < -1.)
mode = LOWER_LIMIT;
else
mode = NO_LIMIT;
}

switch (mode)
{
case NO_LIMIT:
OutputSignal(0, 0)
break;
case UPPER_LIMIT:
OutputSignal(0, 0)
break;
case LOWER LIMIT:
OutputSignal(0, 0)
break;

InputSignal(0, 0);

1}
-

1
1
—_
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ZCSignal(0) = InputSignal(0, 0) + 1.;
ZCSignal(1) InputSignal(0, 0) - 1.;

Ensuring that only one output equation will be used throughout an entire inte-
gration step requires a static mode variable that will retain its value between
function calls. The active mode is determined in major time steps depending on
the input signal. In the subsequent minor time steps, the equation indicated by
the mode variable will be used regardless of the input signal.

If the step size were not properly limited and the input signal went beyond the
limits during minor time steps, so would the output signal. This is prevented
by the two zero-crossing signals that enable the solver to reduce the step size as
soon as the input signal crosses either limit.

Note Instead of the static mode variable, a discrete state variable could also
be used to control the active equation. In this particular application a static
variable is sufficient because information needs to be passed only from one ma-
jor time step to the subsequent minor time steps.

However, if information is to be passed from one major time step to a later ma-
Jor time step, a discrete state variable should be used, so that it can also be
stored between multiple simulation runs.

Multiple Sample Times - Turn-on Delay

A turn-on delay is often needed for inverter controls in order to prevent short-
circuits during commutation. When the input signal changes from 0 to 1, the
output signal will follow after a prescribed delay time, provided that the input
signal is still 1 at that time. When the input signal changes to 0, the output is
reset immediately.

Block Setup The block has one input and one output. One discrete state vari-
able is required to store the input signal value from the previous major time
step.

Two sample times are needed: a semi-continuous sample time so that the input
signal will be sampled at every major time step, and a discrete-variable sample
time to enforce a major time step exactly after the prescribed delay time. The
Sample time parameter is therefore set to [0, -1; -2, 0].
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As an additional feature the delay time is defined as an external user parame-
ter.

Code Declarations

#include <float.h>
#define PREV_INPUT DiscState(0)
#define DELAY ParamRealData(0, 0)

The standard header file float.h defines two numerical constants, DBL_MAX and
DBL_EPSILON, that will be needed in the output function. Additionally, two con-
venience macros are defined in order to make the following code more readable.

Start Function Code

if (NumParameters != 1)
{
SetErrorMessage("One parameter required (delay time).");
return;
}
if (ParamNumDims(0) != 2
|| ParamDim(0, 0) !=
|| DELAY <= 0.)

1 || ParamDim(0, 1) != 1

{
SetErrorMessage("Delay time must be a positive scalar.");
return;

}

The start function checks whether the proper number of external parameters
(i.e. one) has been provided, and whether this parameter has the proper dimen-
sions and value.

Output Function Code

if (InputSignal(0, 0) == 0)
{
OutputSignal(0, 0) = 0;
NextSampleHit = DBL_MAX;
}
else if (PREV_INPUT == 0)
{
NextSampleHit = CurrentTime + DELAY;
if (NextSampleHit == CurrentTime)
NextSampleHit = CurrentTime * (1.+DBL_EPSILON);
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else if (IsSampleHit(1))

{
OutputSignal(0, 0) = 1;
NextSampleHit = DBL_MAX;
}

If the input signal is 0, the output signal is also set to 0 according to the block
specifications. The next discrete-variable hit is set to some large number (in
fact: the largest possible floating point number) because it is not needed in this
case.

Otherwise, if the input signal is not 0 but it has been in the previous time step,
i.e. if it just changed from 0 to 1, a discrete-variable sample hit is requested at
DELAY seconds later than the current time.

Finally, if both the current and previous input signal values are nonzero and
the discrete-variable sample time has been hit, i.e. if the delay time has just
passed and the current input is still nonzero, the output is set to 1 and the next
discrete-variable hit time is again reset to the largest possible floating point
number.

The condition if (NextSampleHit == CurrentTime) requires special expla-
nation: If DELAY is very small and the current time is very large, the sum of
these two floating point numbers might again yield the current time value

due to roundoff errors, which would lead to a simulation error. In this case the
next sample hit is increased to the smallest possible floating point number that
is still larger than the current time. Admittedly, this problem will only occur
when the current time and the delay time are more than 15 decades apart, and
so it might be considered academic.

Update Function Code
PREV_INPUT = InputSignal(0, 0);

In the update function, the current input value is stored as the previous input
value for the following time step.

Store Custom State Code
WriteCustomStateDouble (NextSampleHit);

The previous input value is stored automatically because it is a discrete state.
The NextSampleHit has to be stored in the custom state.
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Restore Custom State Code
NextSampleHit = ReadCustomStateDouble();

Restore the NextSampleHit value. When the simulation starts from a stored
system state that was stored before this block was added to the schematic, the
read operation will fail and PLECS reports a runtime error.

Load External Files

The C-Script can be used to load external functions. In this example, the two
functions sum and product are defined in external files and executed via the C-
Script.

Header File

float sum(float a, float b);
float product(float a, float b);

Content of the file cscript_example_external_files.h.

C Source Code File

#include "cscript_example_external files.h"

float sum(float a, float b)

{
return a + b;
}
float product(float a, float b)
{
return a * b;
}

Content of the file cscript_example_external files.c.

229



8 C-Scripts

230

Code Declarations

#include "cscript_example_external_files.h"
#include "cscript_example_external_files.c"

#define
#define

#define
#define

In1 InputSignal(0,0)
In2 InputSignal(1,0)

Out1 OQutputSignal(0,0)
Out2 OutputSignal(1,0)

The external header and C source code files are loaded. Furthermore, two input
and two output variables are definded.

Output Function Code

Out1t
Out2

sum(Int,In2);
= product(In1,In2);

In the update function, the two output variables are updated with the sum and
product of the two input variables.

C-Script Macros

The following table summarizes the macros that can be used in the C-Script
function code sections.

C-Script Data Access Macros

Macro Type | Access | Description

NumInputTerminals int R Returns the number of input terminals.
NumOutputTerminals int R Returns the number of output terminals.
NumInputSignals int R Returns the number of elements (i.e. the width) of
(int i) the signal connected to the ith input terminal.
NumOutputSignals int R Returns the number of elements (i.e. the width) of
(int 1) the signal connected to the ith output terminal.
NumContStates int R Returns the number of continuous states.
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C-Script Data Access Macros (contd.)

Macro Type | Access | Description

NumDiscStates int R Returns the number of discrete states.

NumzZCSignals int R Returns the number of zero-crossing signals.

NumParameters int R Returns the number of user parameters.

CurrentTime double R Returns the current simulation time (resp. the
simulation start time during the start function
call).

NumSampleTime int R Returns the number of sample times.

SampleTimePeriod int R Returns the period of the ith sample time.

(int i)

SampleTimeOffset int R Returns the offset of the ith sample time.

(int 1)

IsMajorStep int R Returns 1 during major time steps, else 0.

IsSampleHit int R Returns 1 if the ith sample time currently has a

(int 1) hit, else 0.

NextSampleHit double R/W Specifies the next simulation time when the block
should be executed. This is relevant only for blocks
that have registered a discrete-variable sample
time.

InputSignal double R Returns the value of the jth element of the ith

(int i, int j) input signal terminal. See C-Script block (see page
381) for information on how to increase the default
number of input signal terminals.

OutputSignal double R/W Provides access to the value of the jth element of

(int i, int j)

the ith output signal terminal. See C-Script block
(see page 381) for information on how to increase
the default number of output signal terminals.
Output signals may only be changed during the
output function call.
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C-Script Data Access Macros (contd.)

Macro Type Access | Description

ContState double R/W Provides access to the value of the ith continu-

(int 1) ous state. Continuous state variables may not be
changed during minor time steps.

ContDeriv double R/W Provides access to the derivative of the ith contin-

(int i) uous state.

DiscState double R/W Provides access to the value of the ith discrete

(int i) state. Discrete state variables may not be changed
during minor time steps.

ZCSignal double R/W Provides access to the ith zero-crossing signal.

(int 1)

ParamNumDims int R Returns the number of dimensions of the ith user

(int i) parameter.

ParamDim int R Returns the jth dimension of the ith user parame-

(int i, int j) ter.

ParamRealData double R Returns the value of the jth element of the ith

(int i, int j) user parameter. The index j is a linear index
into the parameter elements. Indices into multi-
dimensional arrays must be calculated using the
information provided by the ParamNumDims and
ParamDim macros. If the parameter is a string, this
macro will produce a runtime error or an access
violation if runtime checks are disabled.

ParamStringData char* R Returns a pointer to a UTF-8 encoded, null-

(int i) terminated C string that represents the ith user

parameter. If the parameter is not a string, this
macro will produce a runtime error or returns NULL
if runtime checks are disabled.
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C-Script Data Access Macros (contd.)

Macro Type | Access | Description

WriteCustomStateDouble void W Write a custom state of type double, int or custom

(double val) data with 1en number of bytes. Use multiple calls
for multiple values.

WriteCustomStateInt void

(int val)

WriteCustomStateData void

(void *data, int 1len)

ReadCustomStateDouble() int R Read a custom state of type double, int or custom
data with 1en number of bytes. Use multiple calls

ReadCustomStateInt () double for multiple values.

ReadCustomStateData void

(void *data, int 1len)

SetErrorMessage void w Use this macro to report errors that occur in your

(char *msg) code. The simulation will be terminated after the
current simulation step. In general, this macro
should be followed by a return statement. The
pointer msg must point to static memory.

SetWarningMessage void w Use this macro to report warnings. The warning

(char *msg)

status is reset as soon as the current C-Script

function returns, so you do not need to reset it
manually. The pointer msg must point to static
memory.

Note The values of the input and output signals are not stored in contiguous

memory. Therefore, signal values may only be accessed by using the macros, not
by pointer arithmetic. For example, trying to access the second output using the

following code will fail:

double *output
output[1] = 1;
*(output + 1)
OutputSignal (0,

= &OutputSignal(0, 0); // not recommended
// fails

1
1

; =

// fails
1; /1 ok
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Note Prefer reading and writing of custom state variables with double and
int values over void* custom data. The latter cannot handle the byte order (big
endian, little endian) of your platform. To store a vector of doubles use the fol-
lowing code:

// platform independent code, recommended
WriteCustomStateInt(vectorSize);
for (int i = 0; i < vectorSize; ++i)

{
}

// platform dependent code, not recommended
WriteCustomStateData(&vectorSize, sizeof(vectorSize));
WriteCustomStateData(vector, vectorSize*sizeof (double));

WriteCustomStateDouble(vector[i]);

Deprecated Macros

The macros NumInputs, NumOutputs, Input(int i) and Output(int i) are dep-
recated but are still supported for C-Scripts that have only a single input and

output terminal.



State Machines

State machines are a formalism for event driven systems that move from one
discrete state to another in response to discrete events. PLECS lets you graph-
ically create and edit state machines using common concepts such as boxes for
states and curved arrows for transitions, and simulate them together with a
surrounding system. You can feed continuous or discrete signals into a state
machine e.g. to react to external events and output discrete signals from a state
machine e.g. as control signals. Actions are specified in the C programming lan-
guage and can be associated with states and transitions. Thanks to their built-
in timer events, state machines are equally useful for implementing supervi-
sory controls and complex modulators.

This chapter is subdivided into three sections. The first section describes how
you interact with the graphical editor to create and modify state machines. The
second section describes the semantics of a state diagram and how they influ-
ence the execution of the state machine. The third section contains examples
that highlight different features of the state machine.
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|
Working with State Machines

To create a new state machine, copy the State Machine block from the library
browser into your model. A double-click on the block opens a new window with
the state machine editor.

® OvenControl/Oven Control = |I:|| ﬂ

File Edit View Simulaton Window Format Help

e
12 % Qlf1|@
['Door]
~
DoorOpen DoorClosed
1 Door N NoHeating
»
. v
A |1
2 ActT=SetT +DeltaT ActT <SetT-DeltaT
Hw
1 s ™
Heating
Enter:
< )
Door 1 Heating = 1;
[ACtT <SetT] Exit:
Heating = 0;
T
| . J

State machine editor window

Note The State Machine uses a distinct editor. You cannot copy block dia-
gram components to a state chart or state machine elements to a block diagram
schematic.
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Working with States

A state is represented by a box with rounded corners. The name of the state is
displayed at the top of the box in a title bar with a gray background.

State

Enter:
/* enter action */

An empty state

To create a new state, click on the (3 button in the tool bar. Move the mouse
anywhere on the chart and click the left mouse button to place the new state.
To cancel the operation, press the Escape key, click the right mouse button, or
click anywhere outside the editor window.

To duplicate an existing state, hold down the Ctrl key (cmd key on macOS),
then click on the title bar of the state and drag the mouse to a new location in
the same or a different editor window.

To change the size of a state, move the mouse over one of the four corners so
that the pointer shape becomes a diagonal arrow. Hold down the mouse button,
drag the mouse until the dashed box has the desired size and release the mouse
button.

To change the name of a state, double-click on the name and edit it on the
chart. Valid state names must start with a letter and can contain only letters
and numbers. Whitespace, dashes or underscores are not allowed.

To edit the actions associated with the state, double-click on a free area within

the state. This will open a tabbed code editor, in which you can edit the Enter,

During and Exit actions for the state. If there is enough space, the action code
is also displayed on the state. By double-clicking on the code, you can edit it di-
rectly on the chart.

Hierarchical States

A state can contain other states. The containing state is called a super-state or
compound state, the contained state, a sub-state. A state that does not contain
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other states is called a leaf state. Compound states do not have a During ac-
tion.

To create hierarchical states, resize a state so that it is large enough to fully
surround another state, then move the other state into the first state.

SuperState

A super-state containing a sub-state

Note Overlapping states are forbidden and will produce an error message at
simulation start.

Working with Transitions

Transitions are represented by curved arrows from one state to another (or also
the same) state. To create a new transition, move the mouse over one of the
edges so that the pointer shape changes to crosshairs. Hold down the mouse
button, drag the mouse to another edge until the pointer shape changes to dou-
ble crosshairs and release the mouse button. If you release the mouse button
before the pointer shape has changed to double crosshairs, the operation is can-
celled.

To change the start point or end point of an existing transition, move the mouse
pointer over either end until the pointer shape changes to an open hand, then
hold down the mouse button and drag the mouse to the new location until the
pointer shape changes to a double crosshair. If you release the mouse button
before the pointer shape has changed to double crosshairs, the operation is can-
celled and the transition remains unchanged.

Depending on its shape, a transition may have one or more control handles that
become visible when you hover the mouse over the transition. To change the
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shape of the transition, hold down the mouse button over a control handle and
drag it to the desired location.

A double-click on a transition opens the Transition Editor. It allows you to edit
the Priority, Trigger, Condition and Action of the transition. The priority is
also displayed at the origin of the transition arrow, and a double-click lets you
edit it directly on the chart. Trigger, condition and action combined form the
transition label in the form Trigger [Condition] / Action, which is shown
next to the transition arrow. To change the location of the label along the tran-
sition, hold down the mouse button over the transition and drag it to the de-
sired location. By double-clicking on the label you can edit it directly on the
chart.

Trigger [Condition] / Action

Statel State2

A transition with labels and control handle

Default Transitions

A default transition is represented by a curved arrow originating from a black
dot. It is required on the top level of a state machine to define which state shall
become active at the beginning of a simulation. If a compound state is the di-
rect target of any transitions, it also requires an internal default transition to
define which of its sub-states shall become active when an incoming transition
is activated.

To create a new default transition, click on the % button in the tool bar. Move
the mouse anywhere on the chart and click the left mouse button to place the
origin of the default transition (marked with a dot). Then, move the mouse

to draw the transition to an edge of the desired target state and click the left
mouse button again. To cancel the operation, press the Escape key, click the
right mouse button, or click anywhere on the chart that is not the edge of a
state.
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Working with Junctions

Junctions are branching points that join or fork transitions. They are repre-
sented by circles. Junctions are useful e.g. if the state that shall become active
at the beginning of a simulation depends on one or more conditions. To create a
new junction, click on the G button in the tool bar.

[c] 1X2

Statel State2

A junction forking a default transition

Working with Annotations

Annotations are text blocks that you can place freely on a chart for documenta-
tion purposes. They have no influence on the execution of the state machine. To
create a new annotation, double-click on an empty space in the chart and start
typing. To move an annotation, hold down the mouse button over the annota-
tion and drag it to the desired location. To edit an annotation, double-click on it.
Choose Text alignment from the Format menu to change the text alignment
of the annotation.
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State Machine Configuration

To open the configuration editor, click on the -] button in the tool bar.

» State Machine Configuration: OvenConti ﬂ
Inputs | Outputs I Constants I Variables I C dedlarations I
ll Input variable | Type |
;I ActT continuous

SefT continuous
LI Door continuous
3

Hierarchical transition order: ITop to bottom ;I

Sample time: ID

Animation: i

oK I Cancel | Apply | Help |

State machine configuration editor

Input Signals

On the Inputs tab you define input signals that are fed from the surrounding
system into the state machine. Input signals are specified by an Input vari-
able and a Type.

The Input variable specifies the name with which you refer to the input signal
in actions or expressions. It is also displayed next to the corresponding input
terminal of the State Machine block. The variable name must be unique and

a valid C identifier, i.e. it must start with a letter and consist of only letters,
numbers and underscores.

The Type specifies whether the signal is a continuous signal or a trigger sig-
nal. For continuous and trigger signals, the actual signal value is assigned to
the input variable in every time step. For trigger signals, additionally an event
with the same name will be created when the input signal changes in the pre-
scribed way. A rising trigger event is created in the instant when the input sig-
nal changes from zero to non-zero, a falling trigger event is created in the in-
stant when the input signal changes from non-zero to zero. For trigger signals,
a trigger symbol is also displayed next to the corresponding input terminal of
the State Machine block.
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Note Signal changes from one non-zero value to another non-zero value, e.g.
from a negative value to a positive value, do not cause an event to be created.

Input signals appear on the State Machine block in the order in which they ap-
pear in the list. Use the four buttons to the left of the list to add or remove in-
puts or to change their order.

Output Signals

On the Outputs tab you define output signals that are fed from the state ma-
chine to the surrounding system. Output signals are defined by an Qutput
variable that specifies the name with which you refer to the output signal in
actions. It is also displayed next to the corresponding output terminal on the
State Machine block. The variable name must be unique and a valid C identi-
fier, i.e. it must start with a letter and consist of only letters, numbers and un-
derscores.

Output signals appear on the State Machine block in the order in which they
appear in the list. Use the four buttons to the left of the list to add or remove
outputs or to change their order.

Constants and Variables

On these tabs you define global variables that you can use in actions or expres-
sions. They must have a unique and valid C identifier, i.e. they must start with
a letter and consist of only letters, numbers and underscores.

Constants remain constant during a simulation. The value is determined by
the Value expression, which can be any valid MATLAB or Octave expression
that evaluates to a scalar number.

Variables can be modified by actions. They are in fact additional discrete state
variables in addition to the active state of the state machine. Their initial value
is determined by the Initial value expression, which can be any valid MAT-
LAB or Octave expression that evaluates to a scalar number.
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C Declarations

The C declarations tab is used for global declarations and definitions. It is
also the place to include standard library headers and to define macros and
static helper functions that you want to use in actions and expressions.

In addition to the user defined variables and functions, the following pre-
defined macros can be used in actions:

Predefined Action Macros

Macro

Type

Access

Description

CurrentTime

double

R

Returns the current simulation time.

SetErrorMessage (char *msg)

void

w

Use this macro to report errors that occur
in your code. The simulation will be termi-
nated after the current simulation step. In
general, this macro should be followed by
a return statement. The pointer msg must
point to static memory.

SetWarningMessage (char *msg)

void

Use this macro to report warnings. The
warning status is reset after the execution
of the current simulation step, so you do not
need to reset it manually. The pointer msg
must point to static memory.

Note User defined variable or function names must not start with fsm_ or
FSM_ because these prefixes are reserved for internal symbols in the generated

code.

Hierarchical Transition Order

This option is only relevant for hierarchical state machines (see “Hierarchical
States” on page 237 and “Execution of Hierarchical State Machines” on page
248). When both a super-state and its sub-states have outgoing transitions
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that are eligible to be taken at the same time, this option determines whether
transitions from the super-state take precedence over transitions from the sub-
states or vice versa.

Sample Time

This parameter determines how the state machine is executed. The table be-
low lists the valid parameter values for the different sample time types. For a
detailed description of the sample time types see “Sample Time” (on page 38).

Type Value

Continuous [0, OJorO

Discrete-Periodic | [7},, T,] or 7}, T,: Sample period, 7}, > 0
T,: Sample offset, 0 < T, < T,

Inherited [-1, O] or -1

With a Continuous sample time, the state machine is executed at every sim-
ulation step. With a Discrete-Periodic sample time, the state machine is exe-
cuted only at the regularly spaced simulation steps prescribed by the sample
time values. With an Inherited sample time, the actual sample time depends on
the blocks that are connected to the State Machine block.

Animation

This option is useful for debugging your state machine. When the option is
checked, the simulation is paused whenever a transition fires, and the tran-
sition path including the source and target state is highlighted. The simula-
tion can be continued by selecting Continue from the Simulation menu or by
pressing the Space key.
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State Machine Execution

A state machine is executed at each simulation step that the solver makes if it
has a continuous sample time or at the specified time steps if it has a discrete
sample time (see also “Sample Time” on page 244). During each execution, the
following steps are performed:

1 The triggers and conditions of all transitions leaving the currently active
state are evaluated.

2 If a transition “fires”, i.e. if both trigger and condition are true, the State Ma-
chine executes the Exit action of the current state followed by the transition
action and the Enter action of the target state.

3 If no transition fires, the During action of the current state is executed.

During each execution, at most one state change can occur, i.e. at most one
transition can be taken. Note that a transition may include one or more junc-
tions (see “Compound Transitions” below).

Transition Evaluation

A transition from an active state can be taken when the specified ¢rigger event
occurs, provided that the condition is true at the same time. Both trigger and
condition are optional. If a transition does not specify a trigger, any event (in-
cluding the mere execution of the state machine) will qualify so that the transi-
tion can be taken if the condition is true. If a transition does not specify a condi-
tion, it can be taken when the trigger event occurs.

Transition Priorities

It is possible that multiple transitions from the current state are eligible to be
taken at the same time. In this case, the transition with the lower priority num-
ber is given precedence.

Compound Transitions

A compound transition is a complete path from one leaf state to another (or the
same) leaf state consisting of two or more transitions joined by one or more
junctions. A compound transition can only be taken when all trigger events
specified by the individual transitions occur and all conditions specified by the
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individual transitions are true. If a compound transition is taken, the actions
of all individual transitions are executed in the order of the transitions on the
path.

Trigger Types

PLECS distinguishes between explicit, implicit and time-based triggers.

Explicit Trigger

An explicit trigger is an input signal that is configured as a trigger signal. It is
active whenever the input signal changes in the specified way. In the example
shown below, the event E is active whenever the signal connected to the input
terminal E changes from zero to a non-zero value or from a non-zero value to
zero. If Statel is active at this time, the transition fires.

T —
& E

State machine with explicit trigger

Note It is expected that the input signal for an explicit trigger changes only
at discrete instants. The signal source is responsible for registering an appro-
priate zero-crossing function to enable a variable-step solver to make a simula-
tion step at the instant at which the signal reaches or leaves zero.

Implicit Trigger

An implicit trigger is a relational expression. It is active when the expression

becomes true, i.e. if it evaluated to false in the previous time step and evaluates
to true in the current time step. If the state machine uses a continuous sample
time, an implicit trigger will also register a zero-crossing function to enable the
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solver to make a simulation step at precisely the instant at which the expres-
sion becomes true.

Notice the fundamental difference between an implicit trigger x > 0 and a con-
dition [x > 0] illustrated in the example below.

State2 Statel

1 x>0 1 [x>0]

Implicit trigger (left) versus condition (right)

In the left chart, if Statel is active, the transition will be taken only when x
becomes greater than 0. However, if x is already greater than 0 when Statel be-
comes active, nothing will happen until x becomes less than or equal to 0 and
afterwards greater than 0 again. If x is a continuous signal and the state ma-
chine uses a continuous sample time, the state machine will be executed pre-
cisely at the instant at which x crosses 0.

In the right chart, if Statel is active, the transition will be taken at any exe-
cution of the state machine if x happens to be greater than 0. If x is already
greater than 0 when Statel becomes active, the transition will be taken dur-
ing the next execution of the state machine. However, the execution of the state
machine does not necessarily coincide with the instant at which x crosses 0.

Time-Based Trigger

A time-based trigger is an expression of the form AFTER (delay), where delay is
an expression that evaluates to a number. If the state machine uses a continu-
ous sample time, the trigger event will be created exactly delay seconds after
the source state of the transition was entered. If the state machine uses a dis-
crete sample time, the trigger event will be created at the first execution time
following the delay period.

Trigger Lifetime

A trigger event is only valid in the simulation step in which it is created. If no
transition responds to the event in this time step, the event is ignored; it is not
deferred to a subsequent execution of the state machine.
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Execution of Hierarchical State Machines

In a hierarchical state machine it is not immediately obvious which transitions
are eligible to be taken, and which actions are executed when a transition is
taken.

Transition Evaluation

Only leaf states, i.e. states that do not contain other states, can be the active
state. But compound states that directly or indirectly contain the active state
are also implicitly active. When the state machine searches for a transition to
be taken, it not only evaluates the transitions leaving the active leaf state but
also those that leave the implicitly active compound states.

In the case where both a transition from a super-state and a transition from a
sub-state are eligible to be taken, the option Hierarchical Transition Order
in the State Machine Configuration dialog determines whether the transi-
tion leaving the super-state is given precedence over the transition leaving the
sub-state (top to bottom) or vice versa (bottom to top). Note that in this con-
text leaf states are considered to be at the bottom of a state hierarchy.

Execution Sequence

The two states that are directly connected by a transition are designated the
main source and the main target of the transition. Notice that source state and
target state may both be compound states. The lowest compound state that con-
tains both source state and target state is designated the lowest common an-
cestor (LCA) state. When the transition is taken, the following actions are exe-
cuted in this order:

1 The Exit actions of all states from the active leaf state (which may be the
main source state or a sub-state of it) up to (but not including) the LCA state
are executed from bottom to top.

2 The transition action is executed.

3 The Enter actions of the state hierarchy inside the LCA state to the main
target state are executed from top to bottom.

4 If the main target is a compound state, the action of its local default transi-
tion is executed followed by the Enter action of the default transition’s target
state. If necessary, this process is repeated recursively until a leaf state is
reached.
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This process is illustrated in the example below. Consider that S11 is the cur-
rently active state, so both S1 and S are also implicitly active.

p
s )
p
S1 S2
Exit: Enter: 521
S1_exit(); 1 T1/T1 action(); | S2_enter();
Exit: T e »| Enter:
it(): D_action(); :
S11_exit(); T2/ T2_action(); / D_ (L S21_enter();
\
N J

Execution sequence in a hierarchical state machine

Transition T1 has S1 and S2 as its main source and target. Their LCA state is
S. S2 is a compound state, and therefore after it has been entered, its internal
default transition causes S21 to be entered. Consequently, taking T1 causes
the following sequence of actions to be executed: S11_exit(); S1_exit();
T1_action(); S2_enter(); D_action(); S21_enter();.

Transition T2 has S11 and S21 as its main source and target. Their LCA state
is again S. Taking T2 causes the following sequence of actions to be executed:
S11_exit(); S1_exit(); T2_action(); S2_enter(); S21_enter();.

State Machine Example

Oven Control

This example demonstrates a simple oven control. While the oven is in oper-
ation, a hysteresis type control shall keep the oven temperature within a cer-
tain tolerance band around a set point by switching the heating on and off. As a
safety measure, we also want to ensure that the heating is always switched off
when the oven door is open.

The oven is modeled with a heat source, a thermal capacitance and resistance
and a thermometer. The oven control is implemented with a state machine. Its
inputs are the actual and the desired temperature and the status of the oven
door, which is defined as 0 when the door is open and 1 when the door is closed.
The state machine output is the command for the oven heating. The state ma-
chine uses a constant variable DeltaT that determines the limits of the toler-
ance band around the desired temperature.
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1
ActT>SetT+DeltaT ActT<SetT-DeltaT
1Y
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Heating = 0;
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Example of a simple oven control

The top-level states DoorOpen and DoorClosed reflect the actual state of the
oven door. The default transition, which is taken at the first execution of the
state machine, is branched with a Junction. If the door is initially open, the (i.e.
Door==0), DoorOpen state will be entered, else the DoorClosed state. Notice
that the unconditional “else” branch leaving the Junction has a lower prece-
dence than the conditional branch. Afterwards, the state machine will transi-
tion from DoorOpen to DoorClosed when Door becomes non-zero and vice
versa when the input variable Door becomes zero.

DoorClosed is a compound state. Therefore, when it is the target of a tran-
sition, its internal default transition will be executed, which is also branched
with a Junction. If the actual temperature is below the set point when the de-
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fault transition executes, the Heating state will be entered, else the NoHeat-
ing state. Afterwards, the state machine will transition from Heating to No-
Heating when the actual temperature becomes greater than the upper limit
and from NoHeating to Heating, when the actual temperature becomes less
than the lower limit.

The output variable Heating is set to 1 when the Heating state is entered, and
to 0 when the state is left. Notice that it does not matter whether the state is
left because the transition ActT>SetT+DeltaT is taken when the temperature
exceeds the upper limit, or because the transition !Door is taken when the oven
door is opened. In either case, the Exit action of Heating is executed and the
heating is turned off.

For this state machine to work properly, the Hierarchical Transition Order
must be set to top to bottom (which is the default). This is important because
a door opening event might coincide with the event that the actual temperature
exceeds the upper or lower limit. The higher-level door opening event must take
precedence over the lower-level temperature events so that the state machine
will unconditionally transition to the DoorOpen state.
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Simulation Scripts

Running simulations from a script allows you to perform automated tasks such
as examining the effect of varying parameters or post-processing the simulation
results to extract relevant information.

PLECS Standalone offers two different scripting methods:

¢ Simulation scripts written in Octave can be executed directly in PLECS
Standalone. This is described in section “Simulation Scripts in PLECS Stan-
dalone” (on page 253).

¢ PLECS offers an RPC interface that allows any other program that can send
XML-RPC or JSON-RPC requests to control PLECS. Many scripting lan-
guages support XML-RPC or JSON-RPC out of the box, for example Python
or Ruby. Other scripting language extensions for XML-RPC or JSON-RPC
support are available for free on the internet. This is described in section
“RPC Interface in PLECS Standalone” (on page 262).

In PLECS Blockset, scripts are written and executed in the MATLAB environ-
ment. Simulink offers a scripting interface to modify parameters and run simu-
lations from a script. A detailed description of the Simulink scripting options is
out of the scope of this manual, please refer to the documentation for Simulink
instead. PLECS Blockset offers additional commands to control the parameters
of PLECS Circuits. They are described in section “Command Line Interface in
PLECS Blockset” (on page 273).

Simulation Scripts in PLECS Standalone

Simulation scripts are managed in the Simulation Scripts dialog shown below.
To open the dialog, select Simulation scripts... from the Simulation menu of
the schematic editor.
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+4 Simulation Scripts: BuckParamSweep 1[

Description: IParameter Sweep

1 % create filename independent path to scope
2 mdl = plecs('get', '", 'CurrentCircuit'):

2 scope = [mdl "/Scope'];

4

2 ¥ create simStruct with field "ModelVars'

€ mdlVars = struct('warl', 50e-8);

7 zimStruct = struct('ModelVars', mdlVars);

8

8 plecs ('scope',scope, "ClearTraces');
10
11 inductorValues = [50, 100, 200]; -
4| | »
+ I = I Run Accept | Revert | Help I

The left hand side of the dialog window shows a list of the scripts that are cur-
rently configured for the model. To add a new script, click the button marked

+ below the list. To remove the currently selected script, click on the button
marked -. You can reorder the scripts by clicking and dragging an entry up and
down in the list.

The right hand side of the dialog window shows the script in an editor window.
Each script must have a unique Description.

The button Run/Stop starts the currently selected script or aborts the script
that is currently running.

To make changes to the script without running it, press the Accept button. The
Revert button takes back any changes that have been made after the Accept
or Run button was pressed.

PLECS Standalone uses GNU Octave to execute simulation scripts. The

Octave language is very similar to MATLAB. A full syntax description of
the Octave scripting language is available in the Octave documentation,

http://www.gnu.org/software/octave/doc/interpreter/.

Any console output generated by Octave will appear in the Octave Console
window, which you can open by choosing Show Console from the Window
menu.

Overview of PLECS Scripting Extensions

In addition to generic Octave commands you can use the following commands to
control PLECS from within a simulation script.


http://www.gnu.org/software/octave/doc/interpreter/index.html#Top
http://www.gnu.org/software/octave/doc/interpreter/index.html#Top

Simulation Scripts in PLECS Standalone

Clearing the Octave Console
The command
plecs('clc')

clears the console window. Note that the native Octave commands clc and home
do not have any effect on the console window.

Reading and Setting Component Parameters
The command

plecs('get', 'componentPath')
plecs('get', 'componentPath', 'parameter')

returns the value of parameter of the PLECS component indicated by the com-
ponentPath as a string. If parameter is omitted, a struct array with all available
parameters is returned.

plecs('set', 'componentPath', 'parameter', ‘'value')

sets the value of parameter of the PLECS component indicated by the compo-
nentPath to value.

The special parameter ’CurrentComponent’ can be used to query the path of
the current component as defined above. The component path has to be an
empty string:

plecs('get', '', 'CurrentComponent')

The special parameter *CurrentCircuit’ can be used to query the name of the
model that is currently executed. It cannot be queried interactively from the
console. The component path has to be an empty string:

plecs('get', '', 'CurrentCircuit')

This command is useful for constructing a component path that does not de-
pend on the model name.

A leading dot (.) in the component path is substituted with the current compo-
nent or model as described in “Path Substitution” (on page 259).
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Handling of Errors and Warnings in Initialization Commands

During the execution of model or mask initialization commands, error messages
issued with the Octave command error are caught by PLECS and shown in the
Diagnostics window. To show a warning message in the Diagnostics window,
use the command

plecs('warning', 'warning message')

Note that the native Octave command warning will only print the warning mes-
sage to the Octave console.

Handling of Traces in Scopes

plecs('scope', 'scopePath', 'HoldTrace')
plecs('scope', ‘'scopePath', 'HoldTrace', 'traceName')

saves the values of the last simulation to a new trace in the scope indicated by
the scopePath. If given and unique, traceName is used as the name for the new
trace, otherwise a default name is assigned. In both cases the method returns
the name given to the trace.

plecs('scope', 'scopePath', 'RemoveTrace', 'traceName')

removes the trace named traceName from the scope indicated by the scopePath.
plecs('scope', 'scopePath', 'ClearTraces')

clears all traces in the scope indicated by the scopePath.
plecs('scope', ‘'scopePath', 'SaveTraces', 'fileName')

saves the trace data of the scope at scopePath to the file fileName for later refer-
ence. If fileName is not an absolute path, it is interpreted relative to the model
file that contains the scope.

plecs('scope', 'scopePath', 'LoadTraces', 'fileName')
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loads the trace data from the file fileName into the scope at scopePath. If file-
Name is not an absolute path, it is interpreted relative to the model file that
contains the scope.

The scopePath is the path to the scope within the model including the model
name, e.g. 'DTC/Mechanical’. To access Bode plots from the analysis tools, use
the model name followed by ’ /Analyses/’ followed by the name of the analysis,
e.g. 'BuckOpenLoop/Analyses/Control to Output TF (AC Sweep)’. A leading
dot (.) in the scope path is substituted with the current component or model as
described in “Path Substitution” below.

Retrieving Scope Cursor Data

plecs('scope', 'scopePath', 'GetCursorData', [t1 t2])
plecs('scope', 'scopePath', 'GetCursorData', [t1 t2],
‘analysisl', 'analysis2', ...)

returns a struct with the signal values and analysis results (as specified) for the
cursor positions t1 and t2. Valid analysis names are delta, min, max, absmax,
mean, rms and thd. For more information about scope cursors see section “Cur-
sors” (on page 103).

The return value is a struct with the two fields time and cursorData. The field
time is the vector [t1, t2]. The field cursorData is a nested cell array where
the outer index corresponds to the number of plots in the scope and the inner
index corresponds to the number of signals in a plot. Each cell is a struct with
the fields cursor1 and cursor2 with the signal values and additional fields for
the analyses that you have specified. If the scope has multiple traces, the field
values are vectors with one element for each trace.

So, if the return value is stored in data, to access the signal value at cursor 2
for the third trace of the second signal in the first plot, you write

data.cursorData{1}{2}.cursor2(3)

Exporting Scope Data

plecs('scope', 'scopePath', 'ExportCSV', 'fileName")
plecs('scope', 'scopePath', 'ExportCSV', 'fileName', [t1 t2])

saves all scope data or only the specified time range as comma separated values

to the text file fileName. If fileName is not an absolute path, it is interpreted
relative to the model file that contains the scope.
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Exporting Scope Bitmaps

plecs('scope', 'scopePath', 'ExportBitmap', 'fileName')
plecs('scope', ‘'scopePath', 'ExportBitmap', 'fileName', ...)

saves a bitmap of the scope to the file fileName. If fileName is not an absolute
path, it is interpreted relative to the model file that contains the scope. The file
format is determined automatically from the file extension. The fileName ar-
gument may be followed by one or more name/value pairs to override settings
defined in the scope as follows:

Scope Settings for Bitmap Export

Name Description

Size A two-element integer vector specifying the width and
height of the bitmap in pixels.

Resolution An integer specifying the resolution of the bitmap in
pixels per inch.

TimeRange A two-element real vector specifying the time range of
the data to be shown.

XLim A two-element real vector specifying the limits of
the x-axis. For a normal scope this is equivalent to
TimeRange.

YLim A cell array containing two-element real vectors speci-

fying the limits of the y-axis of the plot(s). For a scope
with a single plot a vector may be given directly.

XLabel A string specifying the x-axis label.

YLabel A cell array containing strings specifying the y-axis la-
bels of the plot(s). For a scope with a single plot a string
may be given directly.

Title A cell array containing strings specifying the title of the
plot(s). For a scope with a single plot a string may be
given directly.
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Scope Settings for Bitmap Export (contd.)

Name Description

LegendPosition | A string specifying the legend position. Possible values
are none, topleft, topmiddle, topright, bottomleft,
bottommiddle and bottomright.

Font A string specifying the font name to be used for the
labels and the legend.

LabelFontSize An integer specifying the label font size in points.

LegendFontSize | An integer specifying the legend font size in points.

Path Substitution

If a component or scope path is a simple dot (.) or starts with a dot followed by
a slash (. /), the dot is substituted with the current component.

When a command is executed interactively from the console, the current com-
ponent is the last component that was clicked on in the schematic editor; if the
last click was not on a component, the current component is undefined.

During the evaluation of block parameters or mask initialization commands
the current component is the component that is currently evaluated; during the
evaluation of the model initialization commands it is the model itself.

Running a Simulation

plecs('simulate')
plecs('simulate', optStruct)

runs a simulation. The optional argument optStruct can be used to override
model parameters; for detailed information see section “Scripted Simulation
and Analysis Options” (on page 268).

If any outports exist on the top level of the simulated model, the command re-
turns a struct consisting of two fields, Time and Values. Time is a vector of sim-
ulation time stamps. Values is an m X n array containing the output values,
where m is the number of time stamps and n is the number of output signals.
The order of the signals is determined by the port numbers.
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By default, the simulation result contains all simulation steps that the solver
makes. This can be controlled with the solver options OutputTimes and Output-
TimesOption, where OutputTimes is a double vector and OutputTimesOption is
a string as described in the table “Control of Output Times in Scripted Simula-
tions” (on page 271).

Running an Analysis

plecs('analyze', 'analysisName')
plecs('analyze', 'analysisName', optStruct)

runs the analysis defined in the Analysis Tools dialog under the name analysis-
Name. The optional argument optStruct can be used to override model param-
eters; for detailed information see section “Scripted Simulation and Analysis
Options” (on page 268).

For a Steady-State Analysis, if any outports exist on the top level of the simu-
lated model, the command returns a struct consisting of two fields, Time and
Values as described above. The signal values at the outports are captured after
a steady-state operating point has been obtained. By default, the simulation re-
sult contains all simulation steps that the solver makes. This can be controlled
with the solver options OutputTimes and OutputTimesOption, where Output-
Times is a double vector and OutputTimesOption is a string as described in the
table “Control of Output Times in Scripted Simulations” (on page 271).

For an AC Sweep, an Impulse Response Analysis or a Multitone Analysis, the
command returns a struct consisting of three fields, F, Gr and Gi. F is a vector
that contains the perturbation frequencies of the analysis. The rows of the ar-
rays Gr and Gi consist of the real and imaginary part of the transfer function as
defined in the analysis. If the command is called without a return value, a scope
window will open and display the Bode diagram of the transfer function.

Running Multiple Simulations or Analyses in Parallel

Instead of a single optStruct argument you can also pass a 1 x N cell array of
option structures to the simulate and analyze commands:

plecs('simulate', optStructs)
plecs('analyze', 'analysisName', optStructs)
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PLECS will then automatically distribute the individual simulations or anal-
yses to the CPU cores available on your computer. After completion, the com-
mands return a 1 x N cell array containing the individual result structs or —
in case of a runtime error — a string with the error message. To avoid memory
problems when running a large number of parallel simulations, you can define
an appropriate OutputTimes vector in the SolverOpts struct in order to reduce
the number of data points.

Additionally, you can define a callback function that is called whenever an in-
dividual simulation or analysis has completed. The arguments of this callback
function are the index of the corresponding option set in the input cell array
and the result of the simulation or analysis. The return value of the callback
function is stored in the output cell array instead of the simulation or analysis
result.

The following code example shows how such a callback function can be used
to replace the simulation result with a single aggregated value (the maximum
value of a certain output signal).

% Aggregate the simulation results in a callback function.
function result = callback(index, result)
if isstruct(result)

[

% with the maximum value of the first output signal.
result = max(result.Values(1,:));
end
end

out = plecs('simulate', optStructs,
@(index, result) callback(index, result));

The notation using an anonymous function handle is due to a technical limita-
tion of Octave 4.4 regarding nested functions.
Example Script

The following script runs a parameter sweep by setting the variable varL to the
values in inductorValues. It is used in the demo model BuckParamSweep.

mdlVars = struct('varL', 50e-6);
opts = struct('ModelVars', mdlvVars);

plecs('scope', './Scope', 'ClearTraces');

% If the simulation succeeded, replace the simulation result
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inductorValues = [50, 100, 200];
for ix = 1:length(inductorValues)
opts.ModelVars.varL=inductorValues(ix) * 1e-6;
out = plecs('simulate', opts);
plecs('scope', './Scope', 'HoldTrace',
['L=" mat2str(inductorValues(ix)) 'uH']);
[maxv, maxidx] = max(out.Values(1,:));
printf('Max current for L=%duH: %f at %fs\n',
inductorValues(ix), maxv, out.Time(maxidx));
end

The first two lines create a struct ModelVars with one field, varL. The struct is
embedded into another struct named opts, which will be used later to initialize
the simulation parameters.

Inside the for-loop each value of inductorvalues is assigned successively to

the structure member variable varL. A new simulation is started, the result

is saved in variable out for post-processing. By holding the trace in the scope
the scope output will remain visible when a new simulation is started; the scope
path uses a dot to reference the current model (see “Path Substitution” on page
259). The name of the trace is the inductance value.

The script then searches for the peak current in the simulation results and out-
puts the value and the time, at which it occurred, in the Octave Console.

RPC Interface in PLECS Standalone

The RPC interface allows you to control PLECS Standalone from an external
program. PLECS acts as an HTTP server which processes XML-RPC! or JSON-
RPC? requests from clients. PLECS automatically determines the actual pro-
tocol used by a client from the request and sends the response using the same
protocol.

The RPC interface in PLECS is disabled by default. It must be enabled in the
PLECS preferences before a connection can be established. The TCP port to use
can also be configured in the PLECS preferences.

Thttp://xmlrpc.com
2https://www. jsonrpc.org

262



RPC Interface in PLECS Standalone

Note RPC connections to PLECS are only allowed from clients running on the
same computer as PLECS. Therefore, the connection should always be initiated

using localhost in the server URL.

Usage Examples

The code examples in this section assume that PLECS is configured to use TCP

port 1080 for RPC.

Using XML-RPC in Python
The following Python 3 code initializes an XML-RPC client for PLECS:

import xmlrpc.client
proxy = xmlrpc.client.ServerProxy("http://localhost:1080")

Using JSON-RPC in MATLAB

To facilitate interaction between PLECS Standalone and MAT-

LAB, Plexim provides a MATLAB class that can be downloaded from
https://github.com/plexim/matlab-jsonrpc. After copying the class file
jsonrpc.m to your MATLAB path, you can initialize a JSON-RPC client for
PLECS as follows:

proxy = jsonrpc('http://localhost:1080")

Overview of RPC Commands

Commands for PLECS start with plecs followed by a dot. If you are using a
Python or MATLAB client as described above, you invoke a command by ap-
pending it to the proxy object using a dot, e.g.:

proxy.plecs.load('C:/path/to/myModel.plecs')
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Opening and Closing a Model
The command
plecs.load('mdlFileName')

opens the model with the given mdlFileName. The filename should contain the
absolute path to the file.

The command
plecs.close('mdIName')

closes the model with the given name. The model will be closed unconditionally
without being saved, even if it has unsaved changes.

Reading and Setting Component Parameters

The command

plecs.get('componentPath')
plecs.get('componentPath', 'parameter')

returns the value of parameter of the PLECS component indicated by the com-

ponentPath as a string. If parameter is omitted, a struct array with all available
parameters is returned.

plecs.set('componentPath', 'parameter', 'value')

sets the value of parameter of the PLECS component indicated by the compo-
nentPath to value.

Handling of Traces in Scopes

plecs.scope( 'scopePath', 'HoldTrace')
plecs.scope( 'scopePath', 'HoldTrace', 'traceName')

saves the values of the last simulation to a new trace in the scope indicated by
the scopePath. If given, traceName is used as the name for the new trace, other-
wise a default name is assigned.
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plecs.scope( 'scopePath', 'RemoveTrace', 'traceName')

removes the trace named traceName from the scope indicated by the scopePath.
plecs.scope( 'scopePath', 'ClearTraces')

clears all traces in the scope indicated by the scopePath.
plecs.scope( 'scopePath', 'SaveTraces', 'fileName')

Saves the trace data of the scope at scopePath to the file fileName for later
reference. If fileName is not an absolute path, it is interpreted relative to the
model file that contains the scope.

plecs.scope( 'scopePath', 'LoadTraces', 'fileName')

Loads the trace data from the file fileName into the scope at scopePath. If file-
Name is not an absolute path, it is interpreted relative to the model file that
contains the scope.

The scopePath is the path to the scope within the model including the model
name, e.g. 'DTC/Mechanical’. To access Bode plots from the analysis tools, use
the model name followed by ’ /Analyses/’ followed by the name of the analysis,
e.g. ’BuckOpenLoop/Analyses/Control to Output TF (AC Sweep)’.

Running a Simulation

The command

plecs.simulate('mdIName")
plecs.simulate('mdIName', optStruct)

runs a simulation of the model named mdI/Name. The optional argument opt-
Struct can be used to override model parameters and solver options; for more
information about this struct see section “Scripted Simulation and Analysis Op-
tions” (on page 268).

If any outports exist on the top level of the simulated model, the command re-
turns a struct consisting of two fields, Time and Values. Time is a vector of sim-
ulation time stamps. Values is an m X n array containing the output values,
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where m is the number of time stamps and n is the number of output signals.
The order of the signals is determined by the port numbers.

By default, the simulation result contains all simulation steps that the solver
makes. This can be controlled with the solver options OutputTimes and Output-
TimesOption, where OutputTimes is a double vector and OutputTimesOption is
a string as described in the table “Control of Output Times in Scripted Simula-
tions” (on page 271).

Note Running a simulation is a blocking command. The RPC server can exe-
cute only one blocking command at a time and will answer requests to execute
a second blocking command with an error message. If you want to run multiple
simulations in parallel via RPC, see “Running Multiple Simulations or Analy-
ses in Parallel” (on page 267).

Running an Analysis

The command

plecs.analyze('mdIName', 'analysisName')
plecs.analyze('mdIiName', 'analysisName', optStruct)

runs the analysis named analysisName in the model named mdIName. The op-
tional argument optStruct can be used to override model parameters; for de-
tailed information see section “Scripted Simulation and Analysis Options” (on
page 268).

For a Steady-State Analysis, if any outports exist on the top level of the simu-
lated model, the command returns a struct consisting of two fields, Time and
Values as described above. The signal values at the outports are captured after
a steady-state operating point has been obtained. By default, the simulation re-
sult contains all simulation steps that the solver makes. This can be controlled
with the solver options OutputTimes and OutputTimesOption, where Output-
Times is a double vector and OutputTimesOption is a string as described in the
table “Control of Output Times in Scripted Simulations” (on page 271).

For an AC Sweep, an Impulse Response Analysis or a Multitone Analysis, the
command returns a struct consisting of three fields, F, Gr and Gi. F is a vector
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that contains the perturbation frequencies of the analysis. The rows of the ar-
rays Gr and Gi consist of the real and imaginary part of the transfer function as
defined in the analysis.

Note Running an analysis is a blocking command. The RPC server can exe-
cute only one blocking command at a time and will answer requests to execute
a second blocking command with an error message. If you want to run multiple
analyses in parallel via RPC, see “Running Multiple Simulations or Analyses in
Parallel” below.

Running Multiple Simulations or Analyses in Parallel

Instead of a single optStruct argument you can also pass a list of option struc-
tures to the simulate and analyze commands:

plecs.simulate('mdIName', optStructs)
plecs.analyze('mdIName', 'analysisName', optStructs)

PLECS will then automatically distribute the individual simulations or anal-
yses to the CPU cores available on your computer. After completion, the com-
mands return a list containing the individual result structs or — in case of a
runtime error — a string with the error message. To avoid memory problems
when running a large number of parallel simulations, you can define an appro-
priate OutputTimes vector in the SolverOpts struct in order to reduce the num-
ber of data points.

Example Script

The following Python script establishes an XML-RPC connection, loads a model
and simulates it twice. The scope output from each simulation is preserved by
holding the traces in the scope.

import xmlrpc.client
proxy = xmlrpc.client.ServerProxy("http://localhost:1080")

proxy.plecs.load("C:/Models/BuckParamSweep.plecs")
proxy.plecs.scope('BuckParamSweep/Scope', 'ClearTraces')
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opts = {'Modelvars' : { 'varL' : 50e-6 } }
result = proxy.plecs.simulate("BuckParamSweep", opts)
proxy.plecs.scope('BuckParamSweep/Scope',

'HoldTrace', 'L=50uH')

opts[ 'ModelVars']['varL'] = 100e-6;
result = proxy.plecs.simulate("BuckParamSweep", opts)
proxy.plecs.scope( 'BuckParamSweep/Scope',

"HoldTrace', 'L=100uH')

Scripted Simulation and Analysis Options

When you start a simulation or analysis from a Simulation Script or via RPC,
you can pass an optional argument optStruct in order to override parameter
settings defined in the model. This enables you to run simulations for different
scenarios without having to modify the model file.

The argument optStruct is a struct that may contain the fields OutputFormat,
ModelVars, SolverOpts and — when starting an analysis — AnalysisOpts, which
are again structs as described below.

OutputFormat The optional field OutputFormat is a string that lets you
choose whether the results of a simulation or analysis should be returned as a
RPC struct (Plain) or in binary form using the MAT-file format (MatFile). The
binary format is much more efficient if the result contains many data points,
but the client may not be able to interpret it, so the default is P1ain.

ModelVars The optional field ModelVars is a struct variable that allows you
to override variable values defined by the model initialization commands. Each
field name is treated as a variable name; the field value is assigned to the cor-
responding variable. Values can be numerical scalars, vectors, matrices or 3d
arrays or strings.

The override values are applied after the model initialization commands have
been evaluated and before the component parameters are evaluated as shown
in the figure below.

SolverOpts The optional field SolverOpts is a struct variable that allows you
to override the solver settings specified in the Simulation Parameters dialog.
Each field name is treated as a solver parameter name; the field value is as-
signed to the corresponding solver parameter. The following table lists the pos-
sible parameters.
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Script
start

v

Model
initialization
commands

v

Script
execution

End

Start
plecs.simulate()
* plecs.analyze()
Model
_’ initialization
commands
plecs('simulate')
plecs('analyze') *
. ModelVars ModelVars
evaluation XMLRPC evaluation
* client *
Component process Component
parameter parameter
evaluation evaluation
¢ Model < Model
simulation simulation
End

Execution order for Simulation Scripts (left) and RPC (right)

Solver Options in Scripted Simulations

Parameter

Description

Solver

The solver to use for the simulation. Possible values
are auto, dopri, radau and discrete. See section
“Standalone Parameters” (on page 111) for more de-
tails.

StartTime

The start time specifies the initial value of the simula-
tion time variable ¢ at the beginning of a simulation,
in seconds (s).

TimeSpan

The simulation ends when the simulation time has
advanced by the specified time span.
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Solver Options in Scripted Simulations (contd.)

Parameter

Description

StopTime

This option is obsolete. It is provided to keep old
scripts working. We strongly advise against using it
in new code.

OutputTimes
OutputTimesOption

These options control the simulation times that are
included in the result of a scripted simulation. See the
table below.

InitialSystemState

Specifies the initial system state used for the simu-
lation. This will override the System State setting
in the simulation parameters (see “System State” on
page 117).

The system state struct can be retrieved after the
completion of a simulation or steady-state analysis
using the command

plecs(’get’, 'mdIName’, ’SystemState’)

MaxStep

See the description for Max Step Size in section
“Standalone Parameters” (on page 111). This option is
only evaluated for variable step solvers.

InitStep

See the description for Initial Step Size in section
“Standalone Parameters” (on page 111). This option is
only evaluated for variable step solvers.

FixedStep

This option specifies the fixed time increments for the
solver and also the sample time used for the state-
space discretization of the physical model. It is only
evaluated for the fixed step solver.

AbsTol

See the description for Tolerances in section “Stan-
dalone Parameters” (on page 111).

RelTol

See the description for Tolerances in section “Stan-
dalone Parameters” (on page 111).

Refine

See the description for Refine factor in section
“Standalone Parameters” (on page 111).
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Control of Output Times in Scripted Simulations

OutputTimesOption | Interpretation of OutputTimes

specified The simulation result contains only the simulation
times specified in the OutputTimes vector.

This is also the default behavior if only the vector Out-
putTimes is provided and OutputTimesOption is omit-
ted.

additional The simulation result contains the simulation times
specified in the OutputTimes vector in addition to all
simulation steps that the solver makes.

range The simulation result contains all simulation steps that
the solver makes within the time span from Output-
Times (1) to OutputTimes(end).

If the vector OutputTimes contains more than two val-
ues, the additional simulation times are also included
in the result.

AnalysisOpts For an analysis the optional field AnalysisOpts is a struct
variable that allows you to override the analysis settings defined in the Analy-
sis Tools dialog. Each field name is treated as an analysis parameter name, the
field value is assigned to the corresponding analysis parameter. The following
tables list the possible parameters

Analysis Options in Scripted Analyses

Parameter Description

TimeSpan System period length; this is the least common mul-
tiple of the periods of independent sources in the
system.

StartTime Simulation start time.

Tolerance Relative error tolerance used in the convergence
criterion of a steady-state analysis.
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Analysis Options in Scripted Analyses (contd.)

Parameter Description

MaxIter Maximum number of iterations allowed in a steady-
state analysis.

JacobianPerturbation | Relative perturbation of the state variables used to
calculate the approximate Jacobian matrix.

JacobianCalculation Controls the way the Jacobian matrix is calculated
(full, fast). The default is fast.

InitCycles Number of cycle-by-cycle simulations that should
be performed before the actual analysis. This pa-
rameter can be used to provide the initial steady-
state analysis with a better starting point.

ShowCycles Number of steady-state cycles that should be sim-
ulated at the end of an analysis. This parameter is
evaluated only for a steady-state analysis.

FrequencyRange Range of the perturbation frequencies. This param-
eter is evaluated only for a small-signal analysis.

FrequencyScale Specifies whether the sweep frequencies should

be distributed on a 1inear or logarithmic scale.
This parameter is evaluated only for a small-signal
analysis.

AdditionalFreqgs A vector specifying frequencies to be swept in ad-
dition to the automatically distributed frequencies.
This parameter is evaluated only for a small-signal
analysis.

NumPoints The number of automatically distributed perturba-
tion frequencies. This parameter is evaluated only
for a small-signal analysis.

Perturbation The full block path (excluding the model name)
of the Small Signal Perturbation block that will
be active during an analysis. This parameter is
evaluated only for a small-signal analysis.
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Analysis Options in Scripted Analyses (contd.)

Parameter Description

Response The full block path (excluding the model name) of
the Small Signal Response block that will record
the system response during an analysis. This pa-
rameter is evaluated only for a small-signal analy-
sis.

AmplitudeRange The amplitude range of the sinusoidal perturba-
tion signals for an ac sweep. This parameter is
evaluated only for an ac sweep.

Amplitude The amplitude of the discrete pulse perturbation
for an impulse response analysis. This parameter is
evaluated only for an impulse response analysis.

MaxNumberOfThreads The maximum number of parallel threads that may
be used during the analysis.

ShowResults Specifies whether to show a Bode plot after a small-
signal analysis. This parameter is evaluated only
for a small-signal analysis.

Command Line Interface in PLECS Blockset

PLECS Blockset offers a Command Line Interface (CLI) to access component
and circuit parameters from scripts or directly from the MATLAB command
line. The command syntax is

plecs('emd', 'parameterl', 'parameter2', ...)

where cmd is one of the following commands: get, set, scope, thermal, export,
version, hostid.

Reading and Setting Parameters of Components

The command
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plecs('get', 'componentPath')
plecs('get', 'componentPath', 'parameter')

returns the value of parameter of the PLECS component indicated by the com-
ponentPath as a string. If parameter is omitted, a struct array with all available
parameters is returned.

plecs('set', 'componentPath', 'parameter', ‘'value')

sets the value of parameter of the PLECS component indicated by the compo-
nentPath to value.

The special parameter ’CurrentCircuit’ can be used to query the path to the
current PLECS Circuit. The component path has to be an empty string:

plecs('get', '', 'CurrentCircuit')

This command can only be used in the initialization commands of subsystems.

Handling of Errors and Warnings in Initialization Commands

During the execution of mask initialization commands, error messages issued
with the MATLAB command error are caught by PLECS and shown in the Di-
agnostics window. To show a warning message in the Diagnostics window, use
the command

plecs('warning', 'warning message')

Note that the native MATLAB command warning will only print the warning
message to the MATLAB command window.

Handling of Traces in Scopes

plecs('scope', ‘'scopePath', 'HoldTrace')
plecs('scope', 'scopePath', 'HoldTrace', 'traceName')

saves the values of the last simulation run to a new trace in the scope indicated
by the scopePath. If given and unique, traceName is used as the name for the
new trace, otherwise a default name is assigned. In both cases the method re-
turns the name given to the trace.
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plecs('scope', 'scopePath', 'RemoveTrace', 'traceName')

removes the trace named traceName from the scope indicated by the scopePath.
plecs('scope', 'scopePath', 'ClearTraces')

clears all traces in the scope indicated by the scopePath.
plecs('scope', 'scopePath', 'SaveTraces', 'fileName')

Saves the trace data of the scope at scopePath to the file fileName for later
reference. If fileName is not an absolute path, it is interpreted relative to the
model file that contains the scope.

plecs('scope', 'scopePath', 'LoadTraces', 'fileName')

Loads the trace data from the file fileName into the scope at scopePath. If file-
Name is not an absolute path, it is interpreted relative to the model file that
contains the scope.

Retrieving Scope Cursor Data

plecs('scope', 'scopePath', 'GetCursorData', [t1 t2])
plecs('scope', 'scopePath', 'GetCursorData', [t1 t2],
‘analysisl', 'analysis2', ...)

returns a struct with the signal values and analysis results (as specified) for the
cursor positions t1 and t2. Valid analysis names are delta, min, max, absmax,
mean, rms and thd. For more information about scope cursors see section “Cur-
sors” (on page 103).

The return value is a struct with the two fields time and cursorData. The field
time is the vector [t1, ts]. The field cursorData is a nested cell array where
the outer index corresponds to the number of plots in the scope and the inner
index corresponds to the number of signals in a plot. Each cell is a struct with
the fields cursor1 and cursor2 with the signal values and additional fields for
the analyses that you have specified. If the scope has multiple traces, the field
values are vectors with one element for each trace.

So, if the return value is stored in data, to access the signal value at cursor 2
for the third trace of the second signal in the first plot, you write

data.cursorData{1}{2}.cursor2(3)
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Exporting Scope Data

plecs('scope', 'scopePath', 'ExportCSV', 'fileName')
plecs('scope', ‘'scopePath', 'ExportCSV', 'fileName', [t1 t2])

saves all scope data or only the specified time range as comma separated values
to the text file fileName. If fileName is not an absolute path, it is interpreted
relative to the model file that contains the scope.

Exporting Scope Bitmaps

plecs('scope', 'scopePath', 'ExportBitmap', 'fileName')
plecs('scope', ‘'scopePath', 'ExportBitmap', 'fileName', ...)

saves a bitmap of the scope to the file fileName. If fileName is not an absolute
path, it is interpreted relative to the model file that contains the scope. The file
format is determined automatically from the file extension. The fileName ar-
gument may be followed by one or more name/value pairs to override settings
defined in the scope as described in table “Scope Settings for Bitmap Export”
(on page 258).

Other CLI Commands

To retrieve the version information from PLECS as a string, enter
plecs('version')

To retrieve a struct with host ID and MATLAB license information, enter
plecs(‘'hostid')

To check out a license for PLECS, enter
[success,message] = plecs('checkout')

If the check-out succeeds, the return variable success will be set to 1 and

message will be an empty string. Else, success will be set to 0 and message

will contain a detailed error message. When called without left-hand side ar-

guments, the command will raise a MATLAB error upon an unsuccessful check-
out and else execute silently.
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Examples

Some examples for using the command line interface in PLECS Blockset:

plecs('get', 'mdl/Circuiti')

returns the parameters of Circuit1 in the simulink model md1.
plecs('get', 'mdl/Circuiti1', 'Name')

returns the name of Circuiti.
plecs('get', 'mdl/Circuiti1', 'CircuitModel')

returns the circuit simulation method of Circuiti.
plecs('get', 'mdl/Circuiti1/R1")

returns the parameters of component R1 in circuit Circuiti.
plecs('set', 'mdl/Circuiti/R1', 'R', '2"')

sets the resistance of component R1 in circuit Circuiti to 2.
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Code Generation

As a separately licensed feature, PLECS can generate C code from a simulation
model to facilitate real-time simulations. Code generation is subject to certain
limitations, which are described in the first section of this chapter. The next two
sections describe how the code generation capabilities are used within PLECS
Standalone and PLECS Blockset, respectively.

Code Generation for Physical Systems

As described earlier in this manual, PLECS models physical systems using
piecewise linear state-space equations that can be described using multiple sets
of state-space matrices. For details see “Physical Model Equations” (on page
29).

During normal simulations, PLECS calculates new sets of state-space matrices
on the fly as the individual switching components change their states. This is
not possible in the generated C code because the algorithms for calculating the
matrices are proprietary and because the calculation would simply be too time
consuming under real-time constraints.

When generating code for a physical model, PLECS therefore embeds the ma-
trices for all combinations of switch states that it expects to encounter during
the execution of a simulation run. In general this means that for a system with
n switch elements 2" sets of state-space matrices are calculated and embedded
into the generated C code. The actual number can be reduced by eliminating
impossible combinations. For instance, the Triple Switch (see page 796) blocks
internally consists of 3 switch elements but it still only accounts for 3 instead
of 23 combinations because one and only one switch will conduct at any time.
Even so, systems with many switches will lead to large source and executable
files and long compile times.
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Maximum Number of Switches

The number of switch elements is limited to 16 or 32 per physical domain de-
pending on the integer word size. This is due to the fact that the switch states
of a physical domain are stored internally in a single unsigned integer variable.
Note that some components, such as the Triple Switch (see page 796), inter-
nally consist of more than one switch element.

Handling Naturally Commutated Devices

Switched physical models are difficult to handle in real-time simulations if the
natural switching instants can occur between two time steps. This is the case
for naturally commutated components where switching events are triggered by
internal quantities of the physical model. Examples of such components are the
diode (which turns on when the voltage becomes positive and turns off when
the current becomes negative) or the mechanical friction components (which
start slipping when the torque resp. force exceeds a certain level and become
stuck when the speed becomes zero).

During normal simulations, PLECS handles such non-sampled switching
events using an interpolation scheme (see “Interpolation of Non-Sampled
Switching Events” on page 36). This is not practical under real-time constraints
because the computation time required for the interpolation is several times
larger than that of an ordinary simulation step. In real-time simulations,
PLECS will therefore defer the switching to the immediately following time
step. Note that this reduces the accuracy compared to a normal simulation.

Switching Algorithm

A further difficulty with naturally commutated devices is that their conduction
state is usually influenced by the conduction states of other switches. During
normal simulations, PLECS solves this problem by iteratively toggling the con-
duction states of naturally commutated switches within one simulation step
until the boundary conditions of all switches are satisfied (see the description of
the Switch Manager in section “Physical Model Equations” on page 29).

When generating code for a physical model, PLECS lets you choose between
two switching algorithms, Iterative and Direct Look-up. You can specify the
algorithm individually for each physical model using special Model Settings
blocks that are connected to individual physical models, see Electrical Model
Settings on page 444, Rotational Model Settings on page 641 and Translational
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Model Settings on page 774. The default switching algorithm is Direct Look-
up.

lterative PLECS generates code that implements an iterative switching
method as described above. As a consequence of the iteration, simulation steps,
in which a switching occurs, require more computation time than simulation
steps without switching events. This is usually undesirable in real-time simula-
tions because the longest execution time determines the feasible sample rate.

Direct Look-up Alternatively, PLECS can generate code that determines the
proper switch conduction states directly as functions of the current physical
model states and inputs and the gate signals of externally controlled switches.
In order to generate these direct look-up functions, PLECS must analyze all
possible transitions between all possible combinations of conduction states.
This increases the computation time of the code generation process but yields
nearly uniform execution times of simulation steps with or without switching
events.

In order to reduce the number of possible combinations of switch conduction
states and thus the code generation time and the code size, PLECS introduces
the condition that naturally commutated devices (e.g. diodes or IGBT's) can only
conduct if their current is non-zero. As a consequence, a diode may block even
though the voltage is forward-biased if there is another blocking switch con-
nected in series that prevents the current from flowing through the diode. This
can produce unexpected voltage waveforms even though otherwise the model
behaves correctly.

Consider the simple circuit shown below. Two diodes are connected in series but
opposing each other so that no current can flow regardless of the polarity of the
source voltage:
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Simulation of a circuit with two opposing diodes
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In the two graphs, the bold lines show the results from a normal simulation.
When the source voltage is positive, D1 conducts and D2 blocks, and hence the
voltage across D1 is zero and the voltage across D2 equals the negative source
voltage. As the source voltage becomes negative, D1 block and D2 conducts,
and accordingly the voltage across D1 equals the source voltage and the voltage
across D2 is zero.

The dotted stairstep lines show the results from generated code using the it-
erative switching method. As can be seen, the diodes behave in the same way
as in the normal simulation. In the generated code using the direct look-up
method shown with continuous stairstep lines, however, both diodes block at
all times because no current can ever flow through either of them. Accordingly,
the source voltage always divides evenly across the two diodes.



Unsupported Components

Unsupported Components

PLECS currently does not support code generation for the following compo-
nents:

¢ Algebraic Constraint (see page 359)

* Brushless DC Machine (see page 374)

¢ Electrical Algebraic Component (see page 440)

* Rotational Algebraic Component (see page 632)

¢ Switched Reluctance Machine (see page 702)

* Translational Algebraic Component (see page 765)

¢ Variable Capacitor (see page 800)

¢ Variable Inductor (see page 806)

¢ Variable Resistor (see page 815)

* Variable Resistor with Constant Parallel Capacitor (see page 816)
¢ Variable Resistor with Constant Series Inductor (see page 817)

* Variable Resistor with Variable Parallel Capacitor (see page 818)
* Variable Resistor with Variable Series Inductor (see page 820)

PLECS also does not support code generation for models that contain algebraic
loops.
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PLECS Standalone produces C code in an embedded format, generating entry
point functions that must be called from a main application. The following func-
tions are generated:

void model_initialize(double time)
This function should be called once at the beginning of a simulation to ini-
tialize the internal data structures and the start value of the global clock for
components that depend on the absolute time.

void model_step()

void model_step(int task_id)
This function should be called at every simulation step to advance the
model by one step. The second form is used if the multi-tasking mode is en-
abled (see “Scheduling” on page 288) and the model has more than one task.

void model_output()

void model_ output(int task_id)
This function calculates the outputs of the current simulation step. It
should be called at every simulation step before the model update function.
The second form is used if the multi-tasking mode is enabled.

void model_update()

void model_update(int task_id)
This function updates the internal states of the current simulation step. It
should be called at every simulation step after the model output function.
The second form is used if the multi-tasking mode is enabled.

void model_terminate()
This function should be called at the end of a simulation to release re-
sources that were acquired at the beginning of or during a simulation.

The prefix model is replaced by a model-specific string.

The model output and model update functions are only generated if the corre-
sponding option is set in the target specific settings (see “Target” on page 288).
In this case, the model step function is not generated.

If a runtime error occurs during the execution of any of the three functions
above, the variable const char * model errorStatus points to a string with
the error message. It is initialized with NULL.
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Generating Code

To generate code, choose Coder options... from the Coder menu. This menu
only appears if you have a license for the PLECS Coder.

M Coder Options: CodeGenPlant ﬂ
System I General | Parameter Inlining I Target I Scheduling I External Mode
CodeGenPlant G I
“ Plant enera
Discretization step size: | 1e-3|
Discretization method: |Radau LI
Floating point format: Idouble :I
—Diagnostics
Usage of absolute time: error ;I
—Output options
Base name: IPIant
Output directory: ICc-deGenPIant_cc-degen |
Accept | Revert | Close | Help |

The left hand side of the dialog window shows a tree view of the model and the
code-generation subsystem that it contains. Intermediate subsystems that have
not been enabled for code generation appear as disabled entries that cannot be
selected.

To enable a subsystem for code generation, select the subsystem, then choose
Execution settings... from the Subsystem submenu of the Edit menu or the
context menu. In the Subsystem Settings dialog check the option Enable code
generation. Note that it is not possible to enable code generation for a subsys-
tem that is contained by or that itself contains other subsystems that enable
code generation. Checking this option implicitly also checks the option Treat
as atomic unit and unchecks the option Minimize occurrence of algebraic
loops. For more information on these options see “Virtual and Atomic Subsys-
tems” (on page 695).
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The right hand side of the dialog window shows a tabbed dialog with the code
generation options for the system that is selected in the tree view. To generate
code for the currently selected system, click on the Build button at the bottom
of the right hand side.

Code generation can also be initiated in an Octave simulation script or via the
RPC interface using the commands

plecs('codegen', 'path', optStruct, 'outputDir')
or
plecs.codegen('path', optStruct, 'outputDir')

respectively, where path is a model name or a subsystem path. The parameters
optStruct and outputDir are optional.

If optStruct is provided, it is expected to be a struct as described in “Scripted
Simulation and Analysis Options” (on page 268). This enables you e.g. to gen-
erate code for different parameter values without having to modify the model
file.

If outputDir is provided, the generated files will be placed in this folder instead
of the folder that is specified in the model.

General

Discretization step size This parameter specifies the base sample time of

the generated code and is used to discretize the physical model equations (see
“Physical Model Discretization” on page 35) and continuous state variables of
control blocks.

Discretization method This parameter specifies the algorithm used to dis-
cretize the physical model equations (see “Physical Model Discretization” on
page 35).

Floating point format This parameter specifies the default data type (float
or double) that is used for floating point variables in the generated code.
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Usage of absolute time This setting allows you to specify the diagnostic ac-
tion to be taken if PLECS generates code for a component that depends on the
absolute time. In order to minimize round-off errors, PLECS generates code to
calculate the absolute time using a signed 64-bit integer tick counter. If a simu-
lation runs for an infinite time, this tick counter will eventually reach its maxi-
mum value, where it is halted to avoid problems that might occur if the counter
was wrapped to the (negative) minimum value, such as a Step block (see page
694) resetting to its initial value. To put things into perspective, assuming a
step size of 1us this would occur after 292 271 years.

Depending on this setting, PLECS will either ignore this condition or it will is-
sue a warning or error message that indicates the components that use the ab-
solute time.

Base name This parameter allows you to specify a custom prefix used to
name the generated files and the exported symbols such as the interface func-
tions or the input, output and parameter structs. By default, i.e. if you clear
this field, the base name is derived from the model or subsystem name.

Output directory This parameter allows you to specify, where the generated
files are stored. This can be an absolute path or a relative path with respect to
the location of the model file. The default path is a directory model codegen
next to the model file.

Parameter Inlining

These two settings specify how PLECS handles tunable parameters in the gen-
erated code.

Default behavior This setting specifies whether PLECS inlines the parame-
ter values as numeric constants directly into the code (Inline parameter val-
ues) or generates a data structure from which the values are read (Keep param-
eters tunable).

Inlining parameter values reduces the code size and increases the execution
speed. However, changing an inlined parameter value requires regenerating
and recompiling the code. On the other hand, the values of tunable parameters
can be changed at execution time without recompiling the code.

Exceptions For the components listed here, the opposite of the default behav-
ior applies. If the default behavior is to inline all parameter values, the com-
ponents listed here will keep their parameters tunable and vice versa. To add
components to this list, simply drag them from the schematic into the list. Use
the Remove - button to remove components from the list. To view the selected
component in the schematic editor, click the Show component & button.
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Note Physical component parameters that affect the physical model equa-
tions, such as resistances or inductances, cannot be kept tunable, because
changing such parameters in general requires a recalculation of the complete
equation system. You can, however, keep the parameters of source blocks tun-
able.

Target

On this tab you can select a code generation target and configure target-specific
settings. By default, only the Generic target is available. For information on
how to install additional code generation targets, see “Coder Configuration” (on
page 127).

The Generic target has the following settings.

Generate separate output and update functions If you choose this op-
tion, the model step function is replaced by the two functions model output
and model update. Choose this option when you need access to the outputs as
early as possible during task execution (e.g. to transfer the values to an analog
or digital output, update a logger, start a DMA transfer, etc.).

Scheduling

This tab is enabled only if you have selected a target that supports multi-
tasking.

Tasking mode This parameter allows you to choose between the single-
tasking and multi-tasking modes.

Task configuration If you choose the multi-tasking mode, the dialog will
show a table that lets you define a set of tasks. A task has a Task name and

a Sample time that must be an integer multiple of the base sample time. The
value 0 is replaced with the base sample time itself. If the selected target sup-
ports multi-core processing, a task is also associated with a Core. If the se-
lected target has multiple processors, a task is also associated with a CPU. The
radio buttons in the Default column specify the default task (see below).

Each task must have a unique name, and the core/sample time pairs must also
be unique. Note that the task set must comprise a base task that is associated
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with the base sample time and core O (if applicable). For this reason, these
columns in the first row are locked.

To assign a block or a group of blocks to a task, copy a Task Frame (see page
726) into the schematic, open the Task Frame dialog to choose the desired task,
and drag the frame around the blocks. Blocks that are not enclosed by a Task
Frame are scheduled in the default task.

Note that blocks do not need to have the same sample time as the task that
they are assigned to; the block sample time can be continuous or an integer
multiple of the task sample time.

Thermal model task In multi-tasking mode you can choose to execute all
thermal model calculations in a dedicated task, typically on a separate core
with a slower sample time in order to allow for the longer computation time for
the calculation of switch losses. This asynchronous execution mode is supported
only for power modules in “Sub-cycle average” configuration.

To configure a dedicated thermal model task, select its name in the combo box.
The default setting, use native task, means that a thermal model is executed
according to the Task Frame configuration synchronously with an associated
electrical model.

External Mode

This tab is enabled only if you have selected a target that supports external
mode operation and if the corresponding target setting is enabled. External
mode operation enables you to

¢ Capture data on a target device and show them in Scope (see page 664),
XY Plot (see page 834) and Display (see page 429) blocks in the model on the
host computer.

* Change values of tunable parameters (see “Parameter Inlining” on page 287)
in the model on the host computer and upload the changed values to an ap-
plication running on a target device.

Task Transitions in Multi-Tasking Mode

If a block in one task receives one or more input signals from a block in another
task, PLECS automatically inserts code to ensure that the signal data is trans-
ferred in a safe manner.
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Task Transitions on the Same Core

If the source task is faster than the destination task and the sample time of the
destination task is an integer multiple of the sample time of the source task (i.e.
if the destination task is executed at instants at which the source task is also
executed), PLECS inserts code equivalent to a Zero Order Hold (see page 837)
that operates with the slower sample time.

If the source task is slower than the destination task and the sample time of
the source task is an integer multiple of the sample time of the destination task
(i.e. if the source task is executed at instants at which the destination task is
also executed), PLECS inserts code equivalent to a Delay (see page 410) that
operates with the slower sample time.

In all other cases, PLECS uses a double buffer with a semaphore to transfer the
data.

The insertion of a Zero Order Hold or a Delay ensures that data is always ex-
changed in a deterministic manner. The drawback is that it introduces latency.
If this is not desired, you can insert a Task Transition block (see page 727) in
front of the receiving block inside the destination task. This causes PLECS to
transfer the data using a double buffer instead.

Task Transitions Between Different Cores

For task transitions between different cores, the write operation in the source
task can occur simultaneously with the read operation in the destination task.
PLECS uses a double buffer with two semaphores to guarantee that simultane-
ous read and write operations never access the same buffer.

Task Transitions Between Different CPUs

For task transitions between different CPUs, PLECS delegates the data trans-
fer to external functions that must be provided by the target framework.

Simulating a Subsystem in CodeGen Mode

Enabling a subsystem for code generation also enables the Simulation Mode
parameter in the Execution Settings dialog (see the Subsystem block on page
695). When this parameter is set to Normal, which is the default, the subsys-
tem is simulated like a normal atomic subsystem. When the parameter is set to
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CodeGen, the generated code is compiled and linked to PLECS to be executed
instead of the subsystem during a simulation.

In connection with the “Traces” feature of the scopes (see “Adding Traces” on
page 104), this allows you to easily verify the fidelity of the generated code
against a normal simulation.
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Standalone Code Generation

PLECS Blockset can generate C code in the same format as PLECS Standalone,
and you can choose to generate code for a complete Circuit block or for an indi-
vidual subsystem. To generate code, choose Coder options... from the Coder
menu. This menu only appears if you have a license for the PLECS Coder. For
details on the coder options dialog please refer to the previous section “Code
Generation with PLECS Standalone” (on page 284).

Code generation can also be initiated via the MATLAB commands

plecs('codegen', 'path')
plecs('codegen', 'path', ‘outputDir')

If outputDir is provided, the generated files will be placed in this folder instead
of the folder that is specified in the model.

Integration with Simulink Coder

In addition, PLECS Blockset fully integrates with Simulink Coder (formerly
Real-Time Workshop) to generate C code for your simulation model. Whenever
you start a build process from within Simulink, PLECS automatically gener-
ates the code for a circuit block and inserts it at the appropriate places into the
code generated by Simulink Coder.

Note Scopes that are placed in PLECS schematics are not updated during
a simulation using code generation. To view the simulation results, all scopes
must be placed in the Simulink model.

Simulink Coder Options

The code generation options for the Simulink Coder are configured on the
Simulink Coder pane of the PLECS simulation parameters.
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Code generation target This parameter specifies the code generation target
(see “Code Generation Targets” on page 293). The default, auto, means that
PLECS selects the target depending on the Simulink Coder target.

Inline circuit parameters for RSim target Specifies for the RSim target

whether component parameters should be evaluated at compile time and in-

lined into the code (on) or evaluated at run time (off). See also “Tunable Cir-
cuit Parameters in Rapid Simulations” (on page 295).

Generate license-free code (requires PLECS Coder license) If this op-
tion is checked, PLECS will attempt to check-out a PLECS Coder license at
build time and, if successful, will generate code for the RSim target that will
run without requiring a PLECS license. Otherwise, the generated executable
will require a PLECS license at run time.

Show code generation progress If this option is checked, PLECS opens
a dialog window during code generation that shows the progress of the code
generation process. You can abort the process by clicking the Cancel button
or closing the dialog window.

Code Generation Targets

PLECS can generate code for two different Simulink Coder targets: the Rapid
Simulation target (or RSim target) and the Real-Time target. These two targets
are described in detail in the following two sections. The table below highlights
the differences between the targets.

Comparison of Code Generation Targets

RSim Target Real-Time Target
Purpose Rapid, non-real-time simu- Real-time simulations.
lations.
Technique A compressed description Signal and state-space
of the circuit schematic is equations are inlined as

embedded in the code and ANSI C code.
interpreted at run time.

Limitations | none Limited support for natu-
rally commutated devices
and non-linear components.
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Comparison of Code Generation Targets (contd.)

RSim Target

Real-Time Target

Inlining Parameters may be de- All parameters are inlined,
clared tunable, so that they | i.e. evaluated at compile
are evaluated at run time. time and embedded into the

generated code.

Deployment | Requires distribution of the | Generated code does not

PLECS RSim module. have external dependen-
cies.
Licensing If a PLECS Coder license Requires a PLECS Coder

is available at build time, license at build time.
the generated code will run
without a license. Other-
wise, a PLECS license is

required at run time.

By default, PLECS automatically selects the appropriate target depending

on the target settings of Simulink Coder. To overrule this selection, open the
PLECS simulation parameters, and on the Advanced pane change the setting
Target to either RSim or RealTime.

Real-Time Target

The Real-Time Target is selected by default when you generate code using any
of the real-time targets of Simulink Coder. Code generation for the Real-Time
target requires a separate license for the PLECS Coder for PLECS Blockset.

For a detailed description of the code generation process for physical systems
and its current limitations see “Code Generation for Physical Systems” (on page
279).

Rapid Simulation Target
The RSim target is selected by default when you run a simulation using

Simulink’s Rapid Accelerator mode or when you generate an executable using
the RSim target or the S-Function target of Simulink Coder. The resulting code
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links against the RSim module of PLECS, a shared library which is part of the
standard installation.

Deploying Rapid Simulation Executables
To deploy the generated executable you need to copy the appropriate shared

library file onto the target computer. The following table lists the library files
for the supported platforms.

Library Files for Rapid Simulations

Platform Library File

Windows 64-bit | plecs\bin\win64\plecsrsim.dll

Mac Intel 64-bit | plecs/bin/maci64/libplecsrsim.dylib

Linux 64-bit plecs/bin/glnxa64/libplecsrsim.so

The library file must be copied into the same directory as the executable. Alter-
natively, you can define the appropriate environment variable for your target
computer such that it includes the directory where you have installed the li-
brary file.

Licensing Protocols for the PLECS RSim Module

Depending on the build settings the RSim module may check out a PLECS
license for the duration of execution. It uses the environment variable

PLEXIM _LICENSE_FILE to locate the license file. If the module is unable to check
out a PLECS license, it issues an error message and stops the simulation.

Tunable Circuit Parameters in Rapid Simulations

By default, PLECS evaluates the parameters of all circuit components at com-
pile time and inlines them into the circuit description. However, for certain ap-
plications — such as rapid simulations on different parameter sets or parame-
terized S-Functions — it is desirable that the parameters be evaluated at sim-
ulation start instead. This can be achieved by declaring the circuit parameters
tunable.

To declare circuit parameters tunable,
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1 Mask the PLECS Circuit block and define all parameters that you wish to
keep tunable as mask variables. Mask variables can either be mask param-
eters (that appear in the parameter dialog) or variables defined in the mask
initialization commands. For more information see “Customizing the Circuit
Block” (on page 49).

2 On the Advanced pane of the PLECS simulation parameters, uncheck the
option Inline circuit parameters for RSim target.

3 Include the variable names in the list of tunable model parameters. Please
see the Simulink Coder User’s Guide for details.

Limitations on Tunable Circuit Parameters If you declare circuit param-
eters tunable, the RSim module uses its own parser to evaluate parameter ex-
pressions at simulation start; it currently cannot handle mask initialization
commands. You will receive runtime errors if your circuit contains masked sub-
systems using mask initialization commands, or if a parameter expression con-
tains a MATLAB function call.

Other limitations apply due to the way the Simulink Coder handles tunable

parameters:

¢ Circuit parameters must be double-precision, 2-dimensional, non-sparse ar-
rays.

* The first four characters of the parameter names must be unique.



FMU Export

As a separately licensed feature, PLECS can export an atomic subsystem to a
Functional Mockup Unit (FMU) according to the FMI Model Exchange stan-
dard in version 2.0. This allows you to integrate PLECS models into third-party
simulation tools. The exported FMU can be used on a target computer with-

out the need to install PLECS, and no license is required to run the FMU. Sup-
ported target platforms are the same as those supported by PLECS itself, i.e.
Windows 64-bit, Linux 64-bit and macOS.

The exported FMU consists of an encrypted PLECS model file and target-
specific shared libraries that parse and execute the PLECS model at runtime.
For technical reasons the subsystem must be discretized for the export so that
the FMU is executed with a fixed sample time. It is recommended that you test
the proper operation of the discretized subsystem by running a simulation with
the Discrete solver in PLECS Standalone (see “PLECS Standalone Parame-
ters” on page 111) or the Discrete state-space circuit model type in PLECS
Blockset (see “PLECS Blockset Parameters” on page 118) prior to the export.

Exporting an FMU

To export an atomic subsystem to an FMU, select the Subsystem block, then
choose Export FMU... from the Subsystem submenu of the Edit menu or the
block’s context menu. This will open the FMU Export dialog that allows you to
configure the FMU as described below. When you click on Export, the FMU is
created.

If the subsystem has a mask (see “Masking Subsystems” on page 68), PLECS
automatically exports the mask description as the FMU description and the
mask parameters as FMU parameters. Note that thermal description parame-
ters are not supported by the FMI standard and are therefore ignored.
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General

m FMU Export: plant_code_generation/Circuit X

FMU export

Export subsystem to Model Exchange Functional Mockup Unit
(ME FMU) using Functional Mockup Interface (FMI) version 2.0.

General options Terminal order Documentation

Sample time: ‘4e-5 ‘

Target platform(s): Windows 64-bit (win64)
]

Linux 64-bit (linux64)
[| Mac/Intel 64-bit (darwin64)
[_] Mac/ARM 64-bit (aarch64-darwin)

Output file: ‘ ‘

Cancel Apply Help

Sample time This parameter specifies the sample time used to discretize the
exported subsystem.

Target platform(s) These checkboxes let you choose the binary platform(s)
on which you intend to run the exported FMU. PLECS will embed the corre-
sponding shared libraries into the FMU.

Before you can export an FMU for the first time, you need to install the shared
library files on your computer. This is indicated by blue arrows next to the
checkbox items as shown below. When you click on any of them, a dialog opens
that lets you download and install the required package automatically.

Terminal Order

On this page you can configure the order in which the input and output termi-
nals of the subsystem appear in the exported FMU.
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Limitations

m FMU Export: plant_code_generation/Circuit

FMU export
Export subsystem to Model Exchange Functional Mockup Unit
(ME FMU) using Functional Mockup Interface (FMI) version 2.0.

General options Terminal order Documentation

Inputs

t pulses
L 2

Outputs

Cancel Apply Help

m FMU Export: plant_code_generation/Circuit

FMU export

Export subsystem to Model Exchange Functional Mockup Unit

(ME FMU) using Functional Mockup Interface (FMI) version 2.0.

General options Terminal order Documentation

Icon file: “ ‘

Documentation: |Add single file v

Cancel Apply Help

Documentation

Icon file This parameter allows you to specify a PNG image file that is in-
cluded as a model icon in the exported FMU.

Documentation This parameter allows you to provide documentation that is
included in the exported FMU. You can choose to include a single HTML file or

a folder with HTML and resource files.

Discrete-Variable Sample Times As described at the beginning of this
chapter, PLECS discretizes the model when exporting to an FMU. As a conse-
quence, the model cannot contain components that have a variable sample time.

Thermal Description Parameters Thermal description parameters are in-

lined and cannot be modified in the exported FMU.
Masked Subsystems The shared FMU libraries contain a basic MATLAB

parser for interpreting simple initialization commands of masked subsystems
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(see “Initialization Commands” on page 80). This parser supports only a lim-
ited subset of the MATLAB language. As a consequence, the following library
components currently cannot be used in an exported FMU:

¢ Diode with Reverse Recovery (see page 413)

¢ Non-Excited Synchronous Machine (see page 579)

¢ Synchronous Reluctance Machine (see page 722)

Thyristor with Reverse Recovery (see page 742)
¢ Transmission Line (3ph) (see page 783)



Dift Tool

The Diff tool can be used to compare two PLECS models or two subsystems of
PLECS models. The result of a Diff is a side-by-side comparison of the two mod-
els showing all the differences between them. Depending on the kind of change,
a suitable view is used, e.g. a schematic to show inserted or deleted components
or a parameter dialog to show changed parameter values. The Diff browser can
be used to navigate through the differences. A “relevance” value for each differ-
ence helps you to identify the most important changes.

This chapter is divided into four sections. The first section describes how to se-
lect two models or subsystems and compute a Diff for them. The second sec-
tion gives an overview on how the result of the Diff is presented to the user. The
third section explains the algorithms PLECS uses to compute the Diff. Finally,
the fourth section lists the limitations of the Diff tool.

How to Compute a Diff

Computing a Diff in PLECS Standalone

The Diff tool can compare either two complete PLECS models or two subsys-
tems contained in one or two PLECS models. To compute a Diff, choose the op-
tion Compare in the File menu. This opens the Diff dialog.

This dialog has the two rows “Before” and “After” to specify the two entities that
should be compared. You can use drag&drop to specify a model or a subsystem
for comparison. Each row in the Diff dialog contains the following fields:

Model file
This field is used to specify the path of the model file. Depending on the
models that are currently open in PLECS, this field is already filled with
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Model file: Subsystem path: State:
Before:

L'in\:l_h.lrhinej'duuhIe_fed_inducﬁunjanarabur_wind_mrb\ne‘D\Ecs‘ |J’E|EEtI'iEE| | File state w

Model file: Subsystem path: State:

L'ind_turhine,fdﬂuhIe_fed_inducﬁnnjeneratﬂr_wind_mrhme‘p\ecs‘ |‘,'Elenrital | Editor state

Compare Swap Cancel

Standalone Diff dialog

a reasonable suggestion. You can also use drag&drop or the Open file
browser button (...) to choose a file.

Subsystem path
This field can be used to specify a subsystem for the comparison. If you
want to compare subsystems you have to specify a subsystem for both the
“before” and “after” row. You cannot compare a model with a subsystem.
The subsystem path should also contain the name of the model, which can
be abbreviated by a dot (.). If you use only the model name or a dot or if you
leave this field empty, the whole model will be compared. Depending on the
subsystems that are currently selected in PLECS, this field is already filled
with a reasonable suggestion. You can also drag&drop a subsystem from a
schematic window.

State
This is a drop-down list that can specify either one of the values File state
or Editor state. If you choose File state, the state the model has in the
model file is used for comparison. If you choose Editor state, the unsaved
changes of an open model are used for comparison. This can be useful to
review changes before saving a model.

Differences are defined as editing steps from the “before” model to the “after”
model. A component present in the “before” model but missing in the “after”
model will be displayed as a deletion. If you decide that you would like the dif-
ferences to be presented the other way around, use the Swap button to swap all
fields in the “before” and “after” row.

Once you have filled out all fields, press the Compare button to start the Diff
computation. A progress bar will show the current state of the Diff computa-
tion. If you want to abort the Diff computation, press Cancel. Once the Diff
computation has finished, the Diff result window will show the result.
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Computing a Diff in PLECS Blockset

The Diff tool can compare either two complete PLECS circuits contained in one
or two Simulink models or two subsystems contained in one or two PLECS cir-
cuits. To compute a Diff, choose the option Compare in the File menu. This
opens the Diff dialog.

. Model file: Circuit path: Subsystem path: State:
efore:
|emos\double_fed_induchonjeneramr_wmd_mrbina‘mdl| "mnd_mrbinafcircu\t ‘ ‘ | File state  ~

Model file: Circuit path: Subsystem path: State:
After:

hemos\doub\e_fed_inducﬁunjenarabor_',\'\nd_mrbine‘slx| ‘wmd_mrbinafsubfcwrcuit H | File state

Compare Swap Cancel

Blockset Diff dialog

This dialog has the two rows “Before” and “After” to specify the two entities that
should be compared. You can use drag&drop to specify a model or a subsystem
for comparison. Each row in the Diff dialog contains the following fields:

Model file
This field is used to specify the path of the Simulink model file. Depending
on the models that are currently open, this field is already filled with a rea-
sonable suggestion. You can also use drag&drop or the Open file browser
button (...) to choose a file. Valid model file extensions are mdl and slx.

Circuit path
This field is used to specify the path of the PLECS Circuit within the
Simulink model. It should start with the Simulink model name and end
with the PLECS Circuit name. Depending on the models that are currently
open, this field is already filled with a reasonable suggestion.

Subsystem path
This field can be used to specify a subsystem for the comparison. If you
want to compare subsystems you have to specify a subsystem for both the
“before” and “after” row. You cannot compare a circuit with a subsystem.
The subsystem path should also contain the name of the circuit, which can
be abbreviated by a dot (.). If you use only the circuit name or a dot or if you
leave this field empty, the whole circuit will be compared. Depending on the
subsystems that are currently selected in PLECS, this field is already filled
with a reasonable suggestion. You can also drag&drop a subsystem from a
schematic window.
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State
This is a drop-down list that can specify either one of the values File state
or Editor state. If you choose File state, the state the circuit has in the
model file is used for comparison. If you choose Editor state, the unsaved
changes of an open model are used for comparison. This can be useful to
review changes before saving a model.

Differences are defined as editing steps from the “before” model to the “after”
model. A component present in the “before” circuit but missing in the “after”
circuit will be displayed as a deletion. If you decide that you would like the dif-
ferences to be presented the other way around, use the Swap button to swap all
fields in the “before” and “after” row.

Once you have filled out all fields, press the Compare button to start the Diff
computation. A progress bar will show the current state of the Diff computa-
tion. If you want to abort the Diff computation, press Cancel. Once the Diff
computation has finished, the Diff result window will show the result.

How to Interpret the Results
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The result of computing a Diff is shown in the Diff result window. This window
contains a Diff browser and two views, one for the “before” model and one for
the “after” model.

DEPEEEELEEEEEEE S

Diff result window

The Diff Browser

The Diff browser can be used to navigate through the differences between the
two models. It is similar to the Circuit Browser shown in schematic windows
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(see “Circuit Browser” on page 89). However, there are three important differ-
ences:

1 The Diff browser shows not only components but also all other kinds of items
stored in a model, e.g. parameters, properties like the positions of compo-
nents, analyses and simulation scripts

2 The Diff browser only shows the items that actually changed

3 The Diff browser merges both models into one tree, i.e. an item in the tree
represents the corresponding item in both models (if it exists)

There are cases where an item is located in different schematics in the “before”
and “after” models. For example, if a resistor is in the root schematic in the “be-
fore” model and within a subsystem in the “after” model, it will appear twice in
the Diff browser.

The Diff browser shows the three columns Name, Type and Relevance.

Name

This column shows the name of the corresponding item. The hierarchical struc-
ture of the model is shown as a tree. Use the little arrows to navigate into
nested items. The colored icons next to the item names illustrate the kind of
change:

A red icon means that the corresponding item was deleted from the “be-
fore” model

__| A green icon means that the corresponding item was inserted into the “af-
ter” model

L A Dblue icon means that the corresponding item was modified

For renamed items, both the “before” and “after” names are shown, with an ar-
row (—) between them.

Type

This column shows the type of the corresponding item. The type is also illus-
trated by the icon. There are the following types:

€/ PLECS Circuit

2] Subsystem

& Component (other than a Subsystem)
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£/ Connection

A Annotation

T Terminal

P| Parameter

5 Setting

A Component assertion

P Scope plot
Al XY-plot axis

Fourier plot

[—n

Fl " Probe (entry for a component in a Probe block or a mask probe)
M/ Mask probe (entry in the list of probes for a masked subsystem)
[Pl Simulink probe (entry in a Simulink Probe block)

5] State machine state (includes entry points and junctions)

T/ State machine transition

Al State machine annotation

[P State machine parameter

Al Analysis

5/ Simulation script

P|  Property (of an item of any type)

This list is exhaustive, i.e. every data item in a model has one of the above
types.

Note The item types in the Type column of the Diff browser are distinct from
the component types shown in the Type column of the Circuit browser.
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Relevance

This column shows a “relevance” for each item shown in the Diff browser. The
relevance gives an estimation for the importance of a change. It can have the
following values:

Simulation
The difference may have an impact on the result of a simulation. Example:
changing a component parameter value.

Representation
The difference does not influence the simulation, but how a model is dis-
played in the GUI. Example: changing the position of a component in the
schematic.

Model file
The difference does not influence the simulation and is not directly visible
in the GUI either, but it is visible in the model file. Example: changing the
PLECS version in which the model is saved.

Tool ButHons

The Diff browser also shows the following tool buttons:

Previous View @

Use this button to return to the previous item that was shown in the views.

Next View @

Use this button to go to the next item in the list of visited items.

Filter Options |

Use this button to filter items according to their relevance (see “Relevance” on
page 307).

Refresh @

Use this button to recompute the Diff after one of the compared original models
changed.
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The Diff Views

To the right of the Diff browser, there are two views that show the currently
selected item in the appropriate context, e.g., a changed component is shown in
the parent schematic, a changed parameter is shown in the parameter dialog.
Each view shows the path of the currently visible item at the top. By clicking on
an element of the path, you can navigate to the corresponding item.

By default, the left view shows the “before” model and the right view shows the
“after” model. You can swap the two views in the General tab of the PLECS
preferences dialog (see section “Configuring PLECS” on page 124). Note that
swapping the views only changes their location in the window and has no influ-
ence on the roles of the “before” and “after” models.

As in the Diff browser, items deleted from the “before” model are marked in red,
items inserted into the “after” model are marked in green and modified items
are marked in blue. A spotlight is used to facilitate finding the changed item.

You can navigate through the models as in a normal Schematic window. How-
ever, editing is disabled, because the Diff result is only valid for the particular
state the models were in when you pressed the Compare button.

How Diff Works
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Classical Diff algorithms (like Miller & Myers, 1985) operate on linear lists.
This works well for continuous text but cannot account for the hierarchical
structure of tree-like data. A PLECS model is a collection of nested linear
and hierarchical data. To compute a useful Diff between two PLECS models,
we therefore employ an algorithm that uses a linear Diff algorithm (Miller

& Myers, 1985) for linear structures and a hierarchical Diff algorithm (Zhang
& Shasha, 1989 and Paassen, 2018) for hierarchical structures and applies
them recursively to nested data as appropriate. For example, the hierarchi-
cal algorithm is used to compare the trees of subsystems and components, and
within a C-Script block, the linear algorithm is used to compare each C code
snippet.

The result of the algorithm is a mapping of items in the “before” model to items
in the “after” model. Items that are mapped to each other are considered to be
“the same” item. Items that are in the mapping and identical are reported to be
unchanged. Items that are in the mapping and not identical are reported to be
modified. Items that are not in the mapping but present in the “before” model
are reported to be deleted. Items that are not in the mapping but present in the
“after” model are reported to be inserted.



Limitations

Limitations

References

W. Miller and E. W. Myers, “A file comparison program”, Softw: Pract. Exper.,
15: 1025-1040, 1985, https://doi.org/10.1002/spe.4380151102

K. Zhang and D. Shasha, “Simple Fast Algorithms for the Editing Distance
between Trees and Related Problems”, SIAM Journal of Computing, 18(6):
1245-1262, 1989

B. Paassen, “Revisiting the tree edit distance and its backtracing: A tutorial”,
2018, https://arxiv.org/abs/1805.06869

Model Conversion

PLECS computes Diffs based on the internal representation of a model rather
than the text contents of a model file. If a model is not open yet, it will be
loaded into the internal representation before the comparison. If the model file
was saved with a different version of PLECS, this internal representation may
differ from the model file due to differences between the PLECS versions. This
means that the Diff shown in PLECS may not contain certain differences that
are present in the model files. PLECS shows a warning if the versions of the
compared models do not match.

Non-Intuitive Results

The result shown in the Diff result window may sometimes not correspond to
what you would consider the “correct” result. There are mainly two reasons for
this:

1 While there are many ways to edit a model, the Diff algorithm (see “How Diff
Works” on page 308) detects only three distinct edit operations: deletions,
insertions and modifications. Also, the order of the items and their parent-
child relationships within the models must be preserved in order for an item
to be considered the same item in the “before” and “after” models.

2 The ordering of the items in the model is not directly visible in the GUI. This
corresponds to the order in which the items are stored in the model file and
has nothing to do with the coordinates of a component within a schematic.
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An example of a non-intuitive result may be the following: Consider a model
containing only a resistor and a diode in the root schematic, in this order. Now
the user adds a subsystem and moves the diode into it. As expected, the Diff
result will be an inserted subsystem in the “after” model and a modified diode,
located in the root schematic in the “before” model and within the subsystem
in the “after” model. However, if the user, instead of moving the diode into

the subsystem, moves the resistor into the subsystem, the Diff result will be a
deleted resistor in the “before” model and an inserted subsystem and inserted
nested resistor in the “after” model.

The reason for the second, unexpected result is that inserting a subsystem and
moving the resistor into it changes the order of the components. Because the
subsystem is added at the end of the list of components in the schematic, and
the resistor is removed from the beginning of the same list, moving the resistor
into the subsystem changes its position relative to the diode. The resistor can
therefore not be part of the mapping and is detected as deleted and inserted
instead of just modified.

Though situations like the one described above exist, the result that the Diff
algorithm produces is always correct in the sense that it represents a minimal
valid sequence of deletions, insertions and modifications that lead from the “be-
fore” model to the “after” model.
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Components by Category

This chapter lists the blocks of the Component library by category.

Configurable Subsystem

Display

Dynamic Signal Selector

Enable

From File

Pause / Stop

Scope

Signal Demultiplexer
Signal From

Signal Goto

Signal Inport

Signal Multiplexer
Signal Outport

Signal Selector

Provide subsystem with exchangeable implementa-
tions

Display signal values in the schematic

Select or reorder elements from vectorized signal
depending on control signal

Control execution of an atomic subsystem

Read time and signal values from file

Pause or stop the simulation

Display simulation results versus time

Split vectorized signal

Reference signal from Signal Goto block by name
Make signal available by name

Add signal input connector to subsystem
Combine several signals into vectorized signal
Add signal output connector to subsystem

Select or reorder elements from vectorized signal
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Control
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Subsystem

Switch Loss Calculator

Task Frame

Task Transition
To File

Trigger

XY Plot

Assert Dynamic Lower Limit

Assert Dynamic Range

Assert Dynamic Upper Limit
Assertion
Assert Lower Limit

Assert Range

Assert Upper Limit

Sources

Clock

Constant

Create functional entity in hierarchical simulation
model

Calculate the average sum of the switch losses of
all probed components over the specified averaging
period

Associate the enclosed components with a task in a
multi-tasking environment

Transfer data between tasks using a double buffer
Write time and signal values to file
Control execution of an atomic subsystem

Display correlation between two signals

Check whether a signal stays above another signal

Check whether a signal stays between two other
signals

Check whether a signal stays below another signal
Check whether a condition is true
Check whether a signal stays above a constant

Check whether a signal stays within a constant
range

Check whether a signal stays below a constant

Provide current simulation time

Generate constant signal



Control

Initial Condition

Pulse Generator
Ramp
Sine Wave

Step

Triangular Wave Generator
White Noise

Random Numbers

Math

Abs

Algebraic Constraint
Data Type

Gain

Math Function
Minimum / Maximum
Offset

Product

Rounding
Signum
Sum

Trigonometric Function

Continuous

Output specified initial value in the first simulation
step

Generate periodic rectangular pulses
Generate constantly rising or falling signal
Generate time-based sine wave with optional bias

Generate constant signal with instantaneous step
change

Generate periodic triangular or sawtooth waveform
Generate normally distributed random numbers

Generate uniformly distributed random numbers

Calculate absolute value of input signal

Enforce an algebraic constraint

Cast the input signal to the specified data type
Multiply input signal by constant

Apply specified mathematical function

Output input signal with highest resp. lowest value
Add constant to input signal

Multiply and divide scalar or vectorized input sig-
nals

Round floating point signal to integer values
Provide sign of input signal
Add and subtract input signals

Apply specified trigonometric function
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Continuous PID Controller

Integrator

PLL (Single-Phase)
PLL (Three-Phase)
State Space

Transfer Function

Delays

Memory
Pulse Delay
Transport Delay

Turn-on Delay

Discontinuous

Comparator
Dead Zone

Hit Crossing
Manual Signal Switch
Multiport Signal Switch

Quantizer

Rate Limiter

Implementation of a continuous-time controller (P,
I, PI, PD or PID)

Integrate input signal with respect to time
Implementation of a single phase PLL
Implementation of a three phase PLL

Implement linear time-invariant system as state-
space model

Model linear time-invariant system as transfer
function

Provide input signal from previous major time step
Delay discrete-value input signal by fixed time
Delay continuous input signal by fixed time

Delay rising flank of input pulses by fixed dead
time

Compare two input signals with minimal hysteresis
Output zero while input signal is within dead zone
limits

Detect when signal reaches or crosses given value

Manually select one of two input signals

Select one of multiple input signals depending on
control signal

Apply uniform quantization to input signal

Limit rising and falling rate of change



Control

Relay

Saturation

Signal Switch

Discrete

Delay
Discrete Integrator
Discrete Mean Value

Discrete PID Controller
Discrete State Space

Discrete Transfer Function
Zero-Order Hold

Filters
Moving Average
Periodic Average
Periodic Impulse Average
Total Harmonic Distortion

Fourier Transform
RMS Value

Toggle between on- and off-state with configurable
threshold

Limit input signal to upper and/or lower value

Select one of two input signals depending on control

signal

Delay input signal by given number of samples
Calculate discrete integral of input signal
Calculate running mean value of input signal

Implementation of a discrete-time controller (P, I,
PI, PD or PID)

Implement discrete time-invariant system as state-

space model
Model discrete system as transfer function

Sample and hold input signal periodically

Continuously average input signal over specified
time period

Periodically average input signal over specified
time

Periodically average Dirac impulses over specified
time

Calculate total harmonic distortion (THD) of input

signal
Perform Fourier transform on input signal

Calculate root mean square (RMS) value of input
signal
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Functions & Tables

1D Look-Up Table
2D Look-Up Table
3D Look-Up Table

C-Script
DLL

Fourier Series
Function

FMU

Logical

Combinatorial Logic

Compare to Constant
D Flip-flop

Edge Detection

JK Flip-flop

Logical Operator
Monoflop

Relational Operator
SR Flip-flop

Compute piece-wise linear function of one input
signal

Compute piece-wise linear function of two input
signals

Compute piece-wise linear function of three input
signals

Execute custom C code

Interface with externally generated dynamic-link
library

Synthesize periodic output signal from Fourier
coefficients

Apply arbitrary arithmetic expression to scalar or
vectorized input signal

Use a model stored in an FMU model

Use binary input signals to select one row from
truth table

Compare input signal to constant threshold
Implement edge-triggered flip-flop

Detect edges of pulse signal in given direction
Implement edge-triggered JK flip-flop

Combine input signals logically

Generate pulse of specified width when triggered
Compare two input signals

Implement set-reset flip-flop
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Modulators

2-Pulse Generator
3-Phase Index-Based Modu-
lation

3-Phase Overmodulation

6-Pulse Generator

Blanking Time
Blanking Time (3-Level)

Peak Current Controller
Sawtooth PWM
Sawtooth PWM (3-Level)

Space Vector PWM
Space Vector PWM (3-Level)
Symmetrical PWM
Symmetrical PWM (3-Level)

Variable Frequency PWM
Variable Phase PWM

Transformations

Polar to Rectangular

Generate firing pulses for H-bridge thyristor recti-
fier

Generate the modulation index for a three-phase
reference voltage

Extend linear range of modulation index for 3-
phase inverters

Generate firing pulses for 3-phase thyristor rectifier

Generate commutation delay for 2-level inverter
bridges

Generate commutation delay for 3-level inverter
bridges

Implement peak current mode control
Generate PWM signal using sawtooth carrier

Generate 3-level PWM signal using sawtooth carri-
ers

Generate PWM signals for 3-phase inverter using
space-vector modulation

Generate PWM signals for 3-phase NPC inverter
using space-vector modulation

Generate PWM signal using symmetrical triangu-
lar carrier

Generate 3-level PWM signal using symmetrical
triangular carriers

Generate PWM signals with variable frequency

Generate PWM signals with variable phase shift

Convert polar coordinates to Cartesian coordinates
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Electrical

Rectangular to Polar
Transformation 3ph->RRF

Transformation 3ph->SRF
Transformation RRF->3ph
Transformation RRF->SRF
Transformation SRF->3ph

Transformation SRF->RRF

State Machine
State Machine

Small Signal Analysis

(PLECS Standalone only)

Small Signal Gain
Small Signal Perturbation

Small Signal Response

Connectivity

Convert Cartesian coordinates to polar coordinates

Transform 3-phase signal to rotating reference
frame

Transform 3-phase signal to stationary reference
frame

Transform vector in rotating reference frame into
3-phase signal

Transform vector from rotating to stationary refer-
ence frame

Transform vector in stationary reference frame into
3-phase signal

Transform vector from stationary to rotating refer-
ence frame

Model